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Troubleshooting

Troubleshooting

Troubleshooting information is categorized into two areas:

® Problem Resolution
® Error Messages

3 / uc-70x-tandt



Universal Controller 7.0.x Troubleshooting and Tutorials

Problem Resolution

® Problem Resolution
® Database
® |nstallation
® Operations

Problem Resolution

This page provides links to problems, and their solutions, that you might encounter with Universal Controller.

Database

Error in your SQL syntax

Maximum open cursors have been exceeded
Out-of-Range Value during Database Initialization
JDBC Connections Time Out

DB2 JDBC License Error

Installation

Processes Will Not Start Automatically (Debian Linux)

Error when Starting Controller

Tomcat Post Limit: STATUS_MAX_POST_SIZE_EXCEEDED
Special Characters not Displayed Correctly

Open JRE Dependency not Installed

Operations

Cannot launch a task

VBScript stuck in "Running" state

My Universal Controller License has Expired

Packet for query is too large

Invalid login credentials for refreshing target agents

Invalid Call Error: Invalid call to setDataSource()

Permanent Generation (PermGen) space removed in Java 8
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Error in your SQL syntax

Problem

When you execute an SQL task that includes multiple SQL commands, the following error message (for example) may display:

I NSERT | NTO uc_deno (name, value) values ("A, '"F);
I NSERT | NTO uc_deno (name, value) values ('B, 'S);
I NSERT | NTO uc_deno (nane, value) values ('C, 'F);

Solution

Multiple queries, by default, are disabled for MySQL. To enable multiple queries, append the following string to the Connection URL field in the Database Connections resource definition:

?al | owMul ti Queri es=true

The following example is a URL connection string for a MySQL Database Connection resource definition:

jdbc: mysql ://1 ocal host: 3306/ uc?al | owVul ti Queri es=true
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6

Maximum open cursors have been exceeded

Problem

During large imports on Oracle, you could receive following error message:

ORA- 01000: maxi num open cursors exceeded

(The cursors are used only during the import; they then are closed.)

Issue the following sql*plus utility command to check the current value for maximum open cursors:

show par anmet er open_cursors

A listing similar to the following will display:

SQL> show paraneter open_cursors;

NAVE TYPE VALUE
open_cursors i nt eger 1000
Solution

An open_cur sor s value of 1000 should be sufficient for all large imports.

You can temporarily set the open_cur sor s value with the following SQL:

al ter system set open_cursors=1000

To make a permanent change, you must set the open_cur sor s value in the initialization parameters file.
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Out-of-Range Value during Database Initialization

Problem

During the database initialization performed on initial start-up, you could receive the following message:

The conversion of a varchar data type to a datetinme data type of the value is out of range.

The problem likely is that the database was created in SQL SERVER Management Studio with a user that has other than English as the default language.

Solution

Verify the installed default language and set the language to U.S. English.

To check what default language a server has installed, use the following SQL command:

sp_configure 'default |anguage'

If the resulting value is not 0, the default language is not U.S. English. Run the following SQL command to find the installed default language setting and date format used:

sel ect name , alias, datefornat
from sysl anguages

where langid =
(sel ect value from master..sysconfigures
where comment = 'default |anguage')

To set the default language to U.S. English, use the following SQL statements:

sp_configure 'default |anguage', O
reconfigure with override

For further details, refer to this Microsoft Support page.
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http://support.microsoft.com/kb/173907
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JDBC Connections Time Out

Problem

JDBC connections from Linux to MS SQL Server 2008 R2/Windows 2008 R2 time out after 40 seconds causing SQL/Stored Procedure Tasks that take longer than 40 seconds to fail with the following
exception:

2014-09-22-14: 51: 37: 034 -0400 ERROR [ Ops. General . 15. EP. Sgl Handl er . ecd8ab62183f 4b9dbf 32d3ead4ad0al26. 74b824adlca84142a40d3eclf 84d4d2b. 0]
SQLSer ver Exception - Connection reset
com microsoft.sql server.jdbc. SQLServer Exception: Connection reset
at com m crosoft.sql server.jdbc. SQLServer Connecti on. term nat e( SQLSer ver Connecti on. j ava: 1667)
at com m crosoft.sql server.jdbc. SQL.Server Connecti on. t erm nat e( SQLSer ver Connecti on. j ava: 1654)
at com m crosoft.sql server.jdbc. TDSChannel . read(| OBuf fer.java: 1789)
at com m crosoft.sql server.jdbc. TDSReader . readPacket (| OBuf f er.j ava: 4838)
at com m crosoft.sql server.jdbc. TDSConmand. st art Response( | OBuf f er. j ava: 6150)
at com m crosoft.sql server.jdbc. SQLServer Prepar edSt at enent . doExecut ePr epar edSt at enent ( SQLSer ver Pr epar edSt at enent . j ava: 402)
at com m crosoft.sql server.jdbc. SQLSer ver Prepar edSt at enent $Pr epSt nt ExecCnd. doExecut e( SQLSer ver Pr epar edSt at enent . j ava: 350)
at com m crosoft.sql server.jdbc. TDSConmand. execut e( | OBuf f er. j ava: 5696)
at com m crosoft.sql server.jdbc. SQLServer Connecti on. execut eConmand( SQLSer ver Connecti on. j ava: 1715)
at com m crosoft.sql server.jdbc. SQ.Server St at enent . execut eConmand( SQLSer ver St at enent . j ava: 180)
at com m crosoft.sql server.jdbc. SQ.Server St at enent . execut eSt at enent ( SQLSer ver St at enent . j ava: 155)
at com m crosoft.sql server.jdbc. SQLServer Prepar edSt at enent . execut e( SQLSer ver Pr epar edSt at ement . j ava: 332)
at com stonebranch. opswi se. server. events. Sql Event Handl er. st or edPr oc( Sql Event Handl er . j ava: 266)

Resolution

To disable TCP Chimney Offload, follow these steps:
Step 1 Use administrative credentials to open a command prompt.
Step 2 | Atthe command prompt, enter the following command: net sh int tcp set gl obal chi mey=di sabl ed

Step 3 Press ENTER:.

For additional information, see:

http://support.microsoft.com/kb/951037
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DB2 JDBC License Error

Problem

A SQL or Stored Procedure task using a DB2 Database Connection may fail with the following error message:

The 1BM Data Server for JDBC and SQ.J license was invalid or was not activated for the DB2 for z/OS subsystem If you are connecting
directly to the data server and using DB2 Connect Unlimted Edition for Systemz, performthe activation step by running the activation
programin the license activation kit. |If you are using any other edition of DB2 Connect, obtain the license file, db2jcc_license_cisuz.jar,
fromthe license activation kit, and follow the installation directions to include the license file in the class path.

Solution

The db2j cc_l i cense_ci suz. j ar file needs to be included in the classpath for Universal Controller.

Step 1 | Copy the db2j cc_l i cense_ci suz. j ar file to the following directory:

Windows
[tontat-install]\webapps\uc\VEB-INF\Iib

UNIX
[tontat-install]/webapps/uc/ VEB-INF/Iib

Step 2 | Restart Universal Controller.
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Processes Will Not Start Automatically (Debian Linux)

Problem
For Debian Linux environment: Outboard 5.1.0 processes will not start automatically at boot time.

Debian Linux does not provide the chkconfig command and therefore cannot work with the runlevels specified in the opsagent, opstransport, opsmsghub scripts provided in/ etc/init. d.

This is a known problem; we are working on a solution.
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Error when Starting Controller

Problem

Upon starting the Universal Controller, the opswi se. | og shows ERR:

SQLSTATE: HY000, SQLERR 1040, ERRVSG [uni xODBC][ MySQL][ODBC 5.1 Driver] Too nany connections

Solution

You must set additional connections in your database server:

MySQL - /etc/ny.conf - max_connections=500 (default is either 100 or 150)
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Tomcat Post Limit - STATUS_MAX_POST_SIZE_EXCEEDED

Problem

The following error message displays:
The server did not receive the data that was sent to it. Please see the docunentation for isc. RPCResponse. STATUS_MAX_POST_SI ZE_EXCEEDED
Resolution

Remove the post limit by specifying the following attribute on the <Connector> elementin conf/server. xm :

maxPost Si ze="-1"
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Special Characters not Displayed Correctly

Problem

Some special characters not getting displayed correctly in your browser GUI.

Resolution
Tomcat on Windows requires you to define code page UTF-8 as the default code page for war files.
To do this, add the following to the Java options statement just as you did with the memory parameter:

-Dfil e. encodi ng=UTF8
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Open JRE Dependency not Installed

Problem

If Universal Controller produces an exception similar to the following when exporting a dashboard widget or generating a scheduled chart report, a required dependency may not be installed.

java. |l ang. Nul | Poi nt er Excepti on
at sun. awt . Font Confi gur ati on. get Ver si on( Font Confi guration.java: 1264)
at sun. awt. Font Confi gurati on. readFont Confi gFi | e( Font Confi gurati on. java: 219)
at sun. awt . Font Confi gurati on.init(FontConfiguration.java: 107)
at sun.awt. X11Font Manager. cr eat eFont Confi gur ati on( X11Font Manager . j ava: 774)

When using the j ava- 1. 8. 0- openj dk- headl ess package from the EL7 repository, it did does not include a required dependency; specifically, f ont confi g.

Solution

Installing the f ont conf i g dependency, along with its own dependencies, will resolve the issue.

yuminstall fontconfig

Alternatively, you can use the non-headless package, j ava- 1. 8. 0- openj dk.
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Cannot launch a task

Problem
You cannot launch a task.

The problem may be with your credentials. Check the stderr for the following message:

ops_suexec: Not enough privileges. Check SU D bit and binary owner.

Solution

If the error message is present, issue the following commands as root in the $WVS_HOVE/ bi n directory:

chown root ops_suexec
chnod 4755 ops_suexec
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VBScript stuck in "Running" state

Problem

By default, Windows uses a GUI-based VBScript interpreter (wscr i pt . exe). With this interpreter, if your script tries to display an error message that requires a user-response (for example, Click OK), you will
never see the dialog box. The script therefore gets stuck in the "Running"” state.

Solution

To avoid this, we recommend you use the console version of the VBScript interpreter (cscri pt . exe). To do so, specify cscri pt . exe before the script name in a task definition, as shown in the following
example:

"cscript.exe C\Wrk\script.vbs".
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My Universal Controller License has Expired

Problem

If your Universal Controller license has expired, you will not be able to run any tasks. If you attempt to run a task under an expired license, the Controller will place the task in the Defined state.

When you log in to the Controller, the Universal Automation Center Console will displays a license expiration informational message if your license will expire within a week, and an error message if your license

already has expired.

Additionally, if you have configured the Controller for System Notifications, system notifications are sent when the Controller license will expire in seven days and if the license already has expired.

There are two other methods you can use to check on license expiration.

Method 1

Check the System Details widget (view the system-defined Home Dashboard or, on the Reporting navigation pane, click Widgets) to see how many days are left on your license.

The Days: #/# entry in the License field indicates the current day of your current license and the total number of days in the license. If the numbers are identical, your license has expired.

System Details
License: [Agents: 67/5000] [Triggers: Unlimited] [Tasks: Unlimited] [Days: 4/365]
Mode |d: ga-opswiseb:8080-ga_opswise620b21
Mode Mode: Active
MNode Uptime: 2 Days 20 Hours 53 Minutes 0 Seconds
Mode Time: 2015-05-18 14:17:43 -0400
Release: 6200
Build: build 21
Build Date: 05-13-2015_0345
Database Type: MY SQL
Database Mame: ga_opswiseb20b21
Database URL: jdbc:mysqgl:f/ga-dfdb2_stone branch/
Database Connections:  In Use: 3, Total: &
Memory Maximum: 989.85 MB
Memory Used: 140.18 MB (14.16%)
Memory Free: 849.70 MB (85.84%)
Method 2
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Check the Controller log file.

If your license has expired, the following two messages should appear in the log at the midnight roll-over:

2015-01- 07-00: 00: 00: 006 ~ WARN [ Ops. Ti mer. Forecast _Refresh. 0] License Violation: Nunber of Days has exceeded # suspendi ng system
2015-01-07- 00: 00: 00: 006 I NFO [ Ops. Ti ner. Forecast _Refresh. 0] Pausing the server.

Additionally, this message should appear in the log if you try to run a task under an expired license:

2015-01-07-09: 32: 27: 728 I NFO [ Ops. Avai | abl e. 2367. 0] System paused, waiting for resume

Solution

Contact Stonebranch Customer Support.
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Packet for query is too large

Problem

During operations, the following message may appear in the Universal Controller log:

Packet for query is too |large (1084852 > 1048576).

Solution
Change this value on the database server by setting the MySQL max_allowed_packet configuration variable.
For detailed information about this variable, refer to:

®* MySQL 5.6.x reference manual

® MySQL 5.7.x reference manual
® MySQL 8.0.x reference manual
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Error when refreshing target agents

Problem

An error occurs when you click Refresh Target Agents on a Promotion Target record and you are using invalid login credentials for the target Universal Controller instance.

The user interface on source machine will show the following error:

GET http://NN NNN. NN. N: 8080/ uc/ resources/ agents/list returned a response status of 401 Unauthorized

The the Controller log on the source machine will show the following error:

ERROR [ htt p-8080-10] com sun.jersey.api.client.Uniform nterfaceException:
CET http:///uc/resources/agents/list returned a response status of 401 Unauthorized"

The target machine will return the following error:

ERROR [http--#] *** ERROR *** Login using Basic Authentication failed for:

Solution

Update the Promotion Target record with valid login credentials and try the promotion again.
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Invalid Call Error

Problem
The following error message displays:

onUncaught Exception: Exception caught: Invalid call to setDataSource() passing null.

Resolution

You may need to update the LimitRequestLine property in the Apache ht t pd. conf file to its default value, 8190.
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Permanent Generation (PermGen) space removed in Java 8

Problem
The Permanent Generation (PermGen) space has been completely removed in Java 8.

If you specify the Maximum PermGen Size option (- XX: MaxPer n5i ze=<NNN>) for a Java 8 VM, you may see a warning message similar to the following.

Java Hot Spot (TM 64-Bit Server VM warning: ignoring option MaxPernSi ze=512m support was renoved in 8.0

Resolution

The PermGen space is superseded by a new space called Metaspace in Java 8.

You can specify the Maximum Metaspace Size with the analogous - XX: MaxMet aspaceSi ze=<NNN> option; however, the default (no limit) is recommended for most deployments.
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Error Messages

Error Messages

This page identifies error messages (in alphabetical order) that you may receive for Universal Controller.

For each error, there is a link to the cause problem, and its solution, in Problem Resolution.

GET http://NN NNN. NN. N: 8080/ uc/ resources/ agents/list returned a response status of 401 Unaut horized

(in user interface on source machine)

ERROR [ htt p-8080-10] com sun.jersey.api.client.Uniformn nterfaceException:
CET http:///uc/resources/agents/list returned a response status of 401 Unauthorized"

(in Controller log on source machine)

ERROR [http--#] *** ERROR *** Login using Basic Authentication failed for:

(on Target machine)

See Error when refreshing target agents.

I NSERT | NTO uc_deno (name, value) values ("A, '"F);

See Error in your SQL syntax.

Java Hot Spot (TM 64-Bit Server VM warning: ignoring option MaxPernSi ze=512m support was renoved in 8.0

See Permanent Generation (PermGen) space removed in Java 8

23 | uc-70x-tandt



Universal Controller 7.0.x Troubleshooting and Tutorials

onUncaught Exception: Exception caught: Invalid call to setDataSource() passing null.

See Invalid Call Error.

ops_suexec___Not enough privileges. Check SU D bit and binary owner

See Cannot launch a task.

ORA- 01000: maxi mum open cursors exceeded

See Maximum open cursors have been exceeded.

Packet for query is too |large (1084852 > 1048576

See Packet for query is too large.

SQ.STATE: HY000, SQLERR 1040, ERRMSG. uni xODBC MySQ. ODBC 5.1 Driver Too many connections

See Error when Starting Controller.

The conversion of a varchar data type to a datetine data type resulted in an out-of-range val ue.

See Out-of-Range Value during Database Initialization.
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The I1BM Data Server for JDBC and SQ.J license was invalid or was not activated for the DB2 for z/OS subsystem If you are connecting directly to the
data server and using DB2 Connect Unlinmted Edition for Systemz, performthe activation step by running the activation programin the |icense
activation kit. If you are using any other edition of DB2 Connect, obtain the license file, db2jcc_license_cisuz.jar, fromthe license activation kit,
and follow the installation directions to include the license file in the class path.

See DB2 JDBC License Error.

The server did not receive the data that was sent to it. Please see the docunentation for isc. RPCResponse. STATUS_MAX_POST_SI ZE_EXCEEDED

See Tomcat Post Limit - STATUS_MAX_POST_SIZE_EXCEEDED.

25 /| uc-70x-tandt



Universal Controller 7.0.x Troubleshooting and Tutorials

Tutorials

Introduction

The tutorials guide you through features of Universal Controller. They also provide links to more detailed information about each aspect of the Controller.
Once you have completed the tutorials, you should have a basic understanding of how the features work together to automate your environment.

Before you begin, we recommend that you read the Setting Up Universal Controller and User Interface sections of this documentation to familiarize yourself with user interface navigation and terminology.

Note

1
During the course of performing these tutorials, you will build up a small database of demonstration records that you will re-use in subsequent exercises. To avoid having to reenter data, do not delete the
records.

The navigation pane on the left lists the tutorials in the sequence they should be read; many of them refer to information created in one or more previous tutorials.

The following table lists the tutorials by topic, rather than sequence.

Tasks

Creating and Manually Launching a Simple Task

Creating and Manually Launching a Universal Task

Running a Windows Task

Launching a Task Automatically Using a Simple Time Trigger
Launching a Task Every Monday Except Holidays

Launching a Task Every Two Hours During Workday
Launching Tasks at a Future Time

Launching an Email Task Based on a File Monitor

Launching an Email Task Based on a Task Monitor
Launching Tasks Using a Cron Trigger

Aborting a Process Launched by a Task

Force Finishing, Force Finish-Cancelling, and Cancelling a Task
Accessing Task Instance Details

Monitoring Task Activity
Workflows

Creating a Simple Workflow
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Running a Workflow with a Conditional Path
Running a Workflow with Multiple Conditional Paths
Running a Workflow with Skipped Criteria
Finding and Inserting Tasks in an Active Workflow
Skipping, Unskipping, and Showing-Hiding Skipped Task Instances
Variables
Using Variables in a Simple Task
Using Variables in a Workflow
Custom Days
Creating Custom Days and Periods
Forecasting
Generating Forecast Data
Virtual Resources
Setting Up a Virtual Resource
User Interface
Creating a Widget
Creating a Dashboard and Selecting Widgets
Business Services
Creating Business Services
Assigning Records to Business Services
Viewing Activity by Business Service
Reports
Creating a Report
Creating a Report Based on Business Services
Scheduling a Report
Security

Creating Users and Assigning Permissions

Creating User Groups and Assigning Permissions
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Bundles and Promotion

Creating and Promoting a Bundle

Scheduling the Promotion of a Bundle
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Tutorial - Creating and Manually Launching a Task

In this tutorial, you will:
® Create a Timer task.

® Manually launch the task.
® View task instance Details of the task.

Step 1 From the Automation Center navigation pane, select Tasks > Timer Task. The Timer Tasks list displays.

Step 2 Click New. The Timer Task Details displays.

® Inthe Task Name field, enter stonebranch-timertask-01.
® |n the Time Duration in Seconds field, enter 60.

Timer Task Details |[=)|E%
[l save 03 Save & New Save & View 3£ Close

Timer Task

— General

Task Name :

Task Description :
Member of
Business Senvices :
Resolve Name B Time Zone
Immediately : Preference :
Hold on Start: []

Virtual Resource Hold Resources on =
Priority © Failure :

- System Default — v

— Timer Details

Timer Type * | Seconds >

Timer Duration In
Seconds :

— Time Options

Late Start: []
Late Finish: [7]
Early Finish : [0]

UserEstimated  Day Hour Win Sec
Duration : v v v v

Critical Path Options
’7 CP Duration : CP Duratien Unit: |Minutes v

— Workflow Execution Options

Execution
Restriction - |~ None =

[] save [ save & New Save & View 3 Close

Step 3 Click Save.

Step 4 On the Timer Tasks list, right-click stonebranch-timertask-01 task to display an Action menu.

Step5  Click Launch Task.

Step 6 | Fromthe Automation Center navigation pane, select Task Instances > Activity. The Activity Monitor displays.

Step 7  Locate the stonebranch-timertask-01 task instance. When the task instance completes, the status changes from Running to Success.
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Step 8

Timer Task Instance Details: stonebranch-timertask-01

Click the Details icon next to the Instance Name of stonebranch-timertask-01 to display Details of the task instance.

[=][ 3

‘H Update 0@ Re-fun (&) Delete [[% Refresh & Close |

Timer Task Instance H Virtual Resources || Exclusive Requests ” Notes |
— General
Instance Name |5mnehran:h—nmenask401 ‘ Instance Number :
Task |slunabran:h-ﬂmenask-ﬂﬂ E Invoked By ‘ManuallyLauncngd ‘
Task Description
Member of Execution User ‘ups admin ‘
Business Serices
ol Time Zone
Calendar |Sy5tem Default |\_/ Preference -~ System Default—
Virtual Resource Hold Resources on
Priority |m |-.‘ Failure : o
— Status
Status |Succsss ‘
Status Description | ‘
Operational Memo
Trigger Time | \ Launch Tume.\zmg-ca-zu 15:24:37 -0400 \
Start Time - [2019-08-20 15:24:38 -0400 | End Time : | 2019-08-20 15:25:38 0400 |
Duration |1 Minute 0 Seconds ‘
Run Unti Time : [2019-08-20 15:25:38 -0400 |
— Timer Details
Timer Type : [seconds [+
Timer Duration In 50
Seconds :
— Statistics
User Estimated End ‘ Average Estimated ‘201905720 16:24:38 -0400 ‘
Time End Time
Lowest Estimated ‘ Highest Estimated ‘
End Time EndTime :
| Flupdate | E@Rewn || ¢ Delete || (5 Refresh || & Close |

For additional information, see:

® Creating Tasks
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Tutorial - Creating and Manually Launching a Universal Task

® Overview
® Before You Begin
® Create a Universal Template
® Create Universal Template Fields
® Create a Universal Task

Overview

To run a Universal Task, you must:

® Create a Universal Template, for which Universal Controller automatically creates a Universal Task type. This includes:
® Entering a script that any Universal Task created for that Universal Task type will execute.
® Creating fields, for which the Controller will both automatically assign variables (to be used in the script) and add to any Universal Task created for that Universal Task type.
Replace variables in the script with the variables assigned to the user-defined Fields that you created in the Universal Template.
Create a Universal Task for the Universal Task type based on the Universal Template that you created.
Enter/select values for the user-defined fields in the Universal Task that match the fields you created in the Universal Template.
Run the Universal Task.
Retrieve the task output and verify that the script variables have been resolved to the Universal Task field values.

In this tutorial, you will:

® Create a Universal Template.
® Define fields for a Universal Task in the Universal Template.
® Create a Universal task.

Before You Begin

When you create a Universal Template, you create fields that will display in the Details of the Universal Task (based on this Universal Template) that you will create. These Universal Template fields are
assigned variables to be used in the script. The script should contain these variables in a specific format based on information that you provide when creating the Universal Template.

Create a Universal Template
First, create a Universal Template:
Step 1 From the Administration navigation pane, select Configuration> Universal Templates. The Universal Templates list displays.

Step 2  Click New. The Universal Template Details displays.
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In the Name field, enter Oracle EBS.

In the Description field, enter Oracle E-Business Suite Tasks.
In the Variable Prefix field, enter: oebs.

In the Agent Type field, select Linux/Unix.

In the Linux/Unix Script field, enter:

concsub ${credential user ("${ops_oebs_appscredential }")}/${_credential Pwd("${ops_oebs_appscredential }")} \
"${ops_oebs_respapp}" ${ops_oebs_respnanme} ${ops_oebs_usernanme} \

WAl T=Y CONCURRENT FND FNDFMRTC \

PROGRAM_NAMVE= ' " ${ ops_oebs_prognane}

® Inthe Agent field, select a Linux/Unix agent on which the Universal Task based on this agent will run.
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F

Universal Template Details =|ax

|H save [ Save&New [[j Save &View $ Close |

Universal Template

— General

Name: Oracle EBS

Description : Oracle E-Business Suite Tasks

Variable Prefix: ogbs

lcon:

EBS logo (48x48).png PNG image (48 x 48 pixels)

— Universal Template Details
AgentType : |LinudUnix [+

concsub S{credentialuser ("${ops_ogbs appscredentiall™)}
/${credentialbnd("S{ops_ochs appscredential}™>} \
"${ops_gebs_respappl” ${ops_gsbs respname} ${ops_gebs username} \
WATT+Y CONCURRENT FND ENDFMRTC

PROGRAM_NAME= ""${ops_pebs_progname}|

Linux/Unix Script :

— Defaults

Agem:lg;;&uﬂ;;mm stone.branch - ga-cnti-mysal Agent Cluster ‘

AgentVariable : [7]

Agent Cluster
Variable o

Credentials:l Cluster Broadcast ‘
Credentials B Cluster Broadcast "
Variable : Variable
Runtime Directary
(-]
Environment | ame lake
Variables I |
No items to show
Exit Code
Processing - |Success Exitcode Range ‘v ‘
Exit Codes: 0
Automatic Qutput
Retyal: |~ None ~ k] i
— Field Restriction
Agent Fields |N(] Restriction [v | Credential Fields ‘Ng Restriction “’l
Emvironment " Exit Code :
Variables Field - [No Restriction x| Processing Fields Mo Restrction [
Automatic Qutput
Retrieval Fields : [ivo Restrcion v/
| [Flsae || savesNew |[f) Save&View | 3 Close | |

Step 3 Optionally, in the Icon field, browse for an icon (PNG image, 48x48 pixels) to be used instead of the default icon for any Universal Tasks based on this Universal Template.
If you select an icon, the file name display next to the Browse button. When you save the Universal Template, the logo itself displays in the Icon field (see #Create Universal Template Fields, below).

Step4  Click Save.

Create Universal Template Fields
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Next, create fields in the template:

Step 1 Open the Oracle EBS template that you just created.

=
T Universal Template Details: Oracle EBS Ei=E3

‘H Update [F Copy ¢f] Delete & Refresh 3% Close |

| Universal Template || Fields. |
Ican
No file selected. PNG image (48 x 48 pixels)
— Universal Template Details
Agent Type : | LinuUnix [+]

concsub ${credentialuser (“${ops_pebs_appscredential}l™)}
/8{credentialPwd("${ops_oebs_appscredentiall™} \
“${ops_gebs_respapp}” S{ops_gehs respname} ${ops_gebs username} \
WALT+Y CONCURRENT END ENDEMRTC

PROGRAM_NAME= " "S{ops_pebs_progname}|

Linux/Unix Script
— Defaults
Agsnt'|qa—mm—mysqlsmns branch - ga-cntir-mysaql ‘v [ AgentCluster \
AgentVariable : Ager;;a[r:‘g&teer 1
Credenials - | |+ [ cluster Broadcast - |
Credentials Cluster Broadcast —
Variable : Variable
Runtime Directory :
9@
Environment | ame ek
Variables :
No items to show
Exit Code
Processing |Success Exitcode Range ‘v ‘
Exit Codes: 0
Automatic Output -
Retrieval : |=one - ]
— Field iction; M
Agent Fields : |Nn Restriction ‘v | Credential Fields \Nﬂ Restriction |v|
Environment Exit Code .
Variables Field * |Na Restriction ‘V ‘ Pr Fields ‘No Restriction |"|
Automatic Output |Nn Restriction ‘v ‘

Retrieval Fields

| Elupdate || [Crcopy || ¢ff Delete || [ Refresh || § Close

o]
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Click the Fields tab to display an empty Fields list.

Step 2
Universal Template Details: Oracle B
Universal Template Fields
0 Fields New =)
Name Label Type Mapping Add To Default List View UpdatedBy  Updated v
No items to show:
Step 3 Click New. The Field Details for a new Field displays.
* In the Name field, enter appscredential.
® In the Label field, enter Oracle Application Credential.
® In the Hint field, enter Credential containing the Oracle Applications username and password..
® In the Type field, select Text.
® In the Required field, enter a check mark.
Field Details =)[@lx
[E] save [F Save & New Save & View $§ Close
Field
— General
MName : appscredential Label : | Oracle Application Credential
Hint: Credential containing the Oracle lication username and
Add To Default List
Wiew a
— Field Details
Type  [Text v Mapping : | Text Field 1 i
Default Value
— Validation
Required
Require IfField . — None — ~
Show IfField |- Nong — v
Length
— Form Layout
StartRow: [] Column Span : 2 v
EndRow: []
[E] save liEy Save & New | | [y Save & View 3 Close
Step 4 Click Save to save the Field and re-display the Fields list.
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Step 5 Click New and create four more Fields.

® Name =respapp.
® |abel = Responsibility Application.
® Type = Text.

® Name =respname.
® |abel = Responsibility Name.
Type = Text.

® Name = username.
® Label = Application User.
® Type = Text.

Name = progname.
Label = Program Name.
Type = Choice.

Default = active users

Click Save to save each Field.

Step 6 When you save the progname field, the Choices tab is enabled so that you can define user-selectable Choices for that Field. An empty Choices list displays under the enabled Choices tab. Click New to display an
empty Choice Details for a new Choice:

® In the Value field, enter active users.
® Inthe Label field, enter Active Users.

Choice Details (=113
[E] save ER save &New [ Save &View 3£ Close

Choice

Details
Value : active users

Use Value For Label : [T]
Label: Active Users

[E] save I Save & Mew Save & View 3 Close

Step 7 Click Save to save the Choice and then create two more Choices for the progname field:

® Value = inactive users.
® Label = Inactive Users.

® Name = temporary users.
® Label = Temporary Users.

Click Save to save each Field.

Step 8 Click the Field tab to re-display the Field Details, click the Close to return to the Fields list, and then click click the Universal Template tab to return to the Universal Template Details.
Step 9 Check the script to make sure that the variables for the five Fields that you created are in the following format: ops_<Vari abl e Prefi x>_<Fi el d Name>. For example: ops_oebs_appscredenti al .

Step 10 Click Save to save the template.

Create a Universal Task

You now can create a Universal Task based on Stonebranch Template One.
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Step 1 Select the Automation Center navigation pane.

Step 2 Right-click inside the navigation pane and, on the Action menu that displays, click Refresh Navigation Tree. An Oracle EBS Tasks Universal Task task type now displays in the Universal Tasks folder.

Step 3 Click Oracle EBS Tasks to display an empty tasks list for this Universal Task type.
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Step 4 Click New to display Details for a new Oracle EBS Tasks task.

Oracle EBS Task Details = =ES
[E] save [ Save & New [ Save &View 3£ Close |

Oracle EBS Task

— General

Task Name :

Task Description

Member of
Business Services

Resolve Name Time Zone

Immediately Preference : |~ System Default -

Hold on Start

Virtual Resource Hold Resources on
Priority |1 Failure :

— Oracle EBS Details

Agent ME Agentcluster'l

Agent Cluster
Variable

AgentVariable : [F]

Credentials v Cluster Broadcast
| [P |

Credentials Cluster Broadcast
Variable Variable :

QOracle A
Credential :
Responsibliity Responsibility
Application Name

Application User Program Name : |Actwe Users

Runtime Directory

Enviranment Value
Variables
No items to show:

Exit Code
Processing

ExitCodes: 0

Automatic Qutput
Retrieval - |~

|Su:cess Exitcode Range

None —

— Retry Options
Retry Exit Codes

Maximum Retries Retry Indefinitely :

Suppress

R(EE:EC‘SI:Z:)E‘ s Intermediate
Failures :

— Wait/Delay Options
Wait To Start |_ None —

Delay On Start |, Nane —

Workflow Only |7 System Default —

— Time Options
Late Start
Late Finish
Early Finish
User Estimated __Day Hour Win

CP Duration CP Duration Unit: |Minutes

’7 Critical Path Options

— Workflow Execution Options

Execution
Restriction

—None —

sae |3 savesNew |[F) savesview| &£ close
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Step 5

Step 6

Step 7

Step 8

Step 9

In the Task Name field, enter: Active Users Report.
Review the Details section fields that you defined in the Oracle EBS Universal Template to make sure that their names, defaults, and requirement settings are correct.

Enter the following field values:
Oracle Application Credential: APPS
Responsibility Application: SYSADMIN

L]
L]
® Responsibility Name: System Administrator
® Application User: SYSADMIN

Click the Save button to save the task.

Right-click Active Users Report on the Oracle EBS Task list and, on the Action menu that displays, click Launch Task.
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Step 10

Oracle EBS Task Instance Details: Active Users Report

Click Activity in the Automation Center navigation pane and open the Active Users Report task instance:

= =163

‘ [F] Update Force Finish » [ Rerun [ Refrieve Qutput.. &) Delete [[5 Refresh £ Close

— General

Oracle EBS Task Instance H © Virtual Resources. H © Exclusive Requests ‘l © Output H © Hotes ‘

Instance Name : ‘Amve Users Report

‘ Instance Number :

Task: ‘Achve Users Report

|E Invoked By : |Manually Launched

Task Description :

Member of
Business Services :

Execution User: |ops.admm

Calendar: ‘Syshzm Default

Time Zone
|E Preference : |_ £ ZEEET =

virual Resource

Priority 10

Hold Resaurces on
Failure

]

[~ Status

Status ‘Suc:ess

Exit Code : [2

Status Description : ‘

Operational Memo :

Trigger Time © ‘

Launch Time : |2019-08—20 17:03:04 -0400

Queued Time ‘2019—0&—20 17:03:04 -0400

Start Time : ‘2019'0&20 17:03.04 -0400

EndTime : |2019'0&20 17:02:05 -0400

Duration ‘

CPU Time - [120

Process ID - 31825

— Oracle EBS Details

Agent: ‘uastune.branch --mysql

Agent Cluster © |

Agent Variable

Agent Cluster

Variable :

Credentials - ‘

Credentials
Variable :

Oracle Application
Credential : APPS

Responsibliity SYSADMIN
Application :

Responsibilly System Administrator
Name :

Application User: SYSADMIN

Program Name * | Active Users

Runtime Directory :

Environment
Variables :

Value

No items to show.

Exit Cods
1 ode ‘Su:cess Exitcode Range

Exit Codes: 0

Automatic Output

Retrieval; = NOne ~

— Retry Options

Retry Exit Codes

Maximum Retries l:l

] I
(Seconds)

a9
Count

Retry Indefinitely : []

Suppress
Intermediate []
Failures

[~ Statistics

User Estimated
nd Time

‘ Average Esl\mated‘wﬂmm 17:03:04 -0400
End Time .

Lowest Estimated
End Time

‘ Highest Estimated
End Time

‘ H Update H Force Finish vH @ Re-run

H[@ Retrieve Output. H

¢ Delete | [[5 Refresh || 3 Close
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Step 11 In the Status section of the task instance Details, check the Status and Exit Code fields to verify that the task ran to success. Optionally, retrieve output from the task instance to view details about the
run.

S
For additional information, see:

® Universal Templates
® Universal Tasks

41 | uc-70x-tandt


https://docs.stonebranch.com/confluence/display/UC70/Retrieving+Output
https://docs.stonebranch.com/confluence/display/UC70/Universal+Templates
https://docs.stonebranch.com/confluence/display/UC70/Universal+Tasks

Universal Controller 7.0.x Troubleshooting and Tutorials

Tutorial - Running a Windows Task

® Creating a Simple Windows Task
® Manually Retrieving Output from a Windows Task
® Attaching Output to an Email Notification

To perform this tutorial, you need a running Universal Agent for Windows.

Creating a Simple Windows Task

Step 1 Fromthe Automation Center navigation pane, select Tasks > Windows Tasks. The Windows Tasks list
displays.

Step 2 In the empty Windows task Details below the list:

® Inthe Task Name field, enter stonebranch-windowstask-01.
® In the Agent field, select your Windows agent.
¢ In the Command field, enter md c:\tutorial.

Step3  Click Save.
Step 4  Onthe Windows Tasks list, right-click stonebranch-windowstask-01 to display an Action menu.
Step 5 Click Launch Task.

Step 7 Check the Activity Monitor for the task instance.

Manually Retrieving Output from a Windows Task

In this Windows task, we will run a DIR command. Normally, you would use the Automatic Output Retrieval field to specify that any output generated by the command be attached to the task instance after the
task completes. However, if you did not specify that output be attached, you can manually retrieve it after the task instance has run. In this exercise, we will manually retrieve and display the output.

Step 1 Use the same steps to create another Windows task called stonebranch-windowstask-02. Do not specify Automatic Output Retrieval, and use the following command:

dir c:\w ndows

Step 2  Save and launch the task.

Step 3 Locate and open the task instance on the Activity Monitor.
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Step 4 Note that the Output tab is empty. Click Retrieve Output. The Retrieve Output window appears:

Retrieve Output = |[3¢

& Standard Qutput and Standard Error
Output Type : € Standard Qutput
" Standard Error
Start Line : 1
Mumber of Lines : 100
Scan Text

Submit Cancel

Step5  Change the number of lines to 300 and click Submit.

Step 6 Click the Output tab. The STDOUT (standard output) displays on the output list, as shown in the following example:

3

Windows Task Instance Details: stonebranch-windowstask-02 ==
Windows Task Instance Virtual Resources Exclusive Requests | @ Output Notes
&
Type Attempt Output Updated By  Updated
Velume in drive C has no label. |
| Velume Serial Number is 74F4-252€
Directory of c:\windows
01/17/2012 08:04 B <DIR>
01/17/2012 08:04 BM  <DIR> ..
07/13/2009 10:37 B <DIR> AppCompat
01/17/2012 07:58 BM  <DIR> AppPatch
11/20/2010 O05:1& AM €5,024 bfsvc.exe
07/14/2009 12 AM <DIR> Boot =
07/14/200%9 12:52 BM <DIR> Branding 3
10/08/2009 02: M <DIR> csc
07/14/2009 AM <DIR> Cursors
12/23/2009 M <DIR> debug
07/14/2009 MM <DIR> diagnostics
07/14/2009 MM <DIR> Digitallocker
07/14/2009 MM <DIR> Downlosded Program Files
10/09/2009 ™ 1,774 DrcInstall.log
01/17/2012 M <DIR> ehome
10/08/2009 AM <DIR> en-US
11/20/2010 AM 2,81€,320 explorer exe -
Q7/13/2009 M 13,824 fveupdate. exe
07/14/2009 AM <DIR> Globalization
10/09/2009 e <DIms Help
Q7/13/2009 M 487,152 HelpPane exe
07/13/2009 ™ 15,360 hh.exe
01/17/2012 ™ 21,337 iis7.log
07/14/2009 MM <DIR> ™E
01/22/2014 M <DIR> inf
07/14/2009 MM <DIR> L2Schemas
07/13/2009 M <DIR> LiveKernelReports
1040972009 M <DIRE Logs
Q7/13/2009 M 43,131 mib.bin
01/17/2012 M <DIR> Microsoft NET
10/09/2009 e <DIms Minidump
07/13/2009 e <DIms ModenLogs
0€/10/2009 M 1,405 msdfmap.ini
07/13/2009 ™ 179,712 notepad.exe
10/09/2009 ™ 124,998 ntbtleg.txt
10/09/2009 M <DIR> nview
07/14/2009 MM <DIR> Offline Web Pages
10/09/2009 MM <DIR> Panther
07/14/2009 MM <DIR> Performance
04/15/2013 M 180,958 PFRO.log
07/13/2009 M <DIR> PLA b
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Attaching Output to an Email Notification

In this exercise, we will modify the stonebranch-windowstask-02 task with an Email notification that includes the output from the DIR command.
Step1  Open the stonebranch-windowstask-02 task.
Step2  Clickthe Actions tab.

Step 3  Click Email Notification and then click the New button.

44 | uc-70x-tandt



Universal Controller 7.0.x Troubleshooting and Tutorials

45

/

Step 4

® & o 0 0 0 o o

Step 5

uc-70x-tandt

Status=Success

In the Email Notification Details, specify the following:

Email Connection=Your email connection
To=Your email address

Subject=Output

Body=See attached.
Attach Standard Output=enabled

Start Line=1

Number of lines=300

P
Email Notification Details

=113

|H Update (i Delete [|5 Refresh 3§ Close |

Email Notification

— Action Criteria

Exit Cot

Status

On Late Start
On Late Finish
On Early Finish

Description

‘Su::ess

B

des

a
]
a

— Action Details

Email Tem|

Attach

Email Template

Variable
Reply-To

Subject

Body

Report

Attach Standard Output

Attach Standard Error

‘ | Email Connection : | OPSWISE-MAILER

late
fhe

stonebranch@stonebranch.com

Bee

Qutput

See attached.

Report Variable : [7]

Start Line 1

Mumber of Lines :

Scan Text

=]
a

File

| E update ||

il Delete

|| [% Refresh ||

¥ Close

Click Save.
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Step 6  Launch the stonebranch-windowstask-02 task.

Step 7 Once the Windows task goes to success, check your inbox for the email. The output is attached, as shown in the following example.

Output Inbox  x &

opswise-email@stonebranch.com & 3:19 PM (1 minute ago) - -
to me [+

See attached.

B STDOUT_Thu_Jul.. '

e
For additional information, see:

® Creating Tasks
® Windows Task
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Tutorial - Launching a Task Automatically Using a Simple Time Trigger

In this exercise, we will define a time trigger that launches our Timer task every one minute.
Step 1 From the Automation Center navigation pane, select Triggers > Time Triggers.
Step 2 Click New.
Step 3 In the Name field, enter stonebranch-timetrigger-01.

Step 4 In the Task(s) field, click the Add-Remove Multiple icon.

Step 5 In the Collection window, locate the Timer task created in the Creating and Manually Launching a Task tutorial, stonebranch-timertask-01, move it to the Tasks List window, and click Save.
Edit Members Si=1|E3
Timer ¥ ¥ stonebranch-imetrigger-01
Task Name * Type T - Task Name * -
stonebranch-timertask-02 Timer stonebranch-timertask 01
stonebranch-timertask-03 Timer
stonebranch-timertask-04 Timer
stonebranch-timertask-05 Timer
(=]
[+]
[»]
[«
[ save Cancel
Step 6 In the Task(s) field, click the lock icon.
Step 7 In the Time Style field, select Time Interval.
Step 8 In the Time Interval field, enter 1.
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Step 9 In the Time Interval Units field, select Minutes.

Time Trigger Details e
[£] save [ Save & New Save & View 3% Close

Time Trigger

— General
Name : stonebranch-timetrigger-01
Description :

Member of
Business Services

Calendar : | System Default v Time Zone : |Server (AmericaiNew_York) .

stonebranch-timertask-01

A

Task(s):

Purge By Retention
Duration - a

— Status

Forecast: []
Skip Count 0

Task Launch Skip

Condition : |~ None = <

Simulate - |- System Default — e

— Time Details
Time Style : | Time Interval A
Time Interval - 1 Enable Offset: []

Time Interval Units - | Minutes o

— Day Details
Day Style : |Simple v
@ Daily (O Business Days (O Specific Day(s)

— Restrictions
Restrict Times =[]
Special Restriction : [7]

[E] save [y Save & New || [ Save & view 3 close

Step 10  Click Save.

Step 11 By default, triggers are disabled. To enable this trigger:
1. On the Time Triggers list, right-click stonebranch-timetrigger-01 to display an Action menu.
2. Click Enable to enable the trigger. Note that the Enabled column on the trigger list now displays a green check-mark for this trigger.

Step 12 From the Automation Center navigation pane, select Activity to display the Activity Monitor. Note that a new instance of stonebranch-timertask-01 appears every one minute.
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Step 13 Click the most recent instance of stonebranch-timertask-01 to view its details, and note that the Invoked By field contains the name of the trigger that launched this task.

7

Timer Task Instance Details: stonebranch-timertask-01 [ |(=)]E

|H Update [ Re-run ¢§ Delete [l& Refresh 3% Close |

Timer Task Instance H Virtual Resources H Exclusive Requests H Notes ‘

— General

Instance Name ‘stonebrancn—timenask—01 ‘ Reference Id

Task ‘stunebranch-{lmsnask-[]1 Invoked By ‘Tngger stnebranch-timetrigger-01 |

Task Description

Member of

Execution User ‘nps admin |
Business Services

Calendar : [System Default prame 207 | gystem Default—
Virtual Resource Hold R on
Priarity ‘10 ‘vl Failure O

— Status

Status ‘Su::ess ‘

Status Description

Operational Memo

Trigger Time ‘2017—10-05 15:18:25 -0400 Launch Time ‘2017—10-06151525-0400 |

Start Time ‘2017—10—06 15:18:25-0400 EndTime ‘2017—10—061515:35—0400 |

|
|
Duration ‘10 Seconds ‘
Run Until Time : [2017-10-06 15:13:35-0400 |

r— Timer Details

Timer Type ‘Semnds ‘vl

Timer Duration In

Seconds: 1

- Statistics

ser Average

End Time- | | STt |2017-10-08 15:18:25-0400 |

Shortest Estimated ‘ Longest Estimated |
End Time End Time

| F update || @ Re-run |

off| Delete | [ Refresh || $£ Close |

e —————
For additional information, see:
® Triggers

® Time Trigger
® Enabling and Disabling Triggers
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Tutorial - Launching a Task Every Monday Except Holidays

® Introduction

® Create Calendar and Custom Days
® Create a Time Trigger

® Adding a Complex Restriction

Introduction

In this exercise, we will define a trigger that runs the stonebranch-timertask-01 task (created in the Creating and Manually Launching a Simple Task tutorial) automatically every Monday at 1 p.m., except
holidays.

For cases where Monday falls on a holiday, we will define a special restriction in the trigger that instructs the Controller to run the task on the next business day.

We will define the business days and holidays in a calendar.

Create Calendar and Custom Days

Before building the trigger, we will create the calendar:

Step 1 From the Automation Center navigation pane, Others > Calendars to display the Calendars list.
Step 2 Click New to display an empty Calendar Details.
Step 3 Enter stonebranch-calendar-01 in the Name field.
Step 4 In the Description field, enter Defines our company business days and holidays.
Step 5 Do not change the default selections for Business Days (Monday through Friday). Click Save.
Calendar Details =3

[F] save [E) Save & New Save & View £ Close

Calendar

Details
Name: stonebranch-calendar-01
Description : Defines our company business days and holidays
Member of Business Senices v

Business Days [C]sunday [#]Monday [¥|Tuesday [¥]Wednesday [¥]Thursday [¥]Friday [[] Saturday

First Day Of Week: | Sunday w2

[E save [ save & New | | [ Save & View 3 close

Step 6 Open stonebranch-calendar-01 and click the Custom Days tab.

Step 7 On the Custom Days list, click the New button. A Custom Day Details for a new Custom Day displays.
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Step 8 In the Name field, enter stonebranch-customday-01.
Step 9 In the Description field, enter Labor Day.
Step 9 In the Category field, select Holiday.

Step 10 In the Type field, select Relative Repeating Date. In the three additional fields that appear, make the following selections:

® When = 1st
* Day of Week = Mon
® Month = Sep
Custom Day Details —l@lx
[ save H3 Save&Mew 3£ Close
Custom Day
r— Details

Name : Labor Day
Description

Category: (O Day (O Business Day @ Holiday (O Period

Type  |Relative Repeating Date A
When:|qst -
Day Of Week: |Mon v,
Month - |Sep v
Adjustment: |- None — v
@ @

Actual Day Of Week Observed Day Of Week
Observed Rules

Mo items to show.

[l save [ Save & New # Close

Step 11  Click Save to add this Custom Day to the Calendar.

Step 12 On the Custom Days list, click the New button. A Custom Day Details for a new Custom Day displays.
Step 13 Inthe Name field, enter stonebranch-customday-02.

Step 14 | Inthe Description field, enter The founder’s birthday.

Step 15  Inthe Category field, select Holiday.
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Step 16  Inthe Type field, select Relative Repeating Date. In the three additional fields that appear, make the following selections:
® When =2nd
® Day of Week = Mon
¢ Month = Oct
Custom Day Details ==

[E] save [ Save &New $£ Close

Custom Day

— Details
Name : stonebranch-customday-02
Description : The founder's birthday
Categary: (O)Day () Business Day (® Holiday () Period

Type : | Relative Repeating Date v
‘When:|2nd -
Day Of Week " |yon v
Month : | Qct -
Adjustment . |~ None — v
")

Actual Day Of Week Observed Day Of Week

Observed Rules
No items to show,

[E] save [ save & New 3 Close

Step 17  Click Save to add this Custom Day to the Calendar.

Create a Time Trigger

Step 1 From the Automation Center navigation pane, select Triggers > Time Trigger to display the Time Triggers list.

Step 2 Click New to display an empty Time Trigger Details.

Step 3 In the Name field, enter stonebranch-timetrigger-01.

Step 4 In the Description field, enter Run every Monday at 1 p.m., roll to Tuesday if Monday is a holiday.
Step 5 In the Calendar field, select stonebranch-calendar-01.

Step 6 In the Task(s) field, select stonebranch-timertask-01.

Step 7 In the Time Style field, keep the default, Time.

Step 8 In the Time field, enter 13:00 (1 p.m. in 24-hour time).

Step 9 In the Day Style field, keep the default, Simple.

Step 10 = Enable Specific Day(s) field and select Monday.
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Step 11  Enable Special Restriction and select:
® On Holiday in the Situation field.
® Next Business Day in the Action field.

Step 12 Click Save.

=)[E3

[E] save [ Save & Mew Save & View 3¢ Close

Time Trigger Details

Time Trigger

— General
Name : stonebranch-timetrigger-01
Description © Run every Monday at 1 p.m., roll to Tuesday if Monday is a holiday.

Member of -
Business Services

Calendar : stonebranch-calendar-01 v Time Zone | | US/Eastern v

stonebranch-timertask-01

=]
Task(s): E
Purge By Retention
Duration a
 Status
Forecast: []
Skip Count 0
Skip Trigger if
Active a
Simulate | — System Default — »
— Time Details
Time Style : Time .
Hour Min
Time

13 > |00 |~

— Day Details
Day Style : | Simple v
(O Daily (O Business Days @ Specific Day(s)

[Jsunday [#]Monday [7]Tuesday [|Wednesday [|Thursday [I|Friday []Saturday

— Restrictions
Special Restriction Action: |Next Business Day -
Simple Restriction Re§1$|r;|pglﬁx [}

Situation : | On Holiday .

[l save I3 Save & New Save & View 3 Close

Step 13 Click the List Qualifying Times button to display the *List Qualifying Times Input pop-up dialog.
Step 14  Inthe Number of Dates/Times field, enter 15.

Step 15  Inthe Start Date fields, Select July 25 2014.

uc-70x-tandt




Universal Controller 7.0.x Troubleshooting and Tutorials

Step 16 Click Submit to display a list of Qualifying Times when the trigger will launch the task.

Qualifying Times =] Es

stonebranch-timetrigger-01

Run every Monday at 1 p.m., roll to Tuesday if Monday is a
holiday.

E Listing From: Friday, July 25, 2014 10:42:45 EDT -0400 [9]

UzerTrigger Timezone: US/Eastern

Manday, July 28, 2014 13:00:00 EDT -0400
Maonday, August 04, 2014 13:00:00 EDT -0400
Maonday, August 11, 2014 13:00:00 EDT -0400
Monday, August 18, 2014 13:00:00 EOT -0400
Maonday, August 25, 2014 13:00:00 EDT -0400
Tuesday, September 02, 2014 13:00:00 EDT -0400
Maonday, September 08, 2014 13:00:00 ECT -0400
Monday, September 15, 2014 13:00:00 EDT -0400
Maonday, September 22, 2014 13:00:00 EDT -0400
Maonday, September 29, 2014 13:00:00 EDT -0400
Manday, October 06, 2014 13:00:00 EDT -0400
Tuesday, October 14, 2014 13:00:00 EDT -0400
Manday, October 20, 2014 13:00:00 EDT -0400
Manday, October 27, 2014 13:00:00 EDT -0400
Maonday, Movember 03, 2014 13:00:00 EST -0500

As shown in the list, the task will not run on the two Mondays that you have defined as holidays in the calendar, but instead will run the the following
Tuesday.

Adding a Complex Restriction
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The following steps show you how to add a complex restriction to the stonebranch-timetrigger-01 trigger. In this case, you will add a restriction that skips the last Monday of the year and instead triggers the
task on the following Tuesday, just as it does for Mondays that are holidays.

Step1  Enable Complex Restriction.

Step2  Inthe Restriction Mode field, select Or.

Step 3 In the Restriction Adjective field, select Last.
Step 4  Inthe Restriction Noun field, select Monday.
Step 5 In the Restriction Qualifier field, select Year.
Step6  Click Update.

Step 7 Re-open the trigger, click the List Qualifying Times button, enter 25 in the Number of Dates/Times field, and click Submit. The Qualifying Times list now shows an additional Monday (the last Monday of the year)
on which the task will not be run.
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Qualifying Times =

stonebranch-timetrigger-01

Run every Monday at 1 p.m., roll to Tuesday if Monday is a
holiday.

E Listing From: Friday, July 25 2014 11:01.54 EDT -0400 [E]

U=zerTrigger Timezone: US/Eastern

Maonday, July 28, 2014 13:00:00 EDT -0400
Monday, August 04, 2014 13:00:00 EDT -0400
Monday, August 11, 2014 13:00:00 EDT -0400
Monday, August 18, 2014 13:00:00 EDT -0400
Monday, August 25 2014 13:00:00 EDT -0400
Tuesday, September 02, 2014 13:00:00 EDT -0400
Monday, September 08, 2014 13:00:00 EDT -0400
Monday, September 15, 2014 13:00:00 EDT -0400
Monday, September 22, 2014 13:00:00 EDT -0400
Monday, September 29, 2014 13:00:00 EDT -0400
Monday, October 06, 2014 13:00:00 EDT -0400
Tuesday, October 14, 2014 13:00:00 EDT -0400
Monday, October 20, 2014 13:00:00 EDT -0400
Monday, October 27, 2014 13:00:00 EDT -0400
Monday, Movember 03, 2014 13:00:00 EST -0500
Monday, Movember 10, 2014 13:00:00 EST -0500
Monday, Movember 17, 2014 13:00:00 EST -0500
Monday, Movember 24, 2014 13:00:00 EST -0500
Monday, December 01, 2014 13:00:00 EST -0500
Monday, December 08, 2014 13:00:00 EST -0500
Monday, December 15, 2014 13:00:00 EST -0500
Monday, December 22, 2014 13:00:00 EST -0500

[ P P - S — e e MM M A B A SLTPL AT ST S an

56 / uc-70x-tandt




Universal Controller 7.0.x Troubleshooting and Tutorials

IUESUdY, LEeCEITIDET U, AU 14 I3 UUUY ES 1 -uduy
Monday, January 05, 2015 13:00:00 EST -0500
Monday, January 12, 2015 13:00:00 EST -0500

For additional information, see:

® Triggers

® Time Trigger

® Calendars

® Displaying Trigger Forecast Information
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Tutorial - Launching a Task Every Two Hours During Workday

In this exercise, we will define a recurring task that runs every two hours, limited to business hours — Monday through Friday from 9 a.m. to 5 p.m. We will also instruct Universal Controller not to run the task on
holidays.

Also, if the task is still running two hours later when it is time to run the next task instance, the Controller will be instructed not to run the next instance.
Step 1 From the Automation Center navigation pane, select Triggers > Time Triggers. The Triggers list displays.

Step 2 Click the New button to display an empty Time Trigger Details.

Step 3 In the Name field, enter stonebranch-timetrigger-02.

Step 4 In the Description field, enter Run Every Two Hours During Business Hours Except Holidays.

Step 5 In the Calendar field, select stonebranch-calendar-01 (created in the Launching a Task Every Monday Except Holidays tutorial).
Step 6 In the Task(s) field, select stonebranch-timertask-01 (created in the Creating and Manually Launching a Simple Task tutorial).

Step 7 Enable the Skip Trigger if Active field. This tells the Controller not to trigger the task if the previous instance of the task is still active.
Step 8 In the Time Style field, select Time Interval and specify the following:

® Time Interval =2
® Time Interval Units = Hours
Step 9 Enable the Restrict Times field and specify the following:
® Enabled Start = 09:00
* Enabled End = 17:00
Step 10 Specify that this trigger should run on weekdays only by selecting either:

® Day Style = Simple
® Business Days = Enabled

OR

Day Style = Complex

Date Adjective = Every
Date Noun = Business Day
Date Qualifier = Year

Both methods use the Business Days specified in stonebranch-calendar-01.
Step 11 Enable the Special Restriction field and specify the following:

® Situation = On Holiday
® Action = Do Not Trigger
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Step 12 Click the Save button.

7

Time Trigger Details: stonebranch-timetrigger-02 (=63

[E] update & Enable (T Trigger Mow. List Qualifying Times... [ Copy ¢f Delete [ Refresh % Close |

Time Trigger H Variables ‘| Versions |

— General

Name : stonebranch-timetrigger-02 Version :

Description : Run Every Two Hours During Business Hours except Holidays

Member of
Business [+
Semices

Calendar: ‘stonebranm—:alendar—m Time Zone : |System (AmericaMNew_York) [~ |

stonebranch-timertask-01

Task(s):

A

Purge By Retention O
Duration

— Status

Forecast: [] Status ‘Dlsamed |

Skip Count 0 Disabled By : | |
Skip Trigger if
Active

Simulate : — System Default — I~

— Time Details

Time Style . Time Interval »

Time Interval 2 Enable Offset: [7]

Time Interval
Units Hours v

— Day Details

Day Style : | Simple -

(O Dally ® Business Days (O Specific Day(s)

— Restrictions
Restrict Times

Hour Min
Enabled Start m m Adjust Interval Ta Enabled Start - [7]

Hour Min
Enabled End: @ @I

sSpecial
Restor Action :[Da Not Trigger [+]

Simple
Restriction :

Situation - [On Holiday [¥]

Complex Restriction: [7]

| [F] update || @ Enable ||(E TriggerNow..| [] ListQualifying Times...|| [ Copy || ¢if| Detete | [[% Refresh | 3§ Close

Step 13 Re-open stonebranch-timetrigger-02 and click the List Qualifying Times button. The Qualifying Times list displays the next scheduled 30 (by default) times when stonebranch-timetrigger-02 will launch stonebra
nch-timertask-01.
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Qualifying Times

stonebranch-timetrigger-02

Run Every Two Hours During Business Hours except

Holidays

E Listing From: Friday, July 25, 2014 13:47:58 EDT -0400

UzerTrigger Timezone: US/Eastern

Friday, July 25, 2014 15:00:00 EDT -0400
Friday, July 25, 2014 17:00:00 EDT -0400
Saturday, July 26, 2014 09:00:00 EDT -0400
Saturday, July 26, 2014 11:00:00 EDT -0400
Saturday, July 26, 2014 13:00:00 EDT -0400
Saturday, July 26, 2014 15:00:00 EDT -0400
Saturday, July 26, 2014 17:00:00 EDT -0400
Sunday, July 27, 2014 09:00:00 EDT -0400
Sunday, July 27, 2014 11:00:00 EDT -0400
Sunday, July 27, 2014 13:00:00 EDT -0400
Sunday, July 27, 2014 15:00:00 EDT -0400
Sunday, July 27, 2014 17:00:00 EDT -0400
Monday, July 28, 2014 09:00:00 EDT -0400
Monday, July 28, 2014 11:00:00 EDT -0400
Monday, July 28, 2014 13:00:00 EDT -0400
Monday, July 28, 2014 15:00:00 EDT -0400
Monday, July 28, 2014 17:00:00 EDT -0400
Tuesday, July 29, 2014 09:00:00 EDT -0400
Tuesday, July 29, 2014 11:00:00 EDT -0400
Tuesday, July 28, 2014 13:00:00 EDT -0400
Tuesday, July 29, 2014 15:00:00 EDT -0400
Tuesday, July 29, 2014 17:00:00 EDT -0400

Al A s Al Lol S0 A4 4 AOGATA0 FET Admn
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YYELNIEDUAY, JUIY JU, £U 18 USULUY CL | -UsuY
Wednesday, July 30, 2014 11:00:00 ECT -0400
Wednesday, July 30, 2014 13:00:00 EDT -0400
Wednesday, July 30, 2014 15:00:00 EDT -0400
Wednesday, July 30, 2014 17:00:00 EDT -0400
Thursday, July 31, 2014 08:00:00 EDT -0400
Thursday, July 31, 2014 11:00:00 EDT -0400
Thursday, July 31, 2014 13:00:00 EDT -0400

For additional information, see:
® Triggers

® Time Trigger
® Calendars
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Tutorial - Launching Tasks at a Future Time

In this exercise, we will create a trigger that will launch multiple tasks at the same time in the future (in two minutes). For this exercise, we will use the SQL tasks created in the Running a Workflow with a
Conditional Path tutorial.

(A future date also can be selected, but to see now that the tasks have been launched, keep the current date.)

Create a Temporary Trigger

Step 1 From the Automation Center navigation pane, select Triggers > Temporary Triggers. The Temporary Triggers list
displays.

Step 2 Click the New button to display Temporary Trigger Details for a new trigger and enter/select the following values:

Name = Launch Tasks

Tasks = stonebranch-timertask-01, stonebranch-timertask-02, and stonebranch-timertask-03 Timer tasks
Date = current date

Time = 5 minutes from the current time

Time Zone = your time zone

Step 3  Click the Save button.

Temporary Trigger Details —lolix
[E] save [E Save & New [ Save &View $£ Close

Temporary Trigger

— General

Name: Launch Tasks

Description
Member of "
Business Senvices
Calendar : | System Default ¥ : Time Zone : US/Eastern v
stonebranch-timertask-01
stonebranch-timertask-02 =)
Taskis): | sionepranch timertask 03 =

Purge By Retention B
Duration

r Status
Forecast: [7]
Skip Count 0
Task Launch Skip
Congition |~ Mon8 = -
Simulate : |- System Default — e

— Tempaorary Details
Date: 2019 |v|Sep |v |5 |v|=
Hour Min

Tme: g o] o5 |

[ save [ Save & New Save & View 3 Close

Step 4 Right-click Launch Tasks on the Temporary Triggers list and click Enable.

Step 5 Open the Activity Monitor to see that the three Timer tasks are run at the selected time.
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S
For additional information, see:

® Temporary Trigger
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Tutorial - Launching an Email Task Based on a File Monitor

Introduction

Create File Monitor Task
Create an Email Task

Create File Monitor Trigger
Test Your File Monitor Set-up

Introduction

In this exercise, we will monitor a machine for a specific file. When the file appears, we will send an email that uses variables to supply information about when and how the email was sent.
In order to set this up, we need the following:

Universal Agent

File Monitor task

File Monitor trigger

Email task being launched by the trigger.

File Manitor trigger

?}@Q’&'@

Universal Agent
Maonitors File Monitor task Task launches when
File being monitored for Trigger is satisfied

Prerequisites:

® In order to perform this exercise, you need a Windows, Linux/Unix, or z/OS Agent running on the machine that is being monitored for the file. Create a directory on the machine called cont r ol | er
tutorial . Later on, you will copy a text file to this directory to satisfy the File Monitor trigger.

Note

1
If you do not have a running Agent, you can bypass this step by manually satisfying the trigger, as per instructions in the tutorial. However, you do need an Agent defined in the database.
® Since we are going to generate an email when the trigger is satisfied, you will need an Email Connection defined.

Create File Monitor Task
The File Monitor task monitors the agent machine for the specified file.

Step 1 From the Automation Center navigation pane, select Tasks > File Monitors. The File Monitors list displays.
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Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

Step 8

Click the New button to display an empty File Monitor Details.

In the Task Name field, enter stonebranch-filemonitor-01.

In the Task Description field, enter Demo File Monitor.

In the Agent field, select an Agent.

In the Monitor Type field, keep the default value, Create. (See File Monitor Task Details Field Descriptions for details about the other file monitor options.)
In the Monitor File field, type filel.txt. Since we have not specified any directory, the Controller will search the root directory.

Enable the Recursive field. Since we are going to write our file to the control | er tutori al directory, we want the Controller to search all sub-directories for the
file.
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Step 9 In the Stable (seconds) field, enter 5. This tells the Controller to satisfy the trigger only when the file has not changed in 5 seconds.

File Monitor Details = ([=)/ET
[l save U5 Save & New Save &View 3£ Close

File Monitor

— General
Task Name : stonebranch-filemaonitar-01
Task Description . Demo File Monitor

Member of
Business Services
Resolve Name = Time Zone
Immediately Preference
Hald on Start: []

Virtual Resource 10 - Hold Resources on B
Priority Failure

— System Default — ~A

r— File Monitor Details
Agent : | gazstone.branch - ga, M= Agent Cluster v

Agent Cluster
’ &l

Agent Variable : [0] Variable

Credentials v || Cluster Broadcast v

Credentials Cluster Broadcast
Variable a Variable B

Trigger on

WMonitor Type * | Create h Edstence .

Monitor File(s) : file 1.5¢

Use Regular
Expression a

Recursive Maximum Files
File Owner
Stable (seconds) 5

Minimum File

Minimum File Size
Scale

KB ~

Scan Text

— WaitDelay Options
Wait To Start: |- None — .
Delay On Start: |~ None — 3

Workdlow Only : | — System Default — h

r— Time Qptions
Late Start: [7]

Late Finish: []

Early Finish : [7]

User Estimated  Day Hour Min Sec
Duration v v v -

Critical Path Options
’7 CP Duration CP Duration Unit: Minutes v

— Workflow Execution Options

Execution
Restriction : —MONe =

[E] Save [ Save & New Save & View # close

Step 10 Click Save.

Create an Email Task

Create the task that will run when the File Monitor is satisfied. In this case, we will generate an email, using the Email task:

66 / uc-70x-tandt



Universal Controller 7.0.x Troubleshooting and Tutorials

Step1  Fromthe Automation Center navigation pane, select Tasks > Email Tasks. The Email Tasks list displays.
step 2  Click the New button to display an empty Email task Details.

Step3  Inthe Task Name field, enter stonebranch-emailtask-01.

Step 4 In the Description field, enter Send Email When File Appears.

Step5  Inthe Email Connection field, select your Email Connection.

Step 6 In the To field, enter your email address. This is where the email will be sent.

Step 7 Inthe Subject field, enter filel.txt arrived.

Step 8 In the body field, enter the following Universal Controller variable and Universal Controller function:

Triggered by: ${ops_trigger_nane}
Date: ${_date}
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When the email is generated, the variables will be substituted with the name of the trigger that launched the Email task, along with the date and time the task was launched.

Step 9
Email Task Details BIEE
[E] save U3 Save & New Save &View $§ Close
Email Task
— General 5
Task Name : stonebranch-emailtask-01
Task Description . Send Email When File Appears
Member of -
Business Services
Resolve Name Time Zone
Immediately B Preference - | = SYStem Default — s
Hold on Start: [7]
Virtual Resource i Hold Resources on
Priority Failure
— Email Details
Email Template ~ =] Email Connection : | QAMAILER M= E
Email Template
variaote -
Reply-To
stonebranch@email.com
To
Cc
Bee
Subject: file 1.b4 arrived 1
Triggered by: ${ops_trigger_name}
Date: ${_date}
Body
Report v|[=] Reportvariable: [ -
Attach Local File: [
— Wait/Delay Options
Walt To Start* | — None — ~
Delay On Start: — None — w
Waorkflow Only ;| — System Default — ~
— Time Options
Late Start: []
Late Finish: [7]
Early Finish: [] 3
User Estimated  Day Hour Min Sec
Duration v v - v
Critical Path Options
’7 CP Duration CP Duration Unit: | Minutes e
‘Workflow Execution Options
Execution N .
Restriction : [~ None =
[E] save ) Save & New | | [f] Save & View # Close |

Step9  Click the Save button.
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Create File Monitor Trigger
Create the File Monitor trigger:
Step 1 From the Automation Center* navigation pane, select Triggers > File Triggers. The File Monitor Triggers list displays.
Step 2 Click the New button to display an empty File Monitor Trigger Details.
Step 3 Inthe Trigger Name field, enter stonebranch-filemonitortrigger-01.
Step 4 In the Description field, enter When File Arrives Send Email.
Step5  Inthe Task(s) field, select stonebranch-emailtask-01.)
Step 6 In the File Monitor field, select stonebranch-filemonitor-01.

Step 7 Click the Save button.

File Monitor Trigger Details B
[E] save [ Save & Mew Save & View $E Close

File Monitor Trigger

— General

Hame : stonebranch-filemonitortrigger-01

Description : When File Arrives Send Email

Member of
Business Senices

Calendar : | System Default M= Time Zone : | System (America/New_York) -

stonebranch-windowstask-01

He

Task(s):

Purge By Retention
Duration : a

— Status

Skip Count: 0

Skip Trigger if
Active © o

File Monitor Details
’7 File Monitor : | stonebranch-filemonitar-01 ¥

— Restrictions
Restrict Times : []
Special Restriction : [7]

[E] save [y Save & New || [ Save & view 3 Close

Test Your File Monitor Set-up
Test your File Monitor set-up.

Step 1 Enable the File Monitor trigger. This launches the File Monitor task. It will appear in the Activity Monitor with a status of Running.
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Step 2 Do one of the following:
® |f you have a running agent, place a text file called fi | e1. t xt inthe control | er tutorial directory on the machine that is being monitored by the File Monitor task. When the file appears, the File Monitor
task waits five seconds, as specified, and then satisfies the trigger.
¢ |f you do not have a running agent but do have an agent connected to your instance, you can manually satisfy the trigger as follows:

1. From the Automation Center navigation pane, select Triggers > File Triggers to display the File Monitor Triggers list.
2. Right-click the stonebranch-file monitortrigger-01 trigger and select Trigger Now.

Step 3 When the trigger is satisfied, the Email is sent. Go to the Activity Monitor and note that the astonebranch-emailtask-01 Email task has been launched.

Step 4 Go to your email account where the email was sent and open the email. Note that the variables were resolved.

e ——————
For additional information, see:

® Email Task

® File Monitor Task

® File Trigger
® Variables
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Tutorial - Launching an Email Task Based on a Task Monitor

Introduction

Select the Activity Monitor Problem Filter

Create an Email Template

Creating an Email Task Using the Email Template
Creating a Task Monitor Task

Creating a Task Monitor Trigger

Running the Task Monitor

Introduction

In this exercise, we will set up a Task Monitor and Task Monitor trigger. The Task Monitor will monitor all tasks for a status that indicates some sort of problem. When the trigger is satisfied, Universal Controller
will launch an Email task that notifies a user that there is a problem. We will also create an Email template for use in our Email task and create an Activity Monitor filter that displays only problem tasks.

The following illustration shows the various components used to trigger tasks based on the status of other tasks.

| |
I l

Task Monitor

: Task Monitor .

Jjﬁ:ﬁrzzznﬁ“ task: Looks for ;:ff ;’Drﬂgr“ggi Tasks being
Windows tasks Failure status in when conditions ] trlgga-r"ad when | ]
whose name Windows tasks . ) conditions are | | |

met, triggers list of satisfiod

beginning with SF

begins with SF tasks.

Select the Activity Monitor Problem Filter

The first task we will do is select the Problem filter for the Activity Monitor. When the user receives an email indicating there is a problem, the user can view this Activity Monitor to find out more information.

Step 1 From the Automation Center navigation pane, select Task Instances > Activity. The Activity Monitor displays.

step2  Click the Click to start the Activity monitor button. All active task instances display.
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Step 3  From the Quick Filter drop-down list, select Status > Problem.

Dashboards Activity

“|Lastaghours ~ | [ Mo quickfilter = | Custom Filter|— None — v | B Filter
Instance Name E status » Active Type Status 7
-_——— Blocked
& Type » Completed

F’%msm
Status is one of Running/Problems,
Defined Cancel Pending, In Doubt, Start Failure,
- i Confirmation Required, Cancelled,
3 Waiting Failed

Held

Started/Finished Late

Exclusive Requested
Exclusive Wait
Resource Requested
Resource Wait
Execution Wait

(k) Undeliverable

(=)

Queued
Submitted
Action Required
Started
Running

Click to start the Activity monitor

Running/Problems
Cancel Pending

In Doubt

Start Failure
Confirmation Required
Cancelled

Failed

Skipped

Finished

1 I >
Success

%% Settings ~ v @] M q b W Page of

The Activity Monitor now will display only Problem task instances.

Create an Email Template

Email Templates allow you to create pre-defined Email task information that you refer to when creating an Email task. This is useful if you have a large number of common parameters on Email tasks but still
require separate tasks.

Step1  Fromthe Agents & Connections navigation pane, select System > Email Templates. The Email Templates list displays.

Step 2  Click the New button to display an empty Email Template Details and enter the following values:

Template Name = Notification based on status

Email Connection = (a valid email connection)

To = (a valid email account)

Subject = Task Failure Alert

Body = Task failure, see Activity Monitor for Problems
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Step 3  Click the Save button.

Email Template Details =115
[E] save [ Save&New [ Save &View $£ Close

Email Template:

— Details

Template Name : Notification based on status
Description :
Member of Business Senices v
Email Connection : | QA-MAILER v
Reply-To:

T suppont@sienahranch.com
0

Subject: TestFailure Alert

Task Failure: see Activity Monitor for Problems.

Body

[F] save I Save & New || [ Save & View 3 Close

Creating an Email Task Using the Email Template

Step 1 From the Automation Center navigation pane, select Tasks > Email Tasks. The Email Tasks list displays.

Step 2 Click the New button to display an empty Email Task Details and enter the following values:

® Task Name = Triggered by Task Status
® Email Template = Notification based on status

Leave the remaining fields blank, since we want to use the information from the template. (If you fill in any of the duplicate fields, the information from the task overrides the information from the template.)
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Step 3  Click the Save button.

Email Task Details

Email Task

— General

o )[=]
[E] save [F Save & New Save &View 38 Close

Task Name : Triggered by Task Status
Task Description

Member of
Business Semvices

Resolve Name
Immediately a

Hold on Start: []

Virtual Resource
Priority

Time Zone
Preference

Hold Resources on
Failure

— System Default — ¥

=]

— Email Details

Email Template : | Nofification based on status

Email Template
Variable a8

Reply-To

To

Subject

Body

Report
Attach Local File : [7]

[F=] Email Connection

Report Variable

=]

— WaitiDelay Options
Walt To Start: |- None —
Delay On Start . |- None —

Workflow Only : |- System Default -

— Time Options

Late Start: [7]
Late Finish: []
Early Finish : [7]

User Estimated __ Day Hour Win Sec
Duration v v v v

Critical Path Options
’7 CP Duration

CP Duration Unit

Minutes %

‘Worlkflow Execution Options

Execution

Resiriction ; ~Mone =

3

[E] save [iE) Save & New Save & View 3 Close Bl

Creating a Task Monitor Task
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For this Task Monitor, we will monitor the status of all other tasks. If any task has a status that indicates there is some sort of problem, we will generate an email. Once the Task Monitor is launched by the Task
Monitor trigger, it remains active, launching an Email every time any of its conditions are met. The Task Monitor task remains active until the Task Monitor trigger is disabled or until a user manually stops it.

Step 1 From the Automation Center navigation pane, select Tasks > Task Monitors. The Task Monitors list displays.

Step 2 Click the New button to display an empty Task Monitor Details and enter the following values:

Task Name = Monitors for Problems
Status To Monitor = enable Running/Problems, Cancel Pending, In Doubt, Start Failure, Confirmation Required, Cancelled, and Failed. (For a description of each status, see Displaying Task Instance Status).

Monitoring Type = General Task(s)
Task Type To Monitor = enable all task types

L]
L]
L]
L]
Step 3 Click the Save button.
Task Monitor Details =X

[E] save [ Save & New Save & View $E Close

Task Menitor

— General

Task Name : Monitors for Problems

Task Description :

Member of "
Business Services |
Resalve Name Time Zone
Immediately - Preference | |~ SYStem Default s

Hold on Start: []

Virtual Resource 10

Hold Resources on
Priority a

Failure

— Monitor Details

Status To Monitor : Running/Problems, Cancel Pending, In Doubt, Start Failure, Confirmation Required, Cancelled, Failed v
Monitoring Type : | General Task(s) v
Task Mame
Condition : |~ 11018 = <
TaskType To
Monitor Workflow, Linux/Unix, Windows, Manual, File Monitor, Task Monitor, Email, ZOS, Timer, File Transfer, FTP File Monitor, SQL, Stored Procedure, Uni_.. | v
l
Workflow Name
Condition - |~ e~ hd
Time Scope : |- None — v
— Wait/Delay Options
Wait To Start : |- Mone — v
Delay On Start: |- Mone — ~
‘Workflow Only : |- System Default — ¥
— Time Options
Late Start: []
Late Finish: []
Early Finish: []
User Estimated __Day Hour, Hin Sec
Duration : > > v v
Critical Path Options
’7 CP Duration : CP Duration Unit: Minutes B

— Workflow Execution Options

Execution

Restriction - 0"~ b4

[ save [Z) Save & New Save & View 3L Close
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Creating a Task Monitor Trigger
As the last step in our set-up process, we will create the Task Monitor trigger, which controls when the Task Monitor task is started and stopped.

Step 1 From the Automation Center navigation pane, select Triggers > Task Monitor Triggers. The Task Monitor Triggers list
displays.

Step 2 Click the New button to display an empty Task Monitor Trigger Details and enter the following values:

® Name = Controls Monitors for Problems
® Task(s) = Triggered by Task Status
® Task Monitor = Monitors for Problems

Step 3  Click the Save button.

Task Monitor Trigger Details —lalx
[E] save [ Save&New [F] Save &View 3% Close

Task Montor Trigger

— General
Name : Controls Monitors for Problems
Description

Member of -
Business Services

Calendar : | System Default » Time Zone : | System (AmericaMew_York) v

Triggered by Task Status

Task(s): D

Purge By Retention
Duration o

— Status
Skip Count 0

Skip Trigger if
Active a

Task Monitor Details
’V Task Monitor : |Monitors for Problems B

Restrict Times : [0]
Special Restriction : [7]

[E] save [ save & New Save & View 3 Close

Step 4 On the Task Monitor Triggers list, right-click Controls Monitors for Problems and then click Enable.

Running the Task Monitor

To test our set-up, we need to run a task to one of the failure statuses that will trigger the email. To do so, we will launch the Pause for Manual Manual task created in the Running a Workflow with a
Conditional Path tutorial and force it into Failed status.

Step 1 From the Automation Center navigation pane, select Tasks > Manual Tasks. The Manual Tasks list displays.
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Step 2  Right-click the Pause for Manual task and, on the Action menu, select Launch Task.

Step 3 Display the Activity Monitor. It will list the Pause for Manual task instance, in Action Required status, and the Monitors for Problems Task Monitor task, which was launched when enabled the Controls Monitor for
Problems triggered

Dashboards Activity [ Manual Tasks

23 Task Instances \.|Last48 hours = | [ No quickfilter ~ || Custom Filter — None — | g Filter..
Instance Name Type Status Invoked By Start Time: End Time Updated ™ 7

E Pause for Manual Manual Action Required Manually Launched 2014-09-05 14:09:26 -0400 2014-09-05 14:09:26 -0400

D Monitors for Problems  Task Monitor Running Trigger: Controls Monitors for Problems 2014-09-05 14:08:57 -0400 2014-09-05 14:08:57 -0400

Step 4  Right-click on Pause for Manual to display an Action menu of actions currently available for this task instance.

Step 5 Click Cancel. Pause for Manual goes to Cancelled status and an Email task is launched by the Task Monitor trigger.

Dashboards Activity Manual Tasks

24 Task Instances \.|Last48 hours = | [4No quickfiter » | Custom Filter —None — v | 5B Filter
Instance Name Type Status Invoked By Start Time End Time Updated ™ A

D Triggered by Task Status Email Success Trigger: Controls Monitors for Problems 2014-08-05 14:19:31 -0400  2014-08-05 14:19:32 -0400  2014-08-05 14:19:32 -0400

E‘ Pause for Manual Manual Cancelled Manually Launched 2014-09-05 14:09.26 -0400  2014-09-0514:19:31 -0400  2014-09-05 14:19:31 -0400

D Wonitors for Problems  Task Monitor Running Trigger: Controls Monitors for Problems 2014-08-05 14:08:57 -0400 2014-08-05 14:19:31 -0400

Stepg | Check the Email account where you sent the notification.
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Step 9 Once the user receives the email, the user can quickly check for more information by looking at the Activity Monitor using the Cancelled Task Instances filter and clicking on the Instance Name of the problem task. As
shown in the illustration below, additional information about the issue is displayed in the Status Description field.

Manual Task Instance Details: Pause for Manual =63

[7] update & Re-run [ ViewParent ¢ Delete [[4 Refresh £ Close

Manual Task Instance Virtual Resources Exclusive Requests @ Notes
— General
Instance Name : | Pause for Manual Reference Id 1
Task: |Pause for Manual |j Invoked By : |Manually Launched

Task Description A Manual task run at 2014-09-05 14:09:26 -0400|

Member of

Execution User : |ops.admin
Business Semvices

= Time Zone

Calendar : | System Default
= Preference

- System Default—

Virtual Resource 10 - Hold Resources on o
Priority Failure

— Status

Status ;| Cancelled

. ... State was cancelled from ACTION REQUIRED to CANCELLED
Status Description :

Start Time : 2014-09-05 14:09:26 -0400 End Time : | 2014-09-05 14:19:31 -0400

Duration

— Wait'Delay Options
Wait Duration In

Wait To Start : | Seconds v 60
Seconds:
Delay On Start | Seconds v Delay Duration In
Seconds :
‘Workflow Only : No -
— Time Options
Late Finish : Late Finish Type : | Duration
Late Finish .
Finished Late : Duration 00 02 00 HH:MM:SS
Critical Path Options
’V CP Duration CP Duration Unit: |Minutes v

 Statistics
User Estimated Average Estimated 7 7
End Time End Time 2014-09-05 14:00:26 -0400
Shortest Estimated Longest Estimated
End Time End Time
[l Update 3 Re-run o View Parent & Delete 5| Refresh # Close

e
For additional information, see:

Email Task

Email Connections

Email Templates

Reports

All Task Instances Table (ops_exec)
Activity Monitor

Task Monitor Task

Task Monitor Trigger
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® Command Quick Reference
® Cancelling a Task Run
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Tutorial - Launching Tasks Using a Cron Trigger

Create a Cron Trigger

Step 1 From the Automation Center navigation pane, select Triggers > Cron Triggers. The Cron Triggers list displays.

Step 2 Click the New button to display Cron Trigger Details for a new trigger and enter/select the following values:

® Name = Launch Tasks Using Cron

® Task(s) = stonebranch-timertask-01, stonebranch-timertask-01=2, and stonebranch-timertask-03 Timer tasks

® Minutes = Number of minutes past the hour you want the tasks to run. For example, if you want the tasks to run at for 3:16, enter 16.

® Hours = Hour (in 24-hour time) that you want the tasks to run. For example, if you want the tasks to run at for 3:16, enter 15. Universal Controller uses the time zone of the Controller server.

Step 3 Keep the asterisks ( *) in the remaining fields and click the Save button.

F

Cron Trigger Details —lEl%
[E] save [R save&New [F] Save & View 8 Close

Cron Trigger

— General
Hame : Launch Tasks Using Cron
Description :

Member of
Business Services

Calendar: |System Default MBS Time Zone : | System (America/New_York) .
stonebranch-timertask-01
stonebranch-timertask-02 =

Task(s}: | stanebranch-timertask-03 D

Purge By Retention
Duration a

— Status

Forecast: [F]
Skip Count: 0

Skip Trigger if
Active a

Simulate : |- System Default — »

— Cron Details
Minutes: 50 Day Logic: And v
Hours: 16
Day of Month: *
Month: *
Day of Week: *
Cron Criteria: |50 16***

Restrictions
(Spema\ Restriction : [7]

[l save

I Save & New || [[5] Save & View & Close

Step 4 In the Cron Triggers list, right-click Launch Tasks Using Cron and click Enable.

Step 5 Open the Activity Monitor to see that three Timer tasks are run at the selected time.
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e
For additional information, see:

® Cron Trigger
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Tutorial - Aborting a Process Launched by a Task

You can use an Abort Actions to instruct Universal Controller to abort a process under certain conditions. For example, you may want to abort a task if it is running too long

In this tutorial, we will set a Timer task to run for 60 seconds and specify an Abort Action when the task runs 45 seconds.

Step 1 Open the Timerl task created in the Creating a Simple Workflow tutorial and enter / select the following values:

® Time in Seconds = 60

® Late Finish = enabled

® Late Finish Type = Duration

® Late Finish Duration = 00:00:45

Timer Task Details: Timer 1

= |ax
[E] update [l Launch Task g5 View Parents [y Copy (ff] Delete [[5 Refresh £ Close
Timer Task Variables Actions. Virtual Resources Mutually Exclusive | © Instances. Triggers Notes | @ Versions
— General
Task Name : Timer 1 Version : 2
Task Description
Member of
Business Senvices Operations, Tech Support ~
Resolve Name Time Zone
Immediately : 0 Preference ; - SYStem Default— e

Hold on Start: [

Virtual Resource - Hold Resources on
Priority

Failure : a

— Timer Details

Timer Type . Seconds

Timer Duration In

Seconds: 50

— Time Options
Late Start: [

Late Finish  Day Hour Min Sec

Duration | Duration:[00 [+ |[00 [v[[o0 [« [[45 [+

Late Finish : Late Ell;;zh
Early Finish : [T

User Estimated __Day Hour Hin Sec
Duration : v v v v

CP Duration

Critical Path Options
’7 CP Duration Unit : | Minutes

— Workflow Options
Execution
Restriction : 1%~ hd
— Statistics
First Time Ran :|2017-05-05 15:23:18 0400 Lowestinetance [+ inute 0 Seconds
Last Time Ran - |2017-05-05 16:23:18 -0400 Average '"ST'fm"Ze 1 Minute 0 Seconds
Last\nsta_nce 1 Minute 0 Seconds Highest Instance 1 Minute 0 Seconds
Duration Time
Number of 1
Instances
o pdate aunch Tas| lew Parents opy :| Delete % Refres 0se
] Updat Launch Task | || View Parent [ Delet Refresh ¥ cl

Step 2  Click the Actions tab to display the Actions list.
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Step 3  Click Abort Action to display the Abort Action list.

Step 4  Click New to display Abort Action Details for a new Abort action, enable On Late Finish, and click Save.

Abort Action Details B
[E] save [ saveaNew [f] Save&view 3 Close

Abort Action

[ Action Criteria

Status : -
Exit Codes :
On Late Start: [
On Late Finish :
On Early Finish - [5]

Description :

[ Action Details

Cancel Process I! &} Override Exit Code

Halt On Force Finish : [7]

[ save [ Save & New Save & View 3 Close

Step 5 Click the Timer Task tab and then click the Update button.
Step 6  Right-click Timer1 in the Timers Tasks list and click Launch Task.

Step 7 Navigate to the Activity Monitor and verify that after running for 45 seconds, the task instance status changes from Running to
Finished.
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Step 8

Open the task instance Details and note the status description indicates:

Fi ni shed due to abort action on Tiner 1

F

Timer Task Instance Details: Timer 1

=3[

‘H Update 0@ Re-run c§i] Delete ||% Refresh 3£ Close ‘

Timer Task Instance H Virtual Resources || Exclusive Requests H

— General

Notes |

Instance Name |T\mer1

Task |T\mer1

Invoked By |Manua|\y Launched ‘

Task Description

Member of

Business Services |Dperatmns‘ Tech Support

Execution User |ups admin ‘

Calendar - [System Default PT;;';ZZH"CZQ_ |- system Defautt —
Virtual Resuur’csl1 |v| Hold Resources on o
Priority Failure
- Status

status : [Finished

Status Description

Finished due to abort action on Timer 1. {Last Status=Running, Cancel Process If Acive=false, Halt On Force Finish=false} ‘

Operational Memo

Trigger Time |

Launch Time : [2017-10-26 15:43:17 -0400 |

Start Time |2017—10—26 15:43:17 -0400

End Time : [2017-10-26 15:44:02 -0400 |

Duration |4559:unds

Run Until Time |2017—10—26 15:44:17 -0400

— Timer Details

Timer Type |Seconds |v|

Timer Duration In 50
Seconds :

— Time Options
Late Finish

Finished Late

Late Finish Type |Duralmr|

Late Finish _ Day Hour Hin Sec
Duration : |00 00 00 45

— Statistics
User Estimated Average Estimated e
S T | g Time. |2017-10-26 15:43:17 0400 |
Shortest | ‘ Longest | ‘
End Time End Time
| Update || @@ Rerun || ¢ Delete || [ Refresh || 3§ Close |

For additional information, see:

® Setting Up Abort Actions
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Tutorial - Force Finishing, Force Finish-Cancelling, and Cancelling a Task

In this exercise, we will force finish, force finish/cancel, and cancel tasks within a workflow from three areas:
® Workflow Monitor
® Activity Monitor
® Task Instances list
You can run any of these three commands from any of these three areas. For stand-alone tasks, you can run these commands only from the Activity Monitor and Task Instances list.

Note

1
You can force finish, force finish/cancel, and cancel any task in Running status, but you only can force finish a task in Waiting status. See Manually Running and Controlling Tasks for a complete list of task
statuses for each command.

Step 1  Fromthe Automation Center navigation pane, select Tasks > Workflow Tasks. The Workflow Tasks list displays.

Step 2 Create a Workflow with an Agent-based task, such as a File Monitor task, that can be Force Finished, Force Finish / Cancelled, and Cancelled. (See the Creating a Simple Workflow tutorial for help on creating the
Workflow.)

Step 3  Click Launch Task to run the Workflow.
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Step 4 Force Finish a task from the Workflow Monitor:

1. From the Automation Center navigation pane, select Task Instances > Task Instances to display the Activity Monitor which displays, by default, a list of Active Task Instances.

2. Open the running Workflow and click the View Workflow button to display its Workflow Monitor.

3. Right-click a Waiting task and, from the list of Commands on the pop-up menu, click Force Finish. The status of the task changes from Waiting to Finished, and all successor task instances waiting for successful
completion of this task instance will start.

View/Edit
View/Edit In Tab

Commands Clear All Dependencies
Clear Predeceszors
View Predecessors/Successors Force Finish

Force Finish (Halt)
Insert Task As Predecessor... Hold

Inzert Task As Successor.. Skip

Details

Properties

Step 5 | Force Finish/Cancel a task from the Activity Monitor:

1. Return to the Activity Monitor.
2. Right-click a Simple Workflow task that is in the Running status and, on the Action menu, click Force Finish/Cancel. The status of the task changes from Running to Finished, and all successor task instances
waiting for successful completion of this task instance will start.

23 Task Instances
Instance Name Type Status
Danstonebi File Monitor Running

FOREVER |

#2 Force Finish Force Finish Timer

ecu-sleep-; & cancel Force Finish (Halt) Timer

stonebrang - Workflow Runnin
Force Finish/Cancel 2

workflaw-1 ) Force FinishiCancel (Halt) Workfiow Suscess

sysmon-dis — System Monitor SUCCESS
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Step 6  Cancel atask from the Task Instances list:

1. From the Automation Center navigation pane, select Task Instances > Task Instances to display the Task Instances list.
2. Right-click a Simple Workflow task in the Running status and, on the Action menu, click Cancel. The status of the task changes from Running to Cancelled, and all successor task instances waiting for successful
completion of this task will remain in the Waiting status. The status of Simple Workflow changes from Running to Running/Problems.

¥ Z3 Task Instances

Instance Name v | Type Status

Danstonebranch-filemonitnr-ni File Monitor Running

FOREVER Timer

3 -
ecu-sleep-30 @i Force Finish Timer

stonebranch-workflo @ ancs Workflow Running

e
For additional information, see:

Force Finishing a Task

Cancelling a Task

Force Finish / Cancelling a Task

Monitoring Activity from the Activity Monitor
Monitoring Activity from the Task Instances List
Monitoring Workflows
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Tutorial - Accessing Task Instance Details

Step 1 From the Automation Center navigation pane, select Task Instances > Activity to display the Activity Monitor.

Step 2  Click the Instance Name of any task instance to display its Task Instance Details. For example:

15
Timer Task Instance Details: Timer 1 =/alx
[F] Update [ Re-un (ff] Delete | % Refresh 3 Close
Timer Task Instance Virtual Resources Exclusive Requests Notes
— General
Instance Name ;| Timer 1 Reference Id 1
Task: |Timer 1 = Invaked By - |Manually Launched
Task Description
Member of
Business Services Operations, Tech Support Execution User : |ops.admin
Time Zone
Calendar : | System Default Preference - System Default —
Virtual Resource Hold Resources on
Priority o e Failure O
— Status
Status : | Finished
Status Description Finished due to abort action on Timer 1. {Last Status=Running, Cancel Process If. , Halt On Force Fi }
Operational Memao
Trigger Time Launch Time : |2017-10-26 15:43:17 -0400
Start Time © |2017-10-26 15:43:17 -0400 End Time : |2017-10-26 15:44:02 -0400
Duration : |45 Seconds
Run Until Time ;| 2017-10-26 15:44:17 -0400
— Timer Details
Timer Type . | Seconds »
Timer Duration In
60
Seconds :
— Time Options
Late Finish Late Finish Type : | Duration
Late Finish _ Day Hour Win Sec
Finished Late Duration - [00 00 00 45
— Statistics
User Estimated Average Estimated
End Time End Time 2017-10-26 15:43:17 -0400
Shortest Estimated Longest Estimated
End Time End Time
[E] update @ Re-run & Delete 5| Refresh 3 Close

Task Instance Details contain many fields not displayed in the Task Details for this task that provide information about this run (instance) of the task and all runs of the task, including the first time it was run; the
last time it was run; the number of times it has run; and the least, average, and most amount of time it has ever taken to run. |

Step 3 To view all details stored in the All Task Instances table (ops_exec) for this task instance, right-click anywhere in the Task Instance Details to display an Action menu and then click Details > Show Details.
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[Dashbuams E:i][ Activity Ei][TmTasm E:i][ Timer 1 [

Agent:

Agent Acquired:

Agent Acquired Hame:

Agent Cluster Acquired:

Agent Cluster Acquired Name:

Agent Hame:
All Dependencies Cleared: | falze
Attempt: 1
Average Estimated End Time: | 2017-05-05 15:32:03 -0400
Calendar: | 77171434c0a801c50168d5b62b5d 1 7ddee
Calendar Hame: | System Default
Can Delete: | true
Can Update: | true

Class: | ops_exec_sleep

CP Duration:

CP Duration (Resolved):
CP Duration Unit: | Minutes

CPUTime: | 0
Created: | 2017-05-05 15:31:02 -0400
Created By: | ops.admin
Credentials:
Credentials Name:
Credentials Unresolved:
Credentials Variable: | false
Critical: | false
Current Retry Count: |0
Delay Duration: | 00:00:00:00
Delay Duration In Seconds:
Delay On Start: | — None —
Duration: | 45 Seconds
Duration In Seconds: | 45
Early Finish: | false
Early Finish Duration: | 00:00:00:00
Early Finish Time: | 00:00
Early Finizh Type: | Time
End Time: | 2017-05-05 15:31:48 -0400
Exclude Backup: | false
Exclusive State: | Initial

Execution User: | ops.admin
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Exit Code:

Finished Early:

falze

Finished Late:

true

Forced Finished:

true

Hold on Start:

falze

Hold Reason:

Hold Resources on Failure:

false

Instance Hame:

Timer 1

Invoked By:

Manually Launched

10 Other:

0

10 Reads:

]

10 Writes:

]

Is Version:

falze

Late Finish:

true

Late Finish Duration:

00:00:00:45

Late Finish Time:

0000

Late Finizh Type:

Duration

Late Start:

falze

Late Start Duration:

00:00:00:00

Late Start Time:

0000

Late Start Type:

Time

Launch Time:

2017-05-05 15:31:02 -0400

Longest Estimated End Time:

2017-05-05 15:32:03 -0400

Maximum Retries:

]

Member of Business Services:

Operations, Tech Support

Member of Business Services:

3fal1cTd335a44f0a83c85855c833aac, 209586acia4f4eacbedBieBa3T48ceb?

Memory Peak:

]

Memory Used:

0

Next Retry Time:

Operational Memao:

Predecessors Satisfied Time:

Progress:

Projected End Time:

Queued Time:

Reference Id:

Resources Consumed:

false

Resources State:

Initial

Retention Time:

Retry Indefinitely:

falze

Retry Interval (Seconds):

60

Run Called:

true

D Critoria Do Timoe

faloa
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PO el VST T

IR

Run Criteria Trigger Time:

false

Run Until Time:

2017-05-05 15:32:03 -0400

Security Name:

Timer 1

Shortest Estimated End Time:

2017-05-05 15:32:03 -0400

Start Time:

2017-05-05 15:31:03 -0400

Started Late:

falze

State Changed Time:

2017-05-05 15:31:43 -0400

Status:

Finished

Status Description:

Finizhed due to abort action on Timer 1. {Last Status=Running, Cancel Process
If Active=falze}

Status History:

2017-05-05 15:31:0Z -0400: Defined
2017-05-05 15:31:03 -0400: BRunning
2017-05-05 15:31:48 -0400: Finished

Suppress Intermediate Failures:

false

Tab Hames Containing Data:

Table Hame:

ops_exec_sleep

Task:

6fb0f88152a7488ab7 3485847 c5f53e5

Task Description:

Task Hame:

Timer 1

Task Priority:

WMEDIUM

Time Wait State:

Initial

Timer Day Constraint:

— None —

Timer Duration:

00:00:00:00

Timer Duration In Seconds:

60

Timer Time (HH:MM):

0000

Timer Type:

Seconds

Trigger:

Trigger Hame:

Trigger Time:

Type:

Timer

Universal Template:

Universal Template Hame:

Updated:

2017-05-05 15:31:48 -0400

Updated By:

ops.system

User Defined Field 1:

User Defined Field 2:

User Estimated End Time:

uuiD:

145374909626278454885Y UYMISTOCZ

Vertex Id:

Virtual Resource Priority:

10

Wait Day Constraint:

— None —
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Wait Duration In 3econds:

Wait Time (HH:MM): | 00:00
Wait To Start: | — None —
Wait Until Time:
Waited for Exclusive: | false
Waited for Resources: | false
Workflow:
Workflow Definition:
Workflow Definition Hame:
Workflow Name:
Workflow Only: | Yes

Workflow Start Time:

Print |

® Left column shows each field in the All Task Instances table for this task instance.
® Right column shows the current value for each field for this task instance.
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Tutorial - Monitoring Task Activity

® Starting and Stopping the Activity Monitor
® Apply Time Constraints and Filters to the Activity Monitor
* Apply Display Settings to the Activity Monitor

In this tutorial, we will monitor task activity from the Activity Monitor.

We will start and stop the Activity Monitor, apply time constraints and filters to the task instances displayed on the Activity Monitor, and apply display settings to the Activity Monitor.

Starting and Stopping the Activity Monitor

By default, the Activity Monitor does not automatically monitor Universal Controller activity when you log in. You must start the Activity Monitor to see task activity.

(You can allow the Activity Monitor to automatically monitor Controller activity when you log in by changing the Activity Monitor Automatically user preference.)

Step 1 From the Automation Center navigation pane, select Task Instances > Activity. The Activity Monitor displays.

Dashboards Activity
7|Last48 hours » | [ No quickfilter ~ | Custom Filter — None — v | B Fiter..| &
Instance Name = Type Status. Invoked By Start Time End Time Updated =
B)
Click to start the Activity monitor
Start Stop

1 m ~
5 Seftings ~ ng H 4 b B Page of
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Step 2 To start the Activity Monitor, either:

1. Click the Click to start the Activity monitor button in the middle of the Activity Monitor.
2. Click the Start Activity monitor button at the bottom of the Activity Monitor.

The Activity Monitor then displays a list of all current activity.

Dashboards Activity 3
646 Task Instances || Last48 hours « @Nu quickfilter =  Custom Filter —None — v ‘@ Filter. &
Instance Name Type Status Invoked By Start Time End Time Updated ¥ -
tecu-wkfl-sleep Workflow  Success  Manually Launched 2014-09-02 12:57:55 0400 2014-09-02 12:58:36 0400 2014-09-02 12:58:36 -0400
sleep 10 Timer Success Workflow: 'ecu-wkfl-sleep 2014-08-02 12:58:26 -0400  2014-09-02 12:58:36 -0400  2014-08-02 12:58:36 -0400
Sleep 30 Timer Success Workflew: lecu-wkfl-sleep 2014-09-02 12:57:56 -0400  2014-09-02 12:58:26 -0400  2014-09-02 12:58:26 -0400

Skeep 0 Timer Success  Workflow: lecu-wkfl-sleep 2014-09-02 12:57:5 20140902 12:57:56 0400  2014-09-02 12:57:56 -0400
Sleep 60 Timer Skipped Workflow: 'ecu-wkfl-sleep 2014-08-02 12:57:55 0400  2014-08-02 12:57:55 -0400
Sleep 60 Timer Skipped Workflow: lecu-wkfl-sleep 2014-09-02 12:57.55-0400  2014-09-02 12:57.55 -0400
Sleep 80 Timer Skipped Workflow: 'ecu-wkfl-sleep 20140902 12:57:55 0400  2014-09-02 12:57:55 -0400
Sleep 30 Timer Skipped Workflow: 'ecu-wkfl-sleep 20140902 12:57:55 0400  2014-09-02 12:57:55 -0400
Sleep 30 Timer Skipps Workflow: lecu-wkfl-sleep 2014-09-02 12:57.55-0400  2014-09-02 12:57.55 -0400
win-exit-code Windows Failed Manually Launched 20140902 12:44:03 0400 2014-09-02 12:44:03 0400  2014-09-02 12:44:03 -0400
z0s-workflow-regrassion-test Workflow Success  Manually Launched 2014-08-02 11:52:47 0400 2014-09-02 12:10:30 -0400  2014-08-02 12:10:30 -0400

zos-workflow-simple-load-test-01  Workflows Success Workflow: zos-workflow-regression-test ~ 2014-09-02 11:56:39-0400  2014-09-02 12:10:30 -0400  2014-09-02 12:10:30 -0400

zos-task-load-simple-01 2/0S. Success  Workflow: zos-workflow-simple-load-test-01 2014-09-02 12:10:28 0400 2014-09-02 12:10:29 -0400  2014-09-02 12:10:30 -0400
z0s-task-load-simple-01 /05 Success  Workflow: zos-workflow-simple-ioad-test-01 2014-08-02 12:10:25 0400 2014-09-02 12:10:26 -0400  2014-09-02 12:10:27 -0400
zos-task-load-simple-01 zI0S Success Workflow: zos-workflow-simple-load-test-01 2014-09-02 12:10:23 -0400  2014-09-02 12:10:23 -0400  2014-09-02 12:10:24 -0400
2z0s-task-load-simple-01 /03 Success  Workflow: zos-workflow-simple-load-test-01 2014-09-02 12:10:20 -0400  2014-09-02 12:10:20 -0400  2014-09-02 12:10:21 -0400

zos-workflow-simple-load-test-02  Workflow Success  Workflow: zos-workflow-regression-test  2014-08-02 11:56:39 -0400  2014-08-02 12:10:19-0400  2014-09-02 12:10:19 -0400

zos-task-load-simple-02 zI0S Success Workflow: zos-workflow-simple-load-test-02 2014-09-02 12:10:17 -0400  2014-09-02 12:10:17 -0400  2014-09-02 12:10:19 -0400
2z0s-task-load-simple-01 ELES Success  Workflow: zos-workflow-simple-load-test-01 2014-09-02 12:10:15-0400  2014-09-02 12:10:15 -0400  2014-09-02 12:10:19 -0400
z0s-task-load-simple-02 /05 Success  Workflow: zos-workflow-simple-load-test-02 2014-09-02 12:10:12 0400 2014-08-02 12:10:12-0400  2014-09-02 12:10:15 -0400
zos-task-load-simple-01 zI0S Success Workflow: zos-workflow-simple-load-test-01 2014-09-02 12:10:11 -0400  2014-09-02 12:10:11 -0400  2014-09-02 12:10:14 -0400

zos-workflow-simple-load-test-03  Workflow Success  Workflow: zos-workflow-regression-test  2014-09-02 11:56:39-0400  2014-09-02 12:10:13-0400  2014-09-02 12:10:13 -0400

i s e s B s B s v B O s s o T

z0s-task-load-simple-03 zi0S Success Workflow: zos-workflow-simple-load-test-03 2014-08-02 12:10:08 -0400  2014-08-02 12:10:09 -0400  2014-09-02 12:10:13 -0400

zos-task-load-simple-02 zI0S Success Workflow: zos-workflow-simple-load-test-02 2014-03-02 12:10:07 -0400  2014-03-02 12:10:03 -0400  2014-03-02 12:10:11 -0400

zos-task-load-simple-01 zI0S Success Workflow: zos-workflow-simple-load-test-01 2014-09-02 12:10:06 -0400  2014-09-02 12:10:06 -0400  2014-09-02 12:10:10 -0400
5 m >
{85 Settings ~ |[(0) | @ M q Next B Last Page 1 i 26

Step 3 To stop the Activity Monitor, click the Stop Activity monitor button at the bottom of the Activity Monitor.

Apply Time Constraints and Filters to the Activity Monitor
(You can select apply any time constraint for any combination of multiple filters for the list of task instances on the the Activity Monitor.)

Step 1 Select a time frame of task activity to display on the Activity Monitor by clicking the Time Constraint button and selecting a time fame from the menu. The default is Last 48 hours, which means that the Activity Monitor
will display only task activity that occurred in the last 48 hours.

Step 2 Click the Quick Filter button to display a menu of simple, pre-defined filters that you can apply to the list, such as a specific task type of specific task instance status. You can apply as many Quick Filters as you like to
the list.

Step 3 Click the Clear button at the bottom of the Quick Filter menu to remove all Quick Filters from the list.

Step 4 Click the Filter button to select a Custom Filter of complex, user-defined filter that you can apply to the list, such as only task instances that belong to a specific Business Service.
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Apply Display Settings to the Activity Monitor

Step 1 Click the Settings button at the bottom of the Activity Monitor to select:
® Number of task instances to display on each page of the Activity Monitor.
® Refresh rate for the dynamic data displayed on the Activity Monitor.
Step 2 Click the First, Prev, Next, and Last buttons at the bottom of the Activity Monitor to navigate through multiple pages of
activity.

Step 3 Click the ellipse ( ... ) button at the bottom of the Activity Monitor to select a specific page of activity to display.
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Tutorial - Creating a Simple Workflow

® Introduction

® Create and Copy Tasks

® Creating a Simple Workflow
® Running the Workflow

Introduction

In this tutorial, we will learn how to copy tasks, create a simple Workflow of Timer tasks, and use the tools available in the Workflow Editor.

Create and Copy Tasks

Create a Timer task and make five copies for use in the Workflow. Use the names Timer1 through Timer6, and assign each task a time of 10 seconds.

Note
1
You can copy tasks using different methods. One method is provided below.

Step1  From the Automation Center navigation pane, select Tasks > Timer Tasks. The Timer Tasks list displays.

Step 2  Inthe Timer Task Details below the list, create Timerl and click Save.
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Step 3 Change the Task Name from Timer1l to Timer2, right-click the Details to display an Action menu, and click Insert to make a copy of the Timerl task named Timer2.

Timer Task Details: Timer 1 =]
[ Update [} Launch Task [& ViewParents [ Copy ¢ Delete | % Refresh &£ Close
Timer Task Variables Actions Virtual Resources Mutually Exclusive Instances Triggers Notes Versions
[ General [E) Launch Task
Task Name : Timer 2 Version : 1 [Z] Launch Task with Variables
Task Description
Member of [Z openinTan "
Business Services
Resolve Name Time Zone
Immediately a Preference . — Ststem Default — [E] Update
Hold on Start: [ Update & View
Virtual Resource - Hold Resources on ] #l Insert
Priarity | 10 Failure - B Insert & View
Copy —
— Timer Details —
Timer Type - | seconds s &4 ViewBundles
Timer Duration In @) Add To Bundle
Seconds:
= Promote
r— Time Qptions —
Late Start [7] Reset Statistics
Late Finish: [] [
Early Finish : [ __'ﬂ Set Execution Restriction
User Estimated _ Day Hour Min Sec b
Duration v . 03 3
&y View Parents
Critical Path Options
’7 CP Duration P Duration Unit- [1inutes | Delete
— Workflow Execution Options 3 Close _—
Execution N . e
Restriction : ~Mone = @ Details .
[F] Update | |[5) Launch Task |[&5 View Parents Ll Copy ci#] Delete 5| Refresh 3 Close %l Refresh
£

Step 4 Repeat Step 3 for Timer3 through Timer6.

Creating a Simple Workflow

Now that we have six Timer tasks, we are ready to create a simple workflow.

(See Creating and Maintaining Workflows for detailed information on the tools and icons used in this procedure.)
Step 1 From the Automation Center navigation pane, select Tasks > Workflow Tasks. The Workflow Tasks List displays.

Step 2 In the Workflow Task Details below the list, enter Simple Workflow in the Task Name field and then click the Save button.
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Step 3  Right-click Simple Workflow in the Workflow Tasks list and click Edit Workflow in the Actions menu to display the Workflow Editor.

Administrator » 53 2]
Workflow Tasks Workflow Editor

ClodSIBIRMr Ao +BaX|Aad8d|Es|Be0E

By default, the Workflow Editor displays in Select mode, which lets you select tasks for the Workflow.

(See Workflow Editor Icons for a description of each icon on the toolbar.)
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99

/

Step 4
Click the Add Task

[a

icon. The Task Find pop-up dialog displays.

Task Find I
Task Name: All Task Types j Search |
| | Task Type Task Name

al

Step5  Select Timer in the drop-down list and click the Search button. A list of all Timer tasks displays.
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Step 6 Drag and drop the icon for Timerl onto the Workflow Editor canvas, and repeat for Timer2 through Timer6.
Workflow Tasks ] | Workflow Editor ]
oS BRIFM. /o +BEXAAAAA |54 BSE
Task Find ]|
G Task Hame: Timer Timer ~| Search
G G [ TaskType Task Name
Timert Tmerz ) Q Timer Timer1
Timer3 @O Timer Timer2
Q Timer Timer3
Q Timer Timerd
QO Timer Timers
Timera G G @ Timer Timers
Timer5
Timerg
Cl
q | I
Workflow Name: Simple Workflow
Step 7 Close the Task Find pop-up dialog.
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Step 8 Click and drag the tasks so that Timerl is at the top of the canvas; Timer2, Timer3, and Timer4 are below Timerl; and Timer 5 and Timer6 are below Timer2, Timer3, and Timer4.

Workflow Tasks [ | Workflow Editor [
Gl S IBIROS A on+BaX|Aaaaad|44|BSE
Timer1
Timer2 Timer3 Timerd

@ ©

Timers Timerf
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Step 9 Click a Connect Icon to connect the tasks so that Timerl is the top-level predecessor task; Timer2, Timer3, and Timer4 are successor tasks to Timerl; and Timer5 and Timer6 are successor tasks to Timer3.

Workflow Tasks Workflow Editor

ClORSIBIFM S A 0a¢BEXAA43 (446 BSB

)

Timeri

f
¢ © ¢

Timer2 Timer3 Timerd
Timers Timer6
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Step 10 The default condition (or dependency) for connectors is Success. That is, a successor task runs if its predecessor task goes to Success. To view the conditions for a successor task, right-click the connector between it
and its predecessor task, and then click Conditions. The Conditions pop-up displays.

Workflow Tasks Workflow Editor

GIOHBIBIFM T /o b@EXA8a8dlds BS&E

o

Timeri

I
¢ © ©

Timer2 Tgner} Timer4
Conditions
& success
e T Faiure
 successiFaiure
© Exit Codes)
Timer5s Tim
OK | Cancel

Note

1
Since a Timer task cannot go to Failure, the Failure and Success/Failure conditions are grayed out.

septt | ) | =M. |
P Click the Cancel button on the Conditions pop-up, and then click the Save icon in the Workflow Editor task bar to save the Workflow.

Running the Workflow

Now we will manually launch the Workflow and view it from the Activity Monitor.
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Right-click anywhere in the Workflow Editor canvas and, on the pop-up menu that displays, click Launch Workflow.

Workflow Name: Simple Workflow

From the Automation Center navigation pane, select Task Instances > Activity. You will see six task instances: the Simple Workflow task, and the six Timer tasks.

Step 1
Workfiow Tasks [ | Workflow Editor [
Tl S GEor slom+@mxaaaaa
/ Tmer1\
Timer2 Timer3 Timer4
/ \ VigwEdit
G G | Paste
Timers Timers
Find In Graph
Pan To Top
Step 2

Home [ | Workflow Tasks [ | Workflow Editor 3 | Activity [

|--|Last48 hours ~
Instance Name Type Status

E| Timers Timer Success
E| Timers Timer Success
El Simple Workflow Workflow Success
E| Timer2 Timer Success
E| Timer3 Timer Success
El Timerd Timer Success
E| Timer1 Timer Success

Custom Filter — pNone —

Invoked By

Workflow: Simple Workflow
Workflow: Simple Workflow
Manually Launched
Workflow: Simple Workflow
Workflow: Simple Workfiow
Workflow: Simple Workflow
Workflow: Simple Workflow

| 5 Filter..
Start Time: End Time
2014-07-28 11:38:54 -0400  2014-07-281
2014-07-28 11:38:54 -0400  2014-07-28 1
2014-07-28 11:38:34 -0400  2014-07-281
2014-07-28 11:38:44 -0400  2014-07-281
2014-07-28 11:38:44 -0400  2014-07-281
2014-07-28 11:38:44 -0400  2014-07-281
2014-07-28 11:38:34 -0400  2014-07-281

For additional information, see:
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® Saving, Updating, Deleting, and Copying Records
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® Creating Workflows
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Tutorial - Running a Workflow with a Conditional Path

® [ntroduction
® Prerequisite
Create a Timer Task
Create SQL Tasks
Create a Manual Task
Create a Workflow
Run the Workflow to Success
Run the Workflow Down the Conditional Path

Introduction

In this exercise, we will create a short workflow of SQL tasks. We will begin with a two-minute Timer task so that we will have enough time to see what the Workflow looks like on the Activity Monitor when we
launch it. We will also create a conditional path, as follows:

* The Workflow runs seven days a week and creates a new database table. If that is successful, additional SQL tasks run that insert a value, select a count, and delete a value. Each subsequent task
runs if the previous is successful.
® |[f the first (table creation) task fails, the Workflow goes to a Manual task instead of the regular flow. This is the conditional path. The Manual task creates a pause in the Workflow and sends an Email

Notification. A user is expected to check the database and fix the problem that caused the first task to fail. If the Manual task is set to a Complete status, it goes to Success and the Workflow then
returns to the remaining SQL tasks. While the Manual task remains in the Action Required status, the successor tasks have a Waiting status.

We will also add an Email Notification and a Note to this Workflow.

Prerequisite

Since we are using SQL tasks in this exercise, you will first need to create a SQL Database Connection.

Create a Timer Task

We will add a Timer task at the beginning of our Workflow so that we will have a chance to view it when Universal Controller loads it into the Activity Monitor.

Step 1 From the Automation Center navigation pane, select Tasks > Timer Tasks. The Timer Tasks list displays.
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Step 2 Click New to display an empty Timer Task Details and enter / select the following values:

® Task Name = Two Minute Timer
® Timer Type = Secocnds
® Time Duration in Seconds = 120

Timer Task Details =114
[E] save 03 Save & New [[j Save & View $§ Close

Timer Task

— General

Task Name : Two Minute Timer

Task Description
Member of
Business Services
Resolve Name B Time Zone
Immediately Preference :
Hold on Start: []

Virtual Resource Hald Resources on B
Priority Failure :

— System Default - v

— Timer Details
Timer Type * Seconds >

Timer Duration In

Seconds: 120

— Time Options
Late Start: []

Late Finish: [7]

Early Finish: []

User Estimated  Day Hour Min Sec
Duration v v v -

Critical Path Options
’7 CP Duration CP Duration Unit : Minutes .

— Workflow Execution Options

Execution

Restriction : [~ Nene = X

[ save I3 Save & New | | [f] Save & View 3 Close

Step 3  Click the Save button.

Create SQL Tasks

In this exercise, we will create SQL tasks that execute the following SQL commands:
® Create a new table in the database.
® Insert a value into the table.
® Select a count value from the table.
® Delete the value from the table.

Perform the following steps to create the SQL tasks:

Step 1 From the Automation Center navigation pane, select Tasks > SQL Tasks. The SQL Tasks list displays.
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Step 2 Click New to display an empty SQL Task Details and enter / select the following values:
® Task Name = SQL Create Table
® Database Connection = (the database connection you created as a [prerequisite|#Prerequisite])
® SQL Command = CREATE TABLE opswise_tut${ date("yyyyMMdd",5)} (name varchar(128), value varchar(128));

=3[

P
5QL Task Details
[E] save [ Save &New [[) Save &View 3£ Close |

| SOL Task

— General
Task Name : SQL Create Table

Task Descripfion

Member of
Busmess‘ |v|
Senvices
Resolve Name Time Zane
Immediately O Preference |— System Default — ‘v ‘
Hold on Start: []
Virtual Resource Hold Resources on
Priority ‘1[] ‘v ‘ Failure B
— SOL Details
o Da'ab.‘""“"‘_‘m Ms3ql Connection — Credentials :|
Database
Connection [ Credentials B
Variable
Variable
Maximum Rows : Aute Cleanup: [7]

CREATE TABLE gpswise_tuts{_dateCywyyMMdd™ 51} (name varchar(128), value varchar(128));

SQL Command :

esult
Fracessing : 5P Result Pracessing M

— Retry Options
Maximum Retries : 0 Retry Indefinitely : [7]

Suppress
Retry Interval
(Seconds) G0 Intermediate [7]
Failures

— Wait/Delay Options
Wait To Start — None — [v]

Delay On Slan.‘—Nune— ‘v‘

Workflow Dmy"— System Default — M

— Time Options
Late Start: [
Late Finish: [7]
Early Finish - [
User Estimated _ Day Hour Min Sec

Duration : E E/ |I/ E

’7 Critical Path Options

CP Duration CP Duration Unit - |Minutes [«

| [Jsave || save&New | [f) Saveaview|| & Close

[Em

Step 3  Click the Save button.
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Step 4  Create a SQL task called SQL Insert Value with this value:

® SQL Command = INSERT INTO opswise_tut${_date("yyyyMMdd",5)} (name, value) values (A', 'F'), (B, 'S"), (C'", 'F");

Step5  Create a SQL task called SQL Select Count with this value:

® SQL Command = SELECT count (*) as count FROM opswise_tut${ date("yyyyMMdd",5)} WHERE value = 'F

Step 6  Create a SQL task called SQL Delete with this value:

® SQL Command = DELETE FROM opswise_tut${_date("yyyyMMdd",5)};

Create a Manual Task

A Manual task is used within a Workflow to create a pause in processing, during which the user must perform some task. When the user task is complete, the user sets the Manual task to a completed state and
processing continues.

For our Manual task, we are also going to request a warning if the user takes too long to complete it.

Step 1  Fromthe Automation Center navigation pane, select Tasks > Manual Tasks and click New.
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Step 2

Step 3

110 /

® Task Name = Pause for Manual
® Task Description = A Manual task run at

${_date()}

In the Manual Task Details, enter / select the following values:

(a variable that indicates the date and time the Manual task launches)
® Late Finish = enabled

® Late Finish Type =

Duration

® Late Finish Duration = Hours 00 02 00 (2 minutes)

Manual Task Details

Wanual Task

= [=)[E3

[E] save U3 Save &New [[] Save &View 3£ Close

— General

Member of
Business Senices
Resolve Name ]
Immediately :
Hold on Start: [

Virtual Resource
Priority :

Task Name : Pause for Manual

Task Description : AManual task run at ${_date()}

Time Zone
Preference :

Hold Resources on ]
Failure :

— System Default — ~

— Wait'Delay Options
Wait To Start .| — None —
Delay On Start: | _ nNone —

Workflow Only © | — System Default -

— Time Options
Late Start: [7]
Late Finish

Early Finish = [

UserEstimated __ Day
Duration v

Late Finish Type
Late Finish

Duration : |00

Hour Min Sec

v v v

Duration
Day

Hour Hin Sec

v [[00 | |02 |v |00 |+

Critical Path Options
’7 CP Duration

CP Duration Unit | Minutes

Execution

Restriction

Workflow Execution Options
’7 —None —

[F] save

[y save & Mew

Save & View

% Close

Click the Save button.
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Step 4 Add a Note:

1. Click the Notes tab and then click New to display Note Details.
2. Enter the following values:

* Title = Probable database problem

® Text = Make sure database is running.

3. Click Save.
Note Details BEE
[] save g Save & New [fj Save & View 3% Close
Note
— Details =

Title : Probable database problem

Make sure database is running

Text

[ save I Save & New | | [y Save & View 3 Close
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Step 5 Add an Email Notification:

. Click the Actions tab.
. Click Email Notification in the list of Action types.
. Click the New button to display Email Notification Details for a new Email Notification.
. Enter / select the following values:
® Status = ACTION REQUIRED
® Email Connection = (the Email Connection you created earlier)
To = (your Email address)
® Subject = Issue with Workflow
Body = ${_date} workflow failure; notification triggered by $\{ops_task_name} |

A WNE

F
Email Hotification Details mEE3
[E] save [ Save & New Save & View £ Close
Emall Notification
— Action Criteria
Status : |Action Required -

Exit Codes
On Late Start: [7]
On Late Finish: [F]
On Early Finish : [7]

Description

— Action Details
Email Template v |[= Email Connection | QA-MAILER v

Email Template
Variable a

Reply-To

support@stonebranch.com
To

Bee

Subject: Issue with Workflow

§{_date} workflow failure; notification triggered by ${ops_task_name}

Body

Report v\ Reportvariasle [

[l save I3 Save & New Save & View 3 Close

Step 6  Click the Save button.

Create a Workflow

Create a Workflow containing the Timer, SQL, and Manual tasks that you just created.
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Step1  Fromthe Automation Center navigation pane, select Tasks > Workflow Tasks and click New.
Step 2 In the Workflow Task Details, enter the following value:
® Task Name = SQL Workflow
Step 3 Click the Save button, right-click SQL Workflow on the Workflow Tasks list, and then click Edit Workflow on the Action menu.
Step 4 In the Workflow Editor, use the Add Task tool to drag the tasks you just created onto the canvas.

Step 5 Organize the tasks and create connections as shown in the following illustration. The Success connectors tell the Controller that if SQL Create Table goes to Success, run Insert SQL Value and the other SQL
tasks.

Step 6 Create a conditional path specifying that if SQL Create Table fails, the Controller should run the Pause for Manual task:
1. Right-click the connector between SQL Create Table and Pause for Manual.

2. On the pop-up menu, click Conditions.
3. On the Conditions pop-up dialog, enable Failure and click the OK button. Note that the connector is a dotted line, which indicates a Failure connection.

Step 7 On the Workflow Editor toolbar, click the Save icon.

\C

Two Minute Timer

5aL saL 5aL
5QL Create Table SQL Insert Value 5qL Select Count SQL Delete

1?_,

Pause for Manual

Run the Workflow to Success

We are going to launch our Workflow and view it from two different perspectives: from the Activity Monitor and the Workflow Monitor.
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Step 1 Launch the workflow manually.

Display the Activity Monitor. Because the Two Minute Timer task is still running, your display should look similar to this:

Step 2
Dashboards [] | Activity [J | Workflow Tasks ]
639 Task Instances |.|Last48 hours » | [ No quickfilter « | Custom Filter — None — v | 3 Filter.
Instance Name Type Status Invoked By Start Time: e
E‘ SQL Select Count saL ‘Workflow: SQL Workflow
E S0L Create Table saL ‘Workfiow: SQL Workflow
E Pause for Manual Manual Workflow: SQL Workflow
E‘ SQL Delete saL ‘Workflow: SQL Workflow
E SOL Insert Value saL ‘Workfiow: SQL Workflow
E Two Minute Timer Timer Running ‘Workfiow: SQL Workflow 2014-08-2215:42:21 -0
E‘ SQL Workflow Workflows Running Manually Launched 2014-08-22 15:42:20 -0
Step 3 Right-click SQL Workflow on the Activity Monitor list to display an Action menu and select Workflow Task Commands > View Workflow. The Workflow Monitor opens and shows progress on the task. The Workflow

Monitor updates automatically with each status change.

Two Minute Timer
Success

sSaL 5aL

SQL Create Table SQL Insert Value SQAL Select Count S5QL Delete
Finished

i

Pause for Manual
Action Required
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When the Timer task finishes, the SQL tasks execute. All tasks go to Success and the workflow goes to Success. The only task that did not run is the conditional task, Pause for Manual.

Sleep 2 Minutes

Success
e [54 s o
s5QL)———» saLl——m» saL)}——m@38 50L
SOL Create Table SOL Insert Value SOL Select Count SOL Delete
Success Success Success Success

Pause for Manual
Skipped

Run the Workflow Down the Conditional Path

Recall that we inserted a date variable into the INSERT TABLE command. Thus, you can run this workflow every day and get a new table name each day, based on the date. For the purposes of our exercise,
assuming you are performing it on the same day you did the previous exercise, the SQL Create Table task will fail this time because the table already exists.

Step 1 Return to the Bigger Workflow task and launch it again.
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From the Activity Monitor, click the Workflow name to view it from the canvas. This time, the workflow goes down the conditional path. Note that when you set up a conditional path, what would normally be a Failure status for the SQL Create Table

SiEp2 task becomes a status of Finished. If you ran this task as a standalone task or without the conditional path, its status would say Failed.
Sleep 2 Minntes
Success
SQL{————» (] R — s5QL ———————» SOL
SOL Create Table SOL Insert Value SOL Select Count SOL Delete
Finished
-
Pause for Manual
Action Reguin
Step 3 When the Pause for Manual task launches, it generates the Email Notification we added earlier.
from  opswise.test@gmail.com hide details 5:32 PM (0 minutes ago) | € Reply | ¥
to @ canneturn@grmail. com
date  Mon, Aug 17, 2009 at 5:32 PM
subject  lssue with Bigger Workflow
mailed-by  gmail.com
signed-by  gmail.com
2009-08-17 16:31:55 -0700 workflow failure; notification triggered by Pause far Manual
©Reply = Forward 2 jruite opswise testf@gmail.corn to chat
Step 4 The user receives the email, which provides the name of the task that generated it (Pause for Manual in our case). The user might also be running a special Activity Monitor that displays only Manual tasks in the Action Required status. According
to our scenario, the user opens the Pause for Manual task and checks the Notes to find out what action he or she is supposed to take. In our case, the Notes say to check the database and bring it back up.
Step 5 At this point, the workflow processing could continue in either of two ways:
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1. Re-run the task that failed and send the workflow down the success path.
2. Set the Pause for Manual task to Completed status and continue the workflow from there.

We will try both methods.
3. Re-run the failed task; right-click the task and select Commands > Re-run. In a real processing situation, this is the method you would use because you need to create the table before you can continue.

a. Right-click the task that failed and select Commands > Re-run.

Sleep 2 Mimnes
Success

fe] fic]

_ - 5GL » 50L
SOL Cre T Insert Value SOL Select Count SOL Delete

Pause for Manual

Note that we are still on the same day so the task fails again because the table already exists. In a real processing situation, the task would go to Success and the subsequent tasks would run as expected.
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4. Set the Manual task to Complete status. For the purposes of our exercise, we will get the workflow going again by setting the Manual task to complete.
a. Right-click the Manual task.
b. Select Commands > Set Completed.

Cancel
Opswike - Force Finish
Agiian B Properties Set Started
|  Setcompleted
The Manual task goes to Success and the rest of the workflow runs.
Sleep 2 Minutes
Success
i
5L — sQL SOL sQL
SOL Create Table SOL Insert Value SOL Select Count SOL Delete
Finished Success Success Success
E Console | o | 4 |
E Monday, August 17, 2009 1:09:31 PM: Command Set Completed executed
. successfully against task instance Pause for Manual.
Pau:se for Mallnual
gougessy
Clear |
: 4

c. Because we set a two-minute Late Finish flag on our Manual task and we (presumably) took more than two minutes to complete it, the Manual task has been flagged as a late finish. To view the flag, go to the Activity Monitor and click
the Manual task name. In the task instance Details, an enabled Finished Late field now displays, and the Duration field indicates the duration of the task.
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For additional information, see:

Activity Monitor

Monitoring Workflows
Database Connections
SQL Task

Manual Task

Email Notification Actions
Creating Notes

Creating Conditional Paths
Adding Skip/Run Criteria
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Tutorial - Running a Workflow with Multiple Conditional Paths

In this tutorial, we will create a Workflow containing tasks with multiple predecessors and multiple successors, and specify different conditional paths for those tasks.
The Workflow will show that:

® A successor task with multiple predecessor tasks needs only one of the predecessor tasks to be Successful in order to run.
® Tasks are skipped if they are in conditional paths not taken.

Step 1 From the Automation Center navigation pane, select Tasks > Workflow Tasks and click New.
Step 2 In the Workflow Details, name the Workflow Multiple Paths and click the Save button.

Step 3 Click the Edit Workflow button to display the Workflow Editor.
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Step 4 Add 10 tasks to the Workflow and specify connections for them, as shown below. (In this example, Email tasks have been added, but you can add any type of task except Timer tasks, since they have only one type of
Conditional path: Success.)

By default, all connections define a Successful condition; if the predecessor task runs to Success, the successor task will run.

Email #2 Email #3

Email #1

Email #5

Email #6

Email #7 -
Email #9

Email #8 Email #10
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Step 5

Step 8

Step 9

Create a Failure condition between tasks #2 and #6, #3 and #6, and #6 and #9, as shown below:

. Right-click the connection between them,.
. Click Conditions on the pop-up menu.

. Select Failure.

. Click OK.

B WN P

Connections with Failure conditions displays as dotted lines.

Email #2 Email #3 Email #4

.
¢

Email #1 / é
:5 Email #5

Email #6
Conditions
 Success

5 , 0 Failure
o Success/Failure

Email #7 — € Exit Code(s)
Email :

lilﬂl

Email #8 Email #10

Launch the workflow.

In the Automation Center navigation pane, select Task Instances > Activity to display the Activity Monitor.
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Step 10  From the list of Task Instances, click Multiple Paths. The Workflow Monitor for that Workflow displays.

Email #2 Email #3 Email #4
Success Success Success
. B

Email #1
Success

Email #5
Success

Email #6
Success

Email #7

Success Email #9

Skipped

Email #8 Email #10
Success Skipped

The Workflow Monitor shows that task #6 ran even though the conditions for two of its predecessor tasks (#2 and #3) specified that it was to run only if those two tasks failed, because the condition for its #5
predecessor task specified that it was to run if #5 ran successfully, which it did.

It also shows that tasks #9 and #10 were Skipped because the Controller took the Success path for task #6 and ran Tasks #7 and #8.
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Tutorial - Running a Workflow with Skipped Criteria

® Introduction

® Create the Daily Workflow

® Run the Daily Workflow

® Check the Skipped Workflow's History

Introduction

In this exercise, we will create a daily Workflow that includes a task that we want to skip on Fridays. We will also include a Workflow within a Workflow and later check the skipped status of the skipped
Workflow.

Create the Daily Workflow

Step 1 Create a Workflow named Workflow with Skipped and add the following tasks created in the Creating a Simple Workflow tutorial:

® Four Timer tasks: Timerl, Timer2, Timer3, Timer4.
® One Workflow task: Simple Workflow.
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Step 2 Organize the tasks in the Workflow as shown in the following illustration (using all Success conditions) and click the Save icon.
Home [ | Workflow Tasks [] || Workflow Editor []
GRS |RIEM Al +sBEXA0aadl|es BSE
C—0—=2 00
Timer1 Timer2 Simple Workflow N N
Timer3 Timerd
Workflow Mame: Workflow with Skipped, Last Saved: 7/28/2014, 2:23:27 PM
Step 4 Right-click Simple Workflow and, on the pop-up menu, click View/Edit Run Criteria. The Task Run Criteria list for Simple Workflow
displays.
Step 5 Click New to display Task Run Criteria Details.
Step 6  Inthe Type field, select Skip Criteria.
Step 7 Select Specific Day(s).
Step 8 Select the current day (that is, if today is Friday, select Fri).
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(See Task Run Criteria Field Descriptions for more details.)
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Step9  Click Save.

Task Run Criteria Details =|alx
5] Save [ Save & New [fj Save & View 3£ Close

Task Run Criteria

Type : | Skip Criteria v
Task: Simple Workflow «[F] Vertex1d: 6 | Simple Workfiow e
Business Day: [7]
Haliday : [[]
Specific Day(s) Sunday [] Monday Tuesday [[] Wednesday [[] Thursday [[] Friday [] Saturday []
Custom Day: []
Complex: [[]
Variable : [0]

[ save 5y Save & New | | [ Save & View ¥ Close

Run the Daily Workflow

Step 1 Right-click anywhere in the Workflow Editor and select Launch Workflow.

Step 2 Display the Activity Monitor and note that the sub-workflow (Simple Workflow) and all its sub-tasks have been skipped, as shown in the following example. Note also that this did not impact subsequent tasks, which ran

as usual.
Home Activity Workflow Tasks
6658 Task Instances |Last48 hours + | [ No quickfilter = | Custom Filter|— None — v | S Filter.
Instance Name Type Status Invoked By Start Time End Time Updated ™ ~
El Workflow with Skipped Workflow Success Manually Launched 2014-07-28 15:07:42 -0400  2014-07-28 15:08:23 -0400  2014-07-28 15:08:23 -0400
El Timerd Timer Success ‘Workflow: Workflow with Skipped 2014-07-28 15:08:13-0400  2014-07-28 15:08:23 -0400  2014-07-28 15:08:23 -0400
E Timers Timer Success WWorkflow: Workflow with Skipped 2014-07-28 15:08:02 0400 2014-07-28 15:08:12 -0400  2014-07-28 15:08:12 -0400
E Timer2 Timer Success Workflow: Workflow with Skipped 2014-07-28 15:07:52 0400 2014-07-28 15:08:02 -0400  2014-07-28 15:.08:02 -0400
] Timert Timer Success Workflow: Workflow with Skipped 2014-07-28 15:07:42 0400  2014-07-28 15:07:52 -0400  2014-07-28 15.07:52 -0400
El Simple Workflow Workflow Skipped ‘Workflow: Workflow with Skipped 2014-07-28 15.07.42 -0400  2014-07-28 15.07.42 -0400
El Timer2 Timer Skipped ‘Workflow: Simple Workflow 2014-07-28 15.07.42-0400  2014-07-28 15.07.42 -0400
El Timer3 Timer Skipped ‘Workflow: Simple Workflow 2014-07-28 15:07:42 -0400  2014-07-28 15:07:42 -0400
El Timer Timer Skipped ‘Workflow: Simple Workflow 2014-07-28 15:07:42 -0400  2014-07-28 15:07:42 -0400
El Timers Timer Skipped ‘Workflow: Simple Workflow 2014-07-28 15:07:42 -0400  2014-07-28 15:07:42 -0400
E Timers Timer Skipped Workflow: Simple Workflow 2014-07-28 1507:42 -0400  2014-07-28 15.07:42 -0400
] Timers Timer Skipped Workflow: Simple Workflow 2014-07-28 15.07:42 -0400  2014-07-28 15.07:42 -0400

Check the Skipped Workflow's History

You can view a task instance Details to find out why it has a status of Skipped. On the Activity Monitor, click the Details icon in the first column for any task instance to display its task instance Details.

For example:
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Workflow Task Instance Details: Simple Workflow =||E=|| %
[F] Update [58, Unskip | View Parent |z View Workflow &) Delete |/% Refresh 3£ Close
Workflow Task Instance Virtual Resources Exclusive Requests Step Conditions Notes
— General
Instance Mame : |Simple Workflow Reference |d: 2
Task : |Simple Workflow D Invoked By  Workflow: Workflow with Skipped
Task Description
. ru1emper0f Execution User : |ops.admin
Business Services :
. = Time Zone
Calendar : | System Default ==l Preference - | System Default —
Virtual Resource -
Priority :
— Status
Status : |Skipped
Status Description - Skipped due to runiskip criteria.
Operational Memo :
Start Time : End Time : | 2014-07-28 15:07:42 -0400
Duration :
Progress : |6/6
— Workflow Details
Show/Hide Skipped R
Tasks - Show Skipped n
— Wait'Delay Options
Wait To Start: |Seconds v Wait Duration In
Seconds:
Delay On Start: |Seconds » Delay Duration In 5
Seconds:
Workflow Only . |No w
— Statistics
Lser Estimated Average Estimated
End Time : End Time:
Shortest Estimated Longest Estimated
End Time : End Time :
[E] update [% Unskip [ View Parent | | [2 ViewWorklow| | ] Delete 4| Refresh # close

Note that the Status Description field indicates that Simple Workflow was skipped due to run/skip criteria.
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For additional information, see:
® Activity display

® Monitoring Workflows
® Adding Skip/Run Criteria
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Tutorial - Finding and Inserting Tasks in an Active Workflow

In this exercise, we will run a workflow and:

® Find a specific task within the workflow. (You also can find a task in a workflow that has not yet been launched or one that has run and completed.)
® |nsert a task as a predecessor to another task in the workflow.
® Insert a task as a successor to another task in the workflow.

Note
!
You may find it easier to run a workflow three different times, once for each step in this exercise.

Step 1 Create a workflow so that all of its tasks cannot display on the Workflow Editor/Monitor at the same time.

129 / uc-70x-tandt



Universal Controller 7.0.x Troubleshooting and Tutorials

130 /

Step 2 Launch the workflow and right-click in the Workflow Monitor canvas. A pop-up menu displays.

stonebranch-timertask-01
Success

/
Bo— |

stonebranch-f
Run

View/Edit
View/Edit In Tab

View Children
View Tree

Commands

Show Skipped/Restore
Hide Skipped

Find In Workflow...
Pan To Top

Inzert Task...

Details

.

stonebranch-timertask-02

Email Tutorial
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Step 3 Click Find in Workflow... to display the Find in Workflow dialog.

o

stonebranch-timertask-01
Success

stonebranch-filemonitor-02
Running Email Tutorial

stonebranch-timertask-02

Find In Workflow [

Tt e

Nex‘tl Previousl starts with ( - Z
- eguals p

Email Tutorial
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Step 4 Select an operator for the search (contains, starts with, or equals), enter the full or partial name of the task(s) that you want to find, and click OK. The Controller locates and displays the first task within the Workflow
that matches the search criteria. Click the Next and/or Previous buttons to find any other tasks that match the search criteria.

o

stonebranch-timertask-01
Success

stonebranch-filemonitor-02
Running

|

Email Tutorial

stonebra; n-c-llfti-m-erla sk-02

Email Tutorial
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Step 5

Right-click the found task (stonebranch-timertask-02) to display a menu of actions available for that task.

stonebranch-timertask-01

Success

[
stonebranch
Ru

View/Edit
View/Edit In Tab

Commands

View Predecessors/Successors

Insert Task As Predecessor..

Insert Task Az Successor..

Detailz

Properties

stonebranch-timertask-01

()
b

Email Tutorial
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Step 6 Click Insert Task As Predecessor.... The Task Insert > Task Selection dialog displays.
Task Insert > Task Selection =10
Task Name: stonsbranch-manuahtask-01 Manual j Search |
| | Tazk Type Tazk Name

4| | i

Step 7 Find a task you want to insert and drag the task's icon to the workflow canvas. In this example, we have selected stonebranch-manualtask-01.
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Step 8 The Controller inserts stonebranch-manualtask-01 as a precedent to the Waiting stonebranch-timertask-02 task, and stonebranch-manualtask-01 begins running (as a Manual Task, it requires a user action).
When stonebranch-manualtask-01 completes, stonebranch-timertask-02 begins running.

\C

stonebranch-timertask-01
Success

stonebranch-manualtask-01
Action Required

L
0

/

stonebranch-filemonitor-02
Running Email Tutorial

stonehr;; rTc-h:ti-n;erta sk-02

|

Email Tutorial
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Step 9 Once again, right click stonebranch-timertask-02 to display a menu of actions available for that task.

16

stonebranch-timertask-01
Success

stonebranch-manualtask-01
Action Required

View/Edit
View/Edit In Tab

2

D

stonebranch-filemonitor-02
Running

. . Commands 3
Email Tutorial e
stonebranch-tir|

View Predecessors/Successors

Insert Task As Predecessor..

Detailz 3

Properties

Email Tutorial
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Step 10 Select Insert Task As Successor.... The Task Insert > Task Selection dialog displays.

Task Insert > Task Selection =I5
Task Name: stonebranch-filemonitor-03 File Monitar j Search |
| | Task Type Task Name

1| | i

Step 11  Find the task you want to insert and drag the task's icon to the workflow canvas. In this example, we have selected stonebranch-filemonitor-03.
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Step 12 The Controller inserts stonebranch-filemonitor-03 as a successor to stonebranch-timertask-02. When stonebranch-timertask-02 completes successfully, the inserted stonebranch-filemonitor-03 task begins
running.

S

stonebranch-timertask-01
Success

stonebranch-manualtask-01
Action Required

|
B

) —_—
stonebranch-filemonitor-02 G

Running Email Tutorial

stonebranch-timertask-02

stonebranch-filemonitor-03

|

Email Tutorial

For additional information, see:
® Finding a Task in a Workflow

® |nserting a Task in a Workflow
® Searching for and Adding Tasks
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Tutorial - Skipping, Unskipping, and Showing-Hiding Skipped Task Instances

You can skip (and unskip) individual task instances and task instances within a workflow that have been launched but have not yet started to run. For skipped tasks within a workflow, you can choose to show or
hide those tasks in the Workflow Monitor.

You also can skip a task instance so that all dependent task instances of that task instance automatically are skipped as well.
Although there are several methods for skipping, unskipping, and showing/hiding skipped task instances, in this exercise we will:
® Skip a task instance in a workflow.
® Unskip a previously skipped task instance in a workflow.

® Show and hide a skipped task instance in a workflow.

Note
1
There also are methods for skipping a task and showing/hiding a skipped task before it becomes a task instance (that is, before it or the workflow in which it resides has been launched). See the links at the

bottom of this page.

Step 1  Fromthe Automation Center navigation pane, select Tasks > Workflow Tasks. The Workflow Tasks list displays a list of all workflow tasks.
Step 2 Right-click Simple Workflow (created in the Creating a Simple Workflow tutorial), and on the Action menu, click Launch Task.
Step 3 On the Activity Monitor, select Active Workflow Task Instances from the drop-down list.

Step4  Click Simple Workflow. The Workflow Monitor displays for this running workflow.
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Step 5

Note

Right-click the Sleep3 task while it is in Waiting status and, from the pop-up menu that displays, click Commands / Skip.

1
If you wanted to skip the Sleep3 task and its dependent Sleep5 and Sleep6 tasks, you would click Commands / Skip Path.

"

o

Opswise - Test Email
Success

QA

View/Edit
View/Edit In Tab

Commands

View Predecessors/SUccessors

Insert Task As Predecessor...
Insert Task As Successor..

Details

Properties

Sleeps

Sleept

Clear All Dependencies
Clear Predecessors

Force Finish
Farce Finizh (Halt)
Hold

The Sleep3 status changes from Waiting to Skipped. When Sleepl completes successfully, Universal Controller will skip Sleep3 and start running Sleep5 and

Sleep6.
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Step 6 To un-skip Sleep3, right-click it and, from the pop-up menu that displays, click Commands / Unskip.

Opswise - Test Email

SUCCESS
|-
View/Edit
5| View/Edit In Tab
S

View Predecessors/SUCCEsS0rs

Sleep2
Running

3t Inzert Task As Predecessor...
Sk

Ingert Task As Successor...

Details k

Properties

Sleeps Sleepb
Running Running

The task status changes from Skipped to Waiting. When Sleepl completes successfully, the Controller will not skip Sleep3.
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Step 7 To hide the skipped Sleep3 task in the Workflow Editor, right-click in the Workflow Monitor canvas and click Hide Skipped.

Opswise - Test Email
Success
View/Edit
View/Edit In Tab
Sleep1 View Children
Success
Commands 4
Show Skipped/Restore
Sleep2 Sleep3 Hide Skipped
Success Skipped
Find In Workflow...
Pan To Top
Insert Task...
Sleeps Sleeph Details *
Success Success

142 | uc-70x-tandt



Universal Controller 7.0.x Troubleshooting and Tutorials

Step 8 To show the skipped Sleep3 task in the Workflow Monitor, right-click in the Workflow Editor canvas and click Show Skipped/Restore.

Opswise - Test Email
Success

View/Edit
View/Edit In Tab

Sleep1
Success View Children

Commands k

ped/Restore
Hide Skipped

Sleep2
Success

Find In Workflows...
Pan To Top

Insert Task...

Sleepb Sleepb _
Success Success Details

For additional information, see:

Skipping a Task

Unskipping a Task

Showing or Hiding Skipped Tasks

Adding Skip/Run Criteria for Specific Tasks
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Tutorial - Using Variables in a Simple Task

Introduction

Resolving Variable Using Value from Global Variable Table
Resolving Variable Using Value from Task

Resolving Variable Using Value from Trigger

Introduction

Note
!
You need an Email Connection to perform this exercise.

In the Launching an Email Task Based on a File Monitor tutorial, a built-in variable called ${ ops_t ri gger _nane} and a system variable called ${ _dat e} were included to pass information into an Email
message. Those variables were resolved using system information when the email task instance was created.

In this exercise, we will create a new user-defined variable, use it in a task, and run the task both manually and via a trigger to illustrate how such variables are resolved.

Resolving Variable Using Value from Global Variable Table

Step 1 Create a Variable with the following values:

® Name = Tutorial
® Value = Global

Step2  Click the Save button.

==

[F] save [ Save &New [ Save &View $% Close

Variable Details

Variable

— Details

MName: Tutorial

Glabal

Value

Description

Member of -
Business Senices

[E] save [ Save & Mew Save & View 3 Close
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Step 3 Creat

uc-70x-tandt

e an Email task with the following values:

Task Name = Email Tutorial

Email Connection = your Email connection
To = your Email address

Subject = Variable demo

Body=${Tutorial}
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Step 4 Click the Save button, re-open the task, and click th

e Launch Task button.

Email Task Details: Email Tutorial

=[=]%

| [E] Update [5) Launch Task g5 View Parents [Ty Copy g Delete [ Refresh 3% Close ‘

Email Task H @ Variables H . Actions ‘l . Virtual Resources H © Wutually Exclusive ||  Instances ‘l . Triggers ||

~ Motes | ¢ Versions |

— General

Task Name : Email Tutorial

Task Description

Member of

Busmess|

Senvices :

Resolve Name
Immediately :

Hold on Start :

Time Zone

Preference - |— System Default —

Virtual Resource |1U

Hold Resources on
Failure

Priority :

— Email Details

Email Template : |

=]

[T £mail Connection : QA-HALER

Email Template
Variable

Reply-To :

daran@stonebranch.com

Ce:

Bece

Subject: Variable Demo

${Tutorial}

Body:

Repon:l

E Report Variable

— Wait'Delay Options

Wait To Start : |— Mone —

ke

Delay On Start |— Mone —

bl

‘Workflow Only : |— System Default —

ll

— Time Options
Late Start

Late Finish
Early Finish

User Estimated _ Day
Duration

Critical Path Options

CP Duration :

(

CP Duration Unit: |Minutes

— Workflow Execution Options

Execution

Restriction |7 None —

B

| [Flupdate | [ LaunchTask] | g, ViewParents|| [ Copy

& Close

|| [ Refresh ||

|| difl Detete

(=
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Step 5  You should receive an email with Global in the body of the email.

Resolving Variable Using Value from Task

Step 1 Open the Email Tutorial task and click the Variables tab.

Step 2 Click the New button to display Variable Details for a new Variable and enter the following values:

® Name = Tutorial
® Value = Task

Step 3  Click the Save button.

Variable Details B
[E] save [ save & Mew Save & View 3¢ Close

Variable

Details

Name : Tutorial

Task

Value

Description

[E] save I save & New Save & View # close

Step 4 In the Email Tutorial Details, click the Update button and then click the Launch Task button.

Step 5  Youshould receive an email with Task in the body of the email.

Resolving Variable Using Value from Trigger

Step 1 Create a Time trigger with the following values:
® Trigger Name = Variable Demo

® Tasks = Email Tutorial
® Time = (Five minutes from the present time.)

147 | uc-70x-tandt


https://docs.stonebranch.com/confluence/display/UC70/Time+Trigger

Universal Controller 7.0.x Troubleshooting and Tutorials

Step 2  Click the Save button.

!T\meTriggerDetai\s —lolx
‘H Save [3) Save &New [f] Save&View 3§ Close ‘

Time Trigger

— General

Name: Variable Demo

Description :

Member of
Business Services :

Calendar : |System Default

Time Zone - | System (AmericaiNew_York) [v]

Email Tutorial

B®

Task(s):

Purge By Retention

Duration :
— Status
Forecast: [F]
Skip Count: 0
Skip Trigger if
Active : a8
Simulate : |—Sy5tem Defauli — [~ |
— Time Details
Time Style : [Time -
. Hour Hin
Time: (15 w|[o0 [«
— Day Details

Day Style - | Simple »

@ Daily (O Business Days () Specific Day(s)

Restrictions
IVSDECIEU Restriction : [7]

| Fsave || saves&New | |[}) Save&view|| ¥ Close

Step 3 Re-open the Variable Demo trigger and click the Variables tab.

Step 4  Click the New button to display Variable Details for a new Variable and enter the following values:
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® Name = Tutorial
® Value = Trigger
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Step5  Click the Save button.

Variable Details B
[l save [ Save & New Save &View $€ Close

Variable

Details

Name : Tutorial

Trigger

Value

Description

[E] save [ Save & Mew Save & View 3 Close

Step 6  Inthe trigger Details, click the Update button and then the Enable button.

Step 7 You should receive an email with Trigger in the body of the email.

e
For additional information, see:

® User-Defined Variables
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Tutorial - Using Variables in a Workflow

Note

1
You need a working Database Connection for this tutorial.

For tasks executing within a Workflow, the order of precedence for resolving user-defined variables differs.

As the following procedure demonstrates, the variable definition in the task takes precedence, then Universal Controller looks within the Workflow or parent Workflow(s), with the global variable coming last.

Step 1  Create a SQL task called SQL with Variable with the following SQL command:

CREATE TABLE ${tutorial }${_date("yyyyMwd",5) } (name varchar(128), value varchar(128));

Step 2  Click the Save button and then re-open the task.

Step 3  Click the Variables tab and create a Variable with the following values:

® Name = tutorial
® *Value+ = task

Step 4  Click the Save button and in the task Details, click the Update button.
Step4  Create a Workflow called Variable Workflow.
Step 5  Addthe SQL With Variable task to the Workflow and save it.

Step 6 Launch Variable Workflow. and open the SQL With Variable task instance on the Activity Monitor. Note that the SQL command resembles the following, with the value from the task variable.

CREATE TABLE t ask20090913 (nane varchar (128), val ue varchar(128));

Step 7 Open the task and delete the task variable.

Step 8 Go back to Variable Workflow and add the following variable:

tutorial /workfl ow
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Step 9 Open the task instance. The SQL command used the variable from the workflow because the task no longer had a variable.

CREATE TABLE wor kf | ow20090913 (nane varchar(128), val ue varchar(128));

e
For additional information, see:

® User-Defined Variables
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Tutorial - Creating Custom Days and Periods

Introduction

Create a Custom Day

Create a Custom Period

Assigning Custom Day and Custom Period to a Calendar
Creating a Local Custom Day for a Calendar

Selecting a Custom Calendar for a Trigger

Introduction

In this tutorial, we will create a Custom Day and period for a Calendar, and assign that Calendar to a Trigger.

Create a Custom Day
In this procedure, we will create a Custom Day, which can be applied to any Calendar.
Step 1 From the Automation Center navigation pane, select Other > Custom Days. The Custom Days list displays.

Step 2 Click the New button to display Custom Day Details for a new Custom Day and enter/select the following values:

Name = Thanksgiving

Holiday is enabled

Type = Relative Repeating Date
When = 4th

Day of Week = Thu

Month = Nov
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Step 3  Click the Save button.

Custom Day Details = =63

[l save [ Save & New Save & View 3£ Close
Custom Day

— Details

Name : Thanksgiving
Description

Category: (O Day () Business Day ® Haliday () Period

Type : Relative Repeating Date v
When : 4th ~
Day Of Week : | Thu .
Month © | Nov v
Adjustment: |- None — -
EXC)

Actual Day Of Week Observed Day Of Week

Observed Rules

No items to show.

] save I Save & New Save & View 3 Close

Create a Custom Period
In this procedure, we will create a custom period of days, which can be applied to any calendar.

Step 1 Click the New button on the Custom Days list and to display Custom Day Details for a new Custom Day and enter/select the following values:

Name = 4th Quarter

Period is enabled.

Type = List of Dates

Dates = 2017-10-01 and 2017-12-31.

Step 2  Click the Save button.

Custom Day Details mISE

[E] save [ Save & New [[] Save &View §£ Close

Custom Day

— Details
Name : 4th Quarter
Description

Category: (O Day (OBusiness Day (O Holiday @ Period

Type : List of Dates .
Ee o=
Dates  *
Dates
2017-10-01
2017-12-31

[l save I Save & New || [ Save & View # Close
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Assigning Custom Day and Custom Period to a Calendar

In this procedure, we will assign the custom day and custom period to a new Calendar.

154 /

Step 1

Step 2

Step 3

Step 4

Step 5

From the Automation Center navigation pane, select Other > Calendars. The Calendars list displays.

Click the New button to display Calendar Details for a new Calendar and enter/select the following values:

® Name = Custom Calendar #1

Click the Save button.

Calendar Details ) (=)

[E] save [ Save & New Save & View 3£ Close
Calendar

Details
Name: Custom Calendar#1
Description
Member of Business Senvices v

Business Days: [7]Sunday [¥]Monday [¥]Tuesday [¥]Wednesday [V]Thursday [¥]Friday [ Saturday

First Day Of Week | Sunday h

[l save [ save & New Save & View 3% Close

Re-open Custom Calendar #1 and click the Custom Days tab. The Custom Days list for this Calendar displays.

Click the Edit button to display an Edit Members pop-up dialog of all Custom Days.

Edit Members =|3][x
Collection Custom Day List
kd Custom Calendar #1

Name * - Name * -
stonebranch-customday-01 4th Quaretr
stonebranch-customday-02 Thanksgiving
stonebranch-customday-03
stonebranch-customday-04
stonebranch-customday-05 |:|

[+]

[»]

[«]

Save Cancel
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Step 6
Calendar Details: Custom Calendar #1 =i=]
Calendar Local CustomDays | @ CustomDays | © Triggers | © Versions
2 Calendar Custom Days New Edit el
Custom Day Description Category  Updated By  Updated

E Thanksagiving Holiday ops.admin 2017-05-25 16:21.29 -0400

El 4th Quaretr Period ops.admin 2017-10-27 15:39:31 -0400
Step 7 In the Calendar Details, click the Update button.

Note

Select Thanksgiving and 4th Quarter, and then click the Save button. Those two Custom Days now appear on the Custom Days list for Custom Calendar #1.

You also can assign a Custom Day to a Calendar by clicking the Calendars tab in the Custom Day Details.

Creating a Local Custom Day for a Calendar

In this procedure, we will create a local custom day for an existing Calendar.

Step
1

Step

Step

155 /

Open Custom Calendar #1 that you created in the previous procedure.

Calendar Details: Custom Calendar #1

Calendar Local Custom Days Custom Days

Triggers

Versions

[E] Update [5] Calendar Preview LIy Copy ¢ Delete

= =63

5 Refresh 3 Close

Details
Name : Custom Calendar #1
Description
Member of Business Services
[]Sunday [ Mongay

First Day Of Week : | Sunday

Business Days

[7]Tuesday  [V] Wednesday

Version : 1

[#] Thursday  [#]Friday ] Saturday

v

[E] Update (=] calendar Preview Ef copy

i Delete

32 Close

%| Refresh

Click the Local Custom Days tab to display an empty Local Custom Days list.

Click the New button to display Local Custom Details for a new Local Custom Day, and enter the following values:

® Name = Local Custom Day #1
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Step | Click the Save button.

F
Local Custom Day Details M =S
[E] save R save & New Save &View £ Close

Local Custom Day

Details

Name : Local Custom Day #1

Description
Category: ® Day (O Business Day (O Holiday () Period
Type : Single Date v
Date: 2017 |+ |[oat |+ |[30 [+ |

[E] save Save & Mew Save & View # Close

Local Custom Days #1 now appears on the Local Custom Days list.

Calendar Details: Custom Calendar #1 -lEl*
Calendar © LocalCustomDays | © CustomDays | © Triggers | © Versions
1 Local Custom Day New =
Name Description Category  Type Updated By Updated
Local Custem Day #1 Day Single Date ops.admin 2017-10-30 11:05:50 -0400

Selecting a Custom Calendar for a Trigger

In this procedure, we will assign the custom calendar to a trigger.
Step 1 From the Automation Center navigation pane, click Triggers > Time Triggers. The Time Triggers list displays.

Step 2 Click the New button to display Time Trigger Details for a new Time Trigger and enter/select the following values:

Name = Custom Trigger

Calendar = Custom Calendar #1

Task(s) = (any task)

Day Style = Complex

Date Noun = Thanksgiving (a Custom Day created for Custom Calendar #1)
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Step 3  Click the Save button.

F
Time Trigger Details

| [=][63
|H save [ Save &New [ Save &View $£ Close ‘
Time Trigger
— General =
Name : Custom Trigger
Description :
Member of
Busmessl ‘V|
Services

Calendar: |Cu5tom Calendar #1

Time Zone : System (AmericaiMew_York) ‘vl
- clonestonebranch-windovrstask-01

Task(s):

Purge By Retention

Duration : a
— Status
Forecast: [F]
Skip Count : 0
Skip Trigger if
acve:
Simulate |- System Defaull - [v] =
— Time Details
Time Style : Time

!

Hour Min
Time

— Day Details

Day Style : |Complex

E

Date Adjective : Every

Date Noun : Thanksgiving

Date Qualifier : |Year
— Restrictions
special
Restriction a8

| save | [ Save &New ||[Fp Save &View|| §§ Close

il

Step 4 Re-open Custom Trigger and click the List Qualifying Times button to see that the trigger will run the task every year on Thanksgiving.
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Qualifying Times

Custom Trigger

Listing From: 2017-10-27 13:54:31 -0400

UserTrigger Timezone: America/Mew _York

Thursday, Movember 23, 2017 00:00:00 EST -0500
Thursday, Movember 22, 2018 00:00:00 EST -0500
Thursday, Movember 28, 2019 00:00:00 EST -0500
Thursday, Movember 26, 2020 00:00:00 EST -0500
Thursday, Movember 25, 2021 00:00:00 EST -0500
Thursday, Movember 24, 2022 00:00:00 EST -0500
Thursday, Movember 23, 2023 00:00:00 EST -0500
Thursday, Movember 28, 2024 00:00:00 EST -0500
Thursday, Movember 27, 2025 00:00:00 EST -0500
Thursday, Movember 26, 2026 00:00:00 EST -0500
Thursday, Movember 25, 2027 00:00:00 EST -0500
Thursday, Movember 23, 2028 00:00:00 EST -0500
Thursday, Movember 22, 2029 00:00:00 EST -0500
Thursday, Movember 28, 2030 00:00:00 EST -0500
Thursday, Movember 27, 2031 00:00:00 EST -0500
Thursday, Movember 25, 2032 00:00:00 EST -0500
Thursday, Movember 24, 2033 00:00:00 EST -0500
Thursday, Movember 23, 2034 00:00:00 EST -0500
Thursday, Movember 22, 2035 00:00:00 EST -0500
Thursday, Movember 27, 2036 00:00:00 EST -0500
Thursday, Movember 26, 2037 00:00:00 EST -0500
Thursday, Movember 25, 2038 00:00:00 EST -0500
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I NUrsaay, MOVeMmDer £4, U3y UUUUU ES | -Usuy
Thursday, Movember 22, 2040 00:00:00 EST -0500
Thursday, Movember 28, 2041 00:00:00 EST -0500
Thursday, Movember 27, 2042 00:00:00 EST -0500
Thursday, Movember 26, 2043 00:00:00 EST -0500

Thursday, Movember 24, 2044 00:00:00 EST -0500
Thursday, Movember 23, 2045 00:00:00 EST -0500
Thursday, Movember 22, 2046 00:00:00 EST -0500

Step5  Inthe Custom Trigger Details, change the following values:

® Date Noun = Business Day.
® Date Qualifier = 4th Quarter (a Custom Day period created for Custom Calendar #1)

Step 6 Click the Update button.

Step 7 Re-open Custom Trigger and click the List Qualifying Times button to see that the trigger will run the task every business day during the custom period, October 1 to December 31.
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Qualifying Times

Custom Trigger

Listing From: 2017-10-27 15:57:36 -0400

UserTrigger Timezone: America/Mew _York

Maonday, October 30, 2017 00:00:00 EDT -0400
Tuesday, October 31, 2017 00:00:00 EDT -0400
Wednesday, Movember 01, 2017 00:00:00 EDT -0400
Thursday, Movember 02, 2017 00:00:00 EDT -0400
Friday, Movember 03, 2017 00:00:00 EDT -0400
Maonday, Movember 06, 2017 00:00:00 EST -0500
Tuesday, Movember 07, 2017 00:00:00 EST -0500
Wednesday, Movember 08, 2017 00:00:00 EST -0500
Thursday, Movember 09, 2017 00:00:00 EST -0500
Friday, Movember 10, 2017 00:00:00 EST -0500
Maonday, Movember 13, 2017 00:00:00 EST -0500
Tuesday, November 14, 2017 00:00:00 EST -0500
Wednesday, Movember 15, 2017 00:00:00 EST -0500
Thursday, Movember 16, 2017 00:00:00 EST -0500
Friday, Movember 17, 2017 00:00:00 EST -0500
Maonday, Movember 20, 2017 00:00:00 EST -0500
Tuesday, Movember 21, 2017 00:00:00 EST -0500
Wednesday, Movember 22, 2017 00:00:00 EST -0500
Thursday, Movember 23, 2017 00:00:00 EST -0500
Friday, Movember 24, 2017 00:00:00 EST -0500
Monday, Movember 27, 2017 00:00:00 EST -0500
Tuesday, Movember 28, 2017 00:00:00 EST -0500
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YWEanesaay, NOVEMDEr LY, U717 UUUWUY B35 1 -UsUu
Thursday, Movember 30, 2017 00:00:00 EST -0500
Friday, December 01, 2017 00:00:00 EST -0500
Maonday, December 04, 2017 00:00:00 EST -0500
Tuesday, December 05, 2017 00:00:00 EST -0500

Wednesday, December 06, 2017 00:00:00 EST -0500
Thursday, December 07, 2017 00:00:00 EST -0500
Friday, December 08, 2017 00:00:00 EST -0500

e
For additional information, see:
® Triggers

® Creating Calendars
® Creating Custom Days
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Tutorial - Generating Forecast Data

In this exercise, we will:

® Add a workflow and its tasks to the Forecast calendar.

® Run the workflow and display its forecast information.

® Update a task in the workflow and then re-run the workflow.
® Recalculate the forecast information for the workflow.

Step 1 Create a Time trigger and enter/select the following values:

Name = Simple Workflow Trigger.
Task(s) = Simple Workflow
Forecast = enabled

Business Days = enabled

Time Trigger Details —[@x
[E] save [ Save & Mew Save & View S Close
Time Trigger
— General
Hame : Simple Workflow Trigger
Description
Member of -
Business Senvices
Calendar : | System Default = Time Zone - |System (America/New_York) v
Simple Workflow
Taskis): L%
Purge By Retention
Duration al
— Status
Forecast:
Skip Count 0
Skip Trigger if
Active a
Simulate : |— System Default —
— Time Details
Time Style : | Time .
. Hour Win
Time: g0 [w/foo [w
— Day Details
Day Style : | Simple ~
(O Daily @ Business Days () Specific Day(s)
Restrictions
’VSpecialRestri:tian: (=]
] save Ry Save & New | | [ Save & View
Step 2 Save the trigger and then enable it. A trigger must be enabled in order to generate forecast data for it.
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From the Automation Center navigation pane, select Triggers > Forecast Calendar. The Forecast Calendar identifies Simple Workflow on the days in the forecast period, for the current month, when it will be

Step 3
launched by Simple Workflow Trigger. (By default, tasks within a Workflow are not displayed.)
“ Home [ || Forecast Calendar [ |
4a Apr2015 &
Sun Mon Tue Wed Thu Fri Sat
1 2
3 4 5 6 7 8 9|
12:00am Simple Workflow | 12:00am Simple Workflow | 12:00am Simple Workflow | 12:00am Simple Workflow | 12:00am Simple Workflow
10/ " 12, 13 14, 15, 16
12:00am Simple Workflow | 12:00am Simple Workflow | 12:00am Simple Workflow | 12:00am Simple Workflow | 12:00am Simple Workflow
17 18 19| 20 21 22 23|
12:00am Simple Workflow | 12:00am Simple Workflow | 12:00am Simple Workflow | 12:00am Simple Workflow | 12:00am Simple Workflows
24 25| 26 27 28/ 29 30
12:00am Simple Workfiow | 12:00am Simple Workflow | 12:00am Simple Workflow | 12:00am Simple Workflow | 12:00am Simple Workflow
31
12:00am Simple Workflow
Step 4 Click any Simple Workflow link in the Forecast Calendar to display a Forecast Details pop-up. Note that the Launch Time and End Time are identical; since the workflow has never been run, there is no data to support
estimated times.
Forecast Details =||3][%
| # Close |
Forecast H . Child Forecast
Details
Task |S|mp\eWorkﬂow E Trigger ‘S\mpleWorkﬁuangger E
Task Type : [Workllow | Launch Time : | 2014-08-18 00:00:00 -0400 |
Worklow : | =] End Time - |2014-08-18 00:00:00 -0400 |
Member of Run Cr\teria‘Run |
Business Services : 1
Simulation : [[]
| 3 close |
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Step 5 From the Automation Center navigation pane, select Triggers > Forecasts. The Forecasts list identifies Simple Workflow and every task in Simple Workflow, as well as their Launch Times and End Times, for every
day in the forecast period when Simple Workflow will be launched by Simple Workflow Trigger.
Home Forecasts.

~ 31 Forecasts. Custom Filter _ pone — ~ | T Filter &
Trigger Task TaskType  Workfiow Launch Time * End Time Run Criteria Evaluation Simulation Updated By — *

D Simple Workflow Trigger ~ Simple Workflow Workflow 2014-08-04 00:00:00 -0400  2014-08-04 00:00:00 -0400 Run No ops.admin k-

El Simple Workflow Trigger  Timerl Timer Simple Workflow  2014-08-04 00:00:00 -0400  2014-08-04 00:00:10-0400  Run No ops_ admin 5

D Simple Workflow Trigger ~ Timeré Timer Simple Workflow  2014-08-04 00:00:00 -0400  2014-08-04 00:00:00-0400  Run No ops.admin

B Simple Workflow Trigger ~ Timer2 Timer Simple Workflow  2014-08-04 00:00:10 -0400  2014-08-04 00:00:21-0400  Run No ops.admin

D Simple Workflow Trigger ~ Timer3 Timer Simple Workflow ~ 2014-08-04 00:00:10 -0400  2014-08-04 00:00:21 -0400 Run No ops.admin

El Simple Workflow Trigger ~ Timerd Timer Simple Workflow  2014-08-04 00:00:10 -0400  2014-08-04 00:00:21 -0400 Run No ops.admin

D Simple Workflow Trigger ~ TimerS Timer Simple Workflow  2014-08-04 00:00:20 -0400  2014-08-04 00:00:31 -0400  Run No ops.admin

B Simple Workflow Trigger ~ Timerl Timer Simple Workflow  2014-08-05 00:00:00 -0400  2014-08-0500:00:10-0400 Run No ops.admin

B Simple Workflow Trigger ~ Simple Workflow Workflow 2014-08-05 00:00:00 -0400  2014-08-05 00:00:00 -0400 Run No ops.admin

El Simple Workflow Trigger ~ Timeré Timer Simple Workflow ~ 2014-08-05 00:00:00 -0400  2014-08-05 00:00:00 -0400 Run No ops.admin

D Simple Workflow Trigger ~ Timerd. Timer Simple Workflow  2014-08-05 00:00:10 -0400  2014-08-05 00:00:21 -0400  Run No ops.admin

B Simple Workflow Trigger ~ Timer2. Timer Simple Workflow  2014-08-05 00:00:10 -0400  2014-08-05 00:00:21-0400 Run No ops.admin

B Simple Workflow Trigger ~ Timer3 Timer Simple Workflow ~ 2014-08-05 00:00:10 -0400  2014-08-05 00:00:21 -0400 Run No ops.admin

D Simple Workflow Trigger ~ TimerS Timer Simple Workflow ~ 2014-08-05 00:00:20 -0400  2014-08-05 00:00:31 -0400 Run No ops.admin

El Simple Workflow Trigger ~ Timer§ Timer Simple Workflow  2014-08-06 00:00:00 -0400  2014-08-06 00:00:00 -0400  Run No ops_ admin =

v Forecast Details

Step 6 Re-display the Time Triggers list, right-click Simple Workflow Trigger, and then click Trigger Now to launch Simple Workflow.

Step 7 When Simple Workflow has completed, re-display the Time Triggers list, right-click Simple Workflow Trigger, and then click Recalculate Forecast.

Note

1
You'also can recalculate the forecast by right-clicking Simple Workflow on the Workflow Tasks list and then clicking Recalculate Forecast.

Step 8 Re-display the Forecast Calendar and click any Simple Workflow link in the Forecast Calendar to display a Forecast Details pop-up, which now contains estimated Launch Time and End Time information based on
the Workflow run just completed.
Forecast Details =Olx
3 Close
Forecast Child Forecast
Details
Task: Simple Workflow D Trigger - Simple Workflow Trigger D
Task Type | Workflow Launch Time : | 2014-08-11 00:00:00 -0400
‘Workflow D End Time : 2014-08-11 00:02:21 -0400
Member of Run Criteria Run
Business Senices Evaluation :
Simulation : [[]
& Close
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Step 9 Open the Timer Task and change the Timer Duration in Seconds value from 10 to 50, and then click Update.
Timer Task Details: Timer 2 BEIR
[5] Update [5) LaunchTask gy ViewParents [Ty Copy i) Delete & Refresh £ Close
Timer Task Variables Actions Virtual Resources Mutually Exclusive Istances Triggers. Notes Versions
— General
Task Name : | Timer 2 Version 1

Task Description

Member of
Business Services

Resolve Name Time Zone
Immediately : O Preference - System Default — v

Hold on Start: [[]

Virtual Resource 10 - Hold Resources on &
Priority : Failure :

— Timer Details

Timer Type : |Seconds -

Timer Duration In
50
Seconds:

— Time Options
Late Start: []

Late Finish Late Finish __ Day Hour Min Sec
Late Finish Type: Duralon v Duration:[00 |~ |00 |« |[00 [v|[45 |+

Early Finish: [[]

User Estimated __Day Hour Hin Sec
Duration v v » v

Critical Path Options
’7 CP Duration : CP Duration Unit: | Minutes B

— Workflow Execution Options

Execution

Restriction = 218~ ad

[E] Update | [E) LaunchTask [ View Parents Cry copy & Delete % Refresh 3 Close

Step 10 Re-run Simple Workflow.

Step 11 When Simple Workflow has completed, re-calculate its Forecast; since the updated time for the Timerl task affected the Simple Workflow End Time (the time it took to run the Workflow), the Forecast information for
Simple Workflow is now obsolete.

Step 12 Re-open the Forecast Calendar and click any Simple Workflow link to see that 20 seconds has been added to the End Time.

e
For additional information, see:
® Creating and Maintaining Workflows

® Triggers
® Displaying Trigger Forecast Information
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Tutorial - Setting Up a Virtual Resource

In this exercise, we will set up an imaginary resource and three imaginary tasks.

In this scenario, two of our tasks are resource-intensive, and they run on the same machine. Therefore, if one is already running when the other is launched, we want the second task to wait until the first is
finished before running. However, our third task is not so resource-intensive, so we will allow this one to run at the same time as either of the other two.

To simplify the exercise, we will use Timer tasks.

Step 1 From the Automation Center navigation pane, click Other > Virtual Resources. The Virtual Resources list displays.

Step 2 Click the New button to display an empty Virtual Resource Details and enter the following values:

® Resource Name = Resource A
® ResourceLimit=5

Step 3 Click the Save button.

Virtual Resource Details B
[l save [ save & Mew Save & View 3¢ Close

Virtual Resource

Details
Resource Hame : Resource A
Resource Type : |Renewable v Resource Limit: 5

Resource
Description :

Member of
Business Senices

[l save ) save & New Save & View 3 close
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Step 4 Update the Timerl, Timer2, and Timer3 tasks that you created in the Creating a Simple Workflow tutorial.

For Timer1:

1. Change Time in Seconds to 60.

2. Click the Virtual Resources tab to display the Virtual Resources list for Timer1:
a. Click the Edit button, add Resource A to the Virtual Resources list, and click Save.
b. Click the Details icon for Resource A to display its Task Virtual Resource Details.

Task Virtual Resource Details =163
[F] Update (ff| Delete | s Refresh 3£ Close

Task Virtual Resource
Task: |Timer1

Virtual Resource : |Resource A

I | T

Amount 1

[FZ] Update 5 Delete % Refresh 3 Close

c. Change the Amount (number of resource units required from the virtual resource) from 1 to 4 and click the Update button.

For Timer2:

1. Change Time in Seconds to 30.
2. Add Resource A and change the Amount to 4.

For Timer3:

1. Change Time in Seconds to 20.
2. Add Resource A and keep the Amount at 1.

Step 5 Open Resource A and click the Tasks tab to see that Timerl, Timer2, and Timer3 are listed.

Virtual Resource Details: Resource A

) |[=] 1B,
Virtual Resource @ Tasks Currently In Use By Outstanding Requests Versions.
3 Task Virtual Resources Edit &
Task Amount | Updated By | Updated
[E] Timert 4 ops.admin
= Timera 1 ops admin
E Time2

4 ops.admin

Step 6 Create a Time Trigger called Trigger A, and select Task1, Task2, and Task 3 in the Task(s) field, and enter a Time three minutes from the current time

Step 7 Click the Save button, right-click Trigger A on the Triggers list, and click Enable.
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When the trigger is satisfied, only Timerl or Timer 2 will run, along with Timer3. When Timer1 or Timer 2 finishes, the other will run run. Display the Activity Monitor and note that Timerl or Timer 2 is waiting in Resourc

Step 8 !
e Wait status.
Home [ | actvity [
|-7|Last48 hours « @ No quickfilter « | Custom Filter — None — v @ Filter..
Instance Name Type Status Invoked By Start Time: End Time Updat ™
E Timer3 Timer Success Trigger: Trigger A 2014-08-12 10:58:00 -0400 2014-08-12 10:56:10 -0400  2014-08-
[E Timert Timer source Wai Trigger: Trigger & 2014-08-
E Timer2 Timer Running Trigger: Trigger A 2014-08-12 10:56.00 -0400 2014-08-
Step 9 In the Virtual Resource Details, click the Currently In Use By tab and observe which tasks are running on this virtual resource. Note that this display does not automatically refresh.

For additional information, see:

Virtual Resources
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Tutorial - Creating a Widget

There are three types of Widgets, all of which can be placed on one or more Dashboards:
® System
® Activity
® Report

In this exercise, we will create an Activity Widget that identifies any failed task instances in the past week.

(You cannot create, modify, or delete a System Widget; they are provided by the Controller.)

Step 1 From the Reporting navigation pane, select Widgets. The Widgets list displays.
Step 2 Click the New button and then click Activity Widget. An Activity Widget Details pop-up displays.

Step 3 Enter / select the following values:

Name = Failed

Refresh Rate (Seconds) = 900 | 15 minutes
Status(es) = Failed

Time Constraint = Last week

Composite Color = Red

Activity Widget Details —lEx
[ save [ Save & New Save & View 3£ Close
Activity Widget

— General

Name : Failed
Description

Refresh Rate (Seconds): |900 | 15 minutes v

— Details
Status(es): Failed Time Contraint: |Last week .

Composite Color: #FFO000

|

No items to show.

Composite Status(es)

OBE®

[E] save IE) Save & New | | [ Save & View 3 Close

Step 4 Click the Save button. This Widget can now be added to any Dashboard and can be selected for any Composite Widget.

S
For additional information, see:

® \Widgets
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Tutorial - Creating a Dashboard and Adding Widgets
Creating a Dashboard and Adding Widgets

Universal Controller provides a default Dashboard containing multiple Widgets that displays as the Home Dashboard when you log in to Universal Controller.
You can create your own Dashboards containing any available Widgets.

In this exercise, we are going to create a Dashboard and select Widgets for the Dashboard.

Step 1 Click the Home icon in the top right corner of any page to display the Home dashboard.

‘4 Dashboards EI‘\
Active Task Instances By Status 2 System Details 2
R [Agents: 84/5000] [Triggers: Unlimited] [Tasks: Unlimited] [Days:
License:
13/365]
Waiting 13 Node Id: opswise8:8080-0pswise620b54
MNode Mode: Active
e
Held 7 Node Uptime: 11 Days 21 Hours 0 Minute 21 Seconds
I ) )
. — Mode Time: 2015-07-14 11:05:27 -0400
Resource Wait _4 Release: 6.2.0.0
N N Build: build.54
Action Required 1
I Build Date: 06-30-2015_1252
Started - Database Type: MYSQL
Database MName: opswise620
Running Database URL: jdbe:mysql://ga-stone branch/
Database Connections:  In Use: 0, Total: 3
Failed .
Memary Maximum: 989.88 MB
Memory Used: 103.49 MB (10.45%)
Memory Free: £86.38 MB (89.55%)
Agent Status Z Cluster Node Status 2 OMS Server Status %

W Offline (1) I Active (2) I Active (1) Passive/Unavailable (1) I Connected (1)

| administrators Home | Dashboard#1 | | & Refresh |

Step2  Onthe Customize drop-down list at the bottom of the Home Page, click New.

Step 3  Selectaname for the new Dashboard on the New Dashboard pop-up and click OK. A new, empty Dashboard displays.
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Step 4 From the list of Widgets to the left of the Dashboard, drag and drop any of the Widgets into either column. (If you want to add more columns, click either Column Properties drop-down list and then click Add Column.)

@) Select 2 Widget Column Properties - Column Properties. -
9 Spacer Active Task Instances By Status Active Task Instances By Type
@) Active nstances

Defined
@) active Task Instances By Status Waiting
@) Active Task instances By Type Held
@ Agent Status Undeliverable
@) Cluster Node Status Running
@) Heldraction Reguired % Start Failure
@) OMS Server Status Cancelled

Failed
@) pending
@ Probiem
: z:m: Agent Status

]
@) success/Finished
@) system Detais
@9 Task Activity Status
1 Workdlow (8) [ Timer (25) I 2/0S (6)
M offine (5) I Active (3) M File Transfer (1)
l J{ J{ New J ] save m Cancel H @) Hide Widget Picker H Customize ;l
|
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Step 5 After you have added Widgets to your new Dashboard, you can click the x icon in the top right corner of any Widget to remove it from the Dashboard, or drag and drop any Widget to a new location in the Dashboard.

om0 oo 3|

@  ScloctaWilget Column Properties - Column Properties -
@ spacer ( Active Task Instances By Type <] [ Cluster Hode Status |
@) Active nstances
@) Active Task Instances By Status
@) Active Task Instances By Type
— |
@) Agent Status
@ Cluster Node Status
@) HeldiAction Required
@) OMS Server Status
@) Pending [ Workflow (8) [/ Timer (25) Il 2/0S ()
@ Prosiem M File Transfer (1)
@ Running = y
Active Task Instances By Status %
@ skipped
@) successiFinished Defined
@ SystemDetails Waiting
Held
Task Activity Stat
@ Tosk Actiy Staus Undeliverable
Running
Running/Problems
Start Failure
Cancelied
Failed
Agent Status |
W offine (8) B Active (9) W Active (1)
{ ﬂ" H New J [ save I[ € cancel H @Y Hide Widget Picker H Customize ~

Step 6  Click the Save button to add the Dashboard.

For additional information, see:
® Home Dashboard

® Dashboards
® Widgets
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Tutorial - Creating Business Services

Business Services are used to group records into business functions.

In this exercise, we will create two hypothetical Business Services: Tech Support and Operations.
Step 1 From the Administration navigation pane, select Security > Business Services. The Business Services list displays.
Step 2  Click the New button to display an empty Business Service Details.

Step 3 Enter the following values:

®* Name = Tech Support
® Description = This is the Tech Support business service.

Step 4  Click the Save button.

Business Service Details i(=1{E3
[F] Save [ Save &New [[ Save & View 3 Close

Business Service

Details

Hame : Tech Support

Description: This is the Tech Support business semice.

[ save ) Save & New | | [ Save & View 3 Close

Step 5 Repeat steps 2 to 4 for a Business Service called Operations.

e
For additional information, see:

® Business Services
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Tutorial - Assigning Records to Business Services

In this exercise, we will assign the Timer and Simple Workflow tasks created in the Creating a Simple Workflow tutorial to the Operations Business Service, and the SQL task and Bigger Workflow tasks created
in the Running a Workflow with a Conditional Path tutorial) to the Tech Support Business Service.

See the Creating Business Services tutorial to see how these Business Services were created.

Step 1 Open the Timer task called Timer1, which you created in the Creating a Simple Workflow tutorial.

Step 2  Fromthe Member of Business Services drop-down list, select Tech Support and Operations.

Timer Task Details: Timer 1 = (=1{F=3

[] update [Z) Launch Task View Parents Iy Copy i) Delete |5 Refresh 32 Close

Timer Task Variables @ Actions @ Virtual Resources Mutually Exclusive Instances Triggers Notes @ Versions
— General
Task Name : Timer 1 Version 4

Task Description :

Member of

Business Senvices Operations, Tech Support v

Resolve Name =

Immediately

a
Accountin
Hold on Start E b o

Virtual Resource | [] ¢
Priority: | [C] IT
L[] MikeD_BusSenices L
— Timer Details Operations —
[C] QADepartment

TimerType | [7] stonebranchbusinessservice 01
Timer Duration In| || stonebranchbusinessserice 02
Seconds: || stonebranchbusinessservice 03
stonebranchbusinessservice 04
N 7] stonebranchbusinessservice 05

— Time Options ——— Tech Support

Late Start: [

Late Finish @[]
Early Finish: []

UserEstimated  Day Hour Win Sec
Duration v ~ ~ v

Critical Path Options
’V CP Duration : CP Duration Unit: |Minutes v

— Workflow Execution Options

Execution
Restriction ||~ "oN2— A
] Update | |[E! Launch Task View Parents Cry Copy & Delete 4| Refresh 3 Close

Step3  Click the Update button.

Step 4 Repeat steps 1 to 3 for the Timer2 and Timer3 tasks and the Simple Workflow Workflow, all of which you also created in the Creating a Simple Workflow
tutorial.

e
For additional information, see:

® Business Services
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Tutorial - Viewing Activity by Business Service

® [ntroduction

Introduction

In this exercise, we will launch the Simple Workflow Workflow (created in the Creating a Simple Workflow tutorial and, on the Activity Monitor, display only tasks assigned to the
Operations Business Service (see Assigning Records to Business Services|Tutorial - Assigning Records to Business Services] tutorial.

Step1  Runthe Simple Workflow Workflow.

Step 2 Display the Activity Monitor, which will list the Simple Workflow and all of its tasks.

Home Reports. Business Sarvices Activity
858 Task Instances \-|Last48 hours ~ [ Mo quickfilter ~ | Custom Filter — None — ~ | S Filter..
instance Name ™ Type Status invoked By Start Time End Time Updated "
F Timers Timer Success Workflow: Simple Workflow 2014-08-11 14:53:25 0400 2014-08-11 14:55:25-0400  2014-08-11 14:55:25 -0400
E Timers Timer Success Workflow: Simple Workflow 2014-08-11 14:53:25 0400 2014-08-11 14:53:35-0400  2014-08-11 14:53:35 -0400
F Timerd Timer Success Workflow: Simple Workflow 2014-08-11 14:53:114 0400 2014-08-11 14:53:24 -0400  2014-08-11 14:53:25 -0400
F Ttmer3 Timer Success Workflow: Simple Workflow 2014-08-11 1455314 -0400  2014-08-11 14:53:25-0400  2014-08-11 14:53:25 -0400
F Ttmerz Timer Success Workflow: Simple Workflow 2014-08-11 1453114 -0400  2014-08-11 14:54:04 -0400  2014-08-11 14:54:05 -0400
E Tmert Timer Success Workflow: Simple Workflow 2014-08-11 14:53:04 -0400  2014-08-11 14:53:14 -0400  2014-08-11 14:53:14 -0400
[E simple Workflow Workfiow Success Wanually Launched 2014-08-11 14:53:04 -0400  2014-08-11 14:55:25-0400  2014-08-11 14:55:25 -0400

Step 3 Apply the following Filter to the list of tasks:
® Member of Business Services
® contains
® Operations

The Activity Monitor now displays only tasks assigned to Operations Business Service.

Home Reports. Business Services Activity
688 Task Instances |-|Last 48 hours = Eﬁ Mo quickfilter « | Custom Filter — Unsaved 2 — v
Instance Name ~ Type Status. Invoked By Start Time End Time Updated -.d
E Timers Timer Success Workflow: Simple Workflow 2014-08-11 14:53:14-0400  2014-08-11 14:53:25 0400 2014-08-11 14:53:25 -0400
E Timerz Timer Success Workflow: Simple Workflow 2014-08-11 14:53:14-0400  2014-08-11 14:54:04 0400 2014-08-11 14:54:05 -0400
= Timert Timer Success Workflow: Simple Workflow 2014-08-11 14:53:04 0400  2014-08-11 14:53:14 0400 2014-08-11 14:53:14 -0400
[E simple Workflow Workflow Success Wanually Launched 2014-08-11 14:53:04-0400  2014-08-11 14:55:25 0400 2014-08-11 14:55:25 -0400
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Tutorial - Creating a Report

In this exercise, we will create a report for Widgets.

Step 1 From the Reporting navigation pane, select Reports. The Reports list displays.

Step 2 In the empty Report Details below the list, enter / select the following values:
® Title = All Widgets

® Table = Widgets (ops_widget)
® Field(s) = (pre-selected fields display when you click Edit Fields)

Step 3  Click the Save button.

Report Details = [=)|E
[E] save [F save & Mew Save &View 3% Close

Report

— General
Title : All Widgets Visible Ta : |Me »

Description :
Type : |List v
Table : | Widgets (ops_widget) -

— List Fields and Ordering

Field Title Field Title Order
Name
Mo order
Widget Type
Description
Field(s) : |updated By Sort By :

Updated

Edit Fields.. Edit Sort...

— Scheduled Options

) '.:'DF_ — System Default— |+ PDF Size | — System Default— |~
Crientation :
— Filter
(@ Match Al () Match Any Advanced..
@

[E] save @ save & New Save & View ¥ Cclose
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Step 4

177 |/

Click the Run button to run the report, which displays under a new tab.

Dashboards [ | Reports

14 Widgets
Name

Skipped

Problem
Success/Finished
Task Activity Status
Failed

Agent Status
Held/Action Required
Cluster Node Status
OMS Server Status.
System Details
Pending

Running

Active Task Instances By Status

6 i A M e W s

Active Task nstances By Type

Al Widgets report [

Widget Type:
Activity
Activity
Activity
Activity
Activity
System
Activity
System
System
Systsm
Activity
Activity
System
Systsm

Description
Activity - Skipped

Activity - Problem
Activity - Success/Finished
Task Activity by status

Pie chart for agent statuses.
Activity - Held/Action Required

Pig chart for cluster node statuses.

Pie chart for OMS server statuses.

Displays a number of system details including version, database, and memory information
Activity - Pending

Activity - Running

Bar chart for active task instances grouped by task instance status.

Bar chart for active task instances grouped by task instance type.

Updated By
ops.admin
ops.admin
ops.admin
ops.admin
ops.admin
ops.system
ops.admin
ops.system
ops.system
ops.system
ops.admin
ops.admin
ops.system

ops.system

Updated

2014-07-17 11:57:26 -0400
2014-08-12 15:54:55 -0400
2014-08-07 17:13:39 -0400
2014-08-18 23:28:05 -0400
2014-08-11 13.43:50 -0400
2014-06-24 20:00:00 -0400
2014-07-17 11:41:46 -0400
2014-06-24 20.00.00 -0400
2014-06-24 20:00:00 -0400
2014-06-24 20:00:00 -0400
2014-07-17 11:56:46 -0400
2014-07-17 11:38:20 -0400
2014-06-24 20:00:00 -0400
2014-06-24 20:00:00 -0400
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Step 5

* Widget Type
® equals
® Activity

Return to the Report Details and select the following Filter for the report:

Report Details: All Widgets

= O]|X

[E]l Update Save As.. ol Run ¢f| Delete || Refresh 3£ Close ‘

Report

— General

Title : All Widgets

|V|

Visiole To: |Me

Description :

|V|

Type : |List

Table :| Widgets (ops_widget)

— List Fields and Ordering

Field Title
Name
Widget Type
Description
Updated By
Updated

Field{s) :

|EditFields...|

Field Title Order

Mo order

Sort By

Edit Sort...

— Scheduled Options

PDF — System Default— n

Crientation

POF Size : |- System Default— |+ |

— Filter

® Match Al O Match Any

Advanced..

@ |Widget Type

|v||aquals |v|ActN'rty

©

|| FE savehs. || i Run

| Update

|| [1%) Refresh H ¥ Close |

|| ¢ Delete

178 / uc-70x-tandt



https://docs.stonebranch.com/confluence/display/UC70/Filters

Universal Controller 7.0.x Troubleshooting and Tutorials

Step 6  Click the Update button, and then click the Run button to display the report under a new tab.

Dashboards [1] | Reports [] | Allwidgets report [
8 Widgets =)
Name widget Type Description Updated By Updated

[E] skipped Activity Activity - Skipped elenulich  2014-07-17 11:57:26 -0400
[E Problem Activity Activity - Problem ops.admin 2014-08-12 15:54:55 -0400
[E] successfFinished Activity Activity - Success/Finished  ops.admin 2014-08-07 17:13:32 -0400
[E] Task Activity Status Activity Task Activity by status elen.ulich  2014-08-18 23:28:05 0400
[E Faied Activity ops.admin 2014-08-11 13:43:50 -0400
[E] Hewdiaction Required Activity Activity - Held/Action Required ellen.ulich  2014-07-17 11:41:46 -0400
[E] Pending Activity Activity - Pending elenulich  2014-07-17 11:56:46 -0400
[= Running Activity Activity - Running elen.uiich  2014-07-17 11:38:20 -0400

e
For additional information, see:

® Reports
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Tutorial - Creating a Report Based on Business Services

In this exercise, we will create two Activity reports so that users from our hypothetical Operations and Tech Support departments (see the Creating Business Services tutorials) can view activity related to their
organizations.

Step 1 From the Reporting navigation pane, select Reports. The Reports list displays.
Step 2 Click the New button to display empty Report Details.

Step 3 Enter / select the following values:
® Title - Business Services

® Table = Business Services (ops_generic_group)
® Field(s) = (pre-selected fields that display when you click the Edit Fields button)

Step 4  Click the Save button.

Report Details ] | =] |4
] save [ Save & Mew Save &View 3£ Close

Report
— General El
Title : Business Senices Visible To : |Me v
Description :
Type : |List 3
Table : | Business Services (ops_generic_group) -

— List Fields and Ordering

Field Title Field Title Order
Name
No order
Description
Updated By
Field(s) : | Updated Sort By :
Edit Fields... Edit Sort.

— Scheduled Options

PDF_ — System Default - v PDF Size - — System Default — v
Orientation :
— Filter
(® Match Al (O Match Any Advanced
o
[ save Save & Mew Save & View # close
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Step 5  Click the Run button. A Business Services report displays under a new tab.

Dashboards [] | Reports [ | Business Services report [

5 Business Services &
Name Description Updated By  Updated -
stonebranchbusinessservics 02 ops.admin 2014-06-13 15:19:47 0400
stonebranchbusinessservice 03 ops.admin 2014-06-13 15:19:51 -0400
'stonebranchbusinessservice 05 ops.admin 2014-06-13 15:20:00 -0400
’stonebranchbusinessservice 01 ops.admin 2014-06-13 15:19:37 -0400
stonebranchbusinessservice 04 ops.admin 2014-06-13 15:19:56 -0400

e
For additional information, see:

® Reports
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Tutorial - Scheduling a Report

In this exercise, we will schedule a report by triggering an Email Task that specifies the report.

To simplify this exercise, we will manually trigger the Email task. However, you can schedule a report using several methods.

182 /

Step 1 Create a Report with the following values:

Title = Scheduled Activity Report

Visible to = Me

Type = List

Table = All Task Instances (ops_exec)

Field(s) = Instance Name, Type, Status

In Scheduling Options, select any PDF Orientation and PDF Size.

Step 2 From the Automation Center navigation pane, select Email Tasks. The Email Tasks list displays.

Step 3 Click the New button and enter / select the following values in the empty Email Tasks Details:

uc-70x-tandt

Task Name = Schedule a Report

Email Connection = (Select a valid email connection for your environment.)
To = (Enter the email address where you want to send the email.)

Subject = Activity Report

Report = Scheduled Activity Report
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7
Email Task Details

=|[=]fx

Email Task

‘ Save 3y Save & Mew Save &View $E Close ‘

— General

Task Name : Schedule a Report

Task Description
Member of

Busmess‘

Senices

Resolve Name
Immediately

Hold on Start

Time Zone
Preference

Virtual Resource

Priority ‘1[]

Hold Resources on
Failure

£

— System Default —

— Email Details

Email Template ‘

: | QA-OPSWISE-MAILER

[+|[ Emailc

Email Template
Variable

Reply-To

suppori@stonebranch.com

Cc

Beo

Subject . Activity Report

Body

Report ‘Schsdu\edAmivity Report

[E

Report Variable

— Wait'Delay Options

Wait To Start ‘— None —

[l

Delay On Start ‘— None —

lx]

‘Workflow Only ‘— System Default —

[

— Time Options
Late Start
Late Finish

Early Finish

User Estimated
Duration

Critical Path Options

CP Duration

(

CP Duration Unit:

Minutes

‘Workflow E: tion Options

Execution

Restriction ‘7 Nene =

I

EED

|| i) save & New || [Fy Save & View |

3 Close |

Step 4 Click the Save button.
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Step 5 From the Automation Center navigation pane, select Manual Triggers. The Manual Triggers list displays.
Step 6 Click the New button and enter / select the following values in the empty Manual Trigger Details:
® Name = Scheduled Report Trigger
® Tasks(s) = Schedule a Report
Manual Trigger Details —[Ex
[l save [ Save &New [[f] Save &View 3£ Close
Manual Trigger
— General
Name : Scheduled Report Trigger
Description
Member of
Business Senices s
Calendar : System Default w :
Schedule a Report
Task(s): G
Purge By Retention
Duration al
[E] save [ save & New | | [y Save & View 3 Cclose
Step 7 Click the Save button.
Step 8 In the Time Triggers list, right-click the Schedule Report Trigger to display an Action menu.
Step 9 Click Trigger Now... and then, on the Trigger Now... pop-up dialog, click Submit.
Step 10 Open the email sent to the recipient selected in Step 3 and double-click the attached Scheduled Activity Report.pdf to see the report.
Scheduled Act Report (17 Task Instances)
Instance Name Type Status
waorkflow-regression-one-of-each-tasks Workflow Success
sap-task-simple-variable SAP Success
Taskmon-workflow-simple Task Monitor Success
sql-task-mysql-sproc Stored Procedure Success
email-task-builtin-variables Email Success
udm-task-simple-variable File Transfer Success
Pause for Manual Manual Success
ftp-filemon-simple-variable FTP File Monitor Success
nix-filemon-simple-variable File Monitor Success
Linux check for vsFTP #QUERY# Application Control Finished
win-task-launch-simple-variables Windows Success
nix-task-launch-simple-vanables Linux/Unix Success
sysmon-diskspace-simple-variable System Monitor Success
Sleep Variable Timer Success
sql-task-mysqgl-select-all saL Success
Indesa-task-simple-variables Universal Command Success
Scheduled Activity Report Email Running
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S
For additional information, see:

® Reports
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Tutorial - Creating Users and Assigning Roles and Permissions

® Introduction
® Create New Users
® Assign Permissions to Groups of Users

Introduction

In this exercise, we will create some users related to the Operations and Tech Support departments created in the Creating Business Services tutorial.
We also will assign access and management rights via user roles and Universal Controller permissions:

® Roles are pre-defined groups of permissions that control access to users, reports (filters), gauges, bundles, and promotions.
® Permissions control who can add, change, delete and control Controller tasks, task instances, triggers, Agents, calendars, and credentials.

Create New Users

In this exercise, we will create a new user and assign different permissions to it.

Step 1 From the Administration navigation pane, click Security > Users. The User list displays.

Step 2 Click the New button to display empty User Details for a new user and enter / select the following values:

User Id = userl
First Name = User
Last Name = One
Password =123

User Details B

[ save (@ Save & New Save & View 3¢ Close

User

[~ Details
Userld: Userl Time Zone :|Server (AmericalNew_York) ~
PassWord : sessssses Title v
First Name : User Department
Middle Name Manager v
LastName : One Business Phone
Email Hobile Phone

Password Req:\sr:‘s B Web Browser Access : |- System Default — >
Locked Out: 7] Command Line ACcess : |- System Default — ~
Web Service Access - | System Default - ¥

Active

‘Standard
Login Method : gL on

B save () Save & New Save & View # close

Step 3 Click the Save button, log out of the Controller and then log in as user1.
Step 4 Click on several areas of the user interface. Since userl has not been assigned any permissions, userl can view only a limited number of lists and records, and cannot create, modify, or delete any records.
Step 5 Log out of the Controller and log in as ops.admin.
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Step 6

Step 7 Click Edit.

Step 8

Step 9

Step 10

Step 11

187 /

Open the userl record and click the User Roles tab.

Move the ops_admin role to the Roles List and click Save to provide userl with full administrative permissions.

Edit Members

Name =

ops_agent_cluster_admin
ops_bundle_admin
ops_dba
ops_email_admin
ops_fiter_global
ops_fiter_group
ops_imex
ops_multi_update
ops_premotion_admin
ops_report_admin
ops_report_global
ops_report_group
ops_report_publish
ops_report_schedule

ops_report_widget_create

Collection

]

Save

B
[«
»]
[«

Cancel

groupa

=

Roles List

X

uc-70x-tandt

Click the User tab and then click the Update button.

Log out and log back in as userl to verify that userl has the same permissions as ops.admin.

Log out and log back in as ops.admin, open the userl record, and remove the ops.admin role.
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Step 12 Click the Permissions tab, click the New button, and in the Permissions Details select the following values:

Type = Task

Create = enabled

Read = enabled

Update = enabled

Commands = Launch

Unassigned to Business Service = disabled
Member of Business Services = Tech Support

Permission Details =/alx

[7] save [y Save & New [fj Save & View 3£ Close

Permission

— Details

Type : Task .
Create :
Read:
Update
Delete: [7]
Commands : |Launch »
Name: *

Member of Any Business B Unassignedto Business B

Senvice or Unassigned : Senvice :
Member of Business
Sernvices

Tech Support ¥

H Save ’-E-_] Save & New Ej Save & View ¥ Close

Step 13 Click Save, log out of the Controller, and log in as userl.

Step 14 userl now will be able to see the tasks assigned to the Tech Support group, and launch those tasks. However, userl cannot see them on the Activity Monitor because userl was not given permissions on Task
Instances.

Assign Permissions to Groups of Users

In this exercise we will assign our last user to a group, then assign permissions to the group instead of to the user.

Step1  Open the userl record .

Step 2 Click the Member of Groups tab to display a list of groups that userl belongs to.

Step 3 Click the New button to display Group Details for a new group.

Step 4  Inthe Name field, enter Group1, and then click the Save button. The Member of Groups list now shoes Group1.

Step 5 Open Groupl and click the Permissions tab to display the list (currently empty) of permissions for Group1l.
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Step 6  Click the New button and on the Permissions Details, enter / select the following values:

Type = Task Instance

Read, Update, Delete = enabled
Commands = All

Business Services = Operations
Unassigned to Business Service = disabled

These permissions provides all users in the Group1 full permissions on all activity (task instances) related to the Operations Business Service. Any users you assign to Groupl will inherit these permissions.

Permission Details [|(=]]B33

[7] save [ Save & New Save & View 3£ Close

Permission

r— Details

Type : TaskInstance -
Read:
Update
Delete :

Commands : |ALL v

Name: *

Member of Any Business B Unassigned to Business B
Senvice or Unassigned : Service :
Member of Business

Operations v
Senvices | "

H Save ’-l__m Save & New Save & View x Close

Step 7  Click Save, log out, and then log in as userl to check the permissions.

e
For additional information, see:

® Users and Groups
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Tutorial - Creating User Groups and Assigning Permissions

In this exercise, we will create users and user groups, then assign permissions to the groups instead of directly to the users.

Step 1 Create the following three users:

® stonebranch-user-01
® stonebranch-user-02
® stonebranch-user-03

Step 2 Select Users > Groups and create a group called stonebranch-group-01.

1. Click the Permissions tab
2. Click the New button and add the following permission:
® Type = Task Instance
® Read = enabled
* Member of Any Business Service or Unassigned = enabled
3. Click the Group Members tab and click Edit.
4. Add stonebranch-user-01 to the group.

Step 3 Create a group called stonebranch-group-02.

1. Add the following two permissions:
® Type = Task Instance
Read = enabled
Update = enabled
Commands = None
Business Services = stonebranchbusinessservice 01
Unassigned to Business Service = disabled

and

Type = Task Instance

Read = enabled

Update = enabled

Commands = All

Business Services = stonebranchbusinessservice 02
Unassigned to Business Service = disabled

Group Details: stonebranch-group-02 —|Ex
Group Group Roles Group Members Child Groups Permissions
2 Permissions New =
Type Operaions ~ Commands  Name  Unassigned to Business Service Business Services Updated By  Updated
[5] Taskinstance Read, Update ALL * No stonebranchbusinessservice 02 ops.admin 2014-08-07 16:12:04 -0400
[E] Task Instance Read, Update 5 Ho stonebranchbusinessservice 01 ops.admin 2014-08-07 16:08:14 0400

2. Click the Group Members tab and Edit button to add stonebranch-user-02 to the group.
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Step 4  Create a group called stonebranch-group-03.

1. Add the following two permissions:
® Type = Trigger
Create = enabled
Read = enabled
Update = enabled
Delete = enabled
Commands = None
Member of Any Business Service or Unassigned = enabled

and

Type = Task

Create = enabled

Read = enabled

Update = enabled

Delete = enabled

Commands = None

Member of Any Business Service or Unassigned = enabled

Group Details: stonebranch-group-03 =63

Group Group Roles Group Members Child Groups Permissions

2 Opswise Permissions New =)

Type | Operations Commands  Name  Unassigned to Business Service Business Services Updated By  Updated
[E] Task  Creste, Read, Update, Delete o Yes o ops.admin 2014-08-07 16:18:42 0400
[=] Trigger Creste, Read, Update, Delste & “Yes & ops.admin 2014-08-07 16:18:32 0400

2. Add stonebranch-user-03 to the group.

Step 5 Log in as each user and note that each is limited to those functions assigned to the user's group.

S
For additional information, see:

® Users and Groups
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Tutorial - Creating and Promoting a Bundle

In this exercise, we will create a bundle (group) of Controller records and promote (copy) them from a source machine (a Controller cluster node) to a target machine.

Specifically, we will:

Create a Bundle.
Add records to a Bundle.
Create a promotion target record for the bundle promotion.

Map Agents on the source machine to Agents on the target machine.
Promote the bundle to the target.

Create a Bundle

In this procedure, we will create a Bundle record to which other records can be added.
Step 1 From the Bundles & Promotion navigation pane, select Bundles. The Bundles list displays.

Step 2  Click the New button to display Bundle Details for a new Bundle.

Enter a Bundle Name.

Bundle Details BEIES
[ save [ save & New Save &View 3¢ Close
Bundle e

r— Details

Bundle Name

Description
Member of Business
Senices
Default Pramotion =
Target =
Exclude on .
Existence . EMail Templates
Fallow References = [

Promote Bundle
Definition a

— Promote By Business Service
Promote Members of
Business Senvices

Visible To

7] Save I3 Save & New Save & View & Close

step 3  Click the Save button to create (and close) the Bundle record, which now appears on the Bundle list. You now can add records to the
Bundle.

Add Records to the Bundle

In this procedure, we will add records to the Bundle record that you just created.

Step 1 Open the Bundle record you just created.
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Step 2 Click the Triggers tab to display an empty Triggers list.

Bundle Details: Demo Bundle #1 =163
Bundle Triggers Tasks Calendars Custom Days Variables Business Services Credentials Agent Clusters VirtualR 4| » |+
0 Triggers Edit &
Name Type Descripon | Added By  Updated

No items to show.

Step 3  Click the Edit button to display a list of all Trigger records.

Edit Members =/ |=][%:

Collection Trigger List

Demo Bundle #1

4‘

»

Name * Name * -

[

'stonebranch-applicationmonitortrigger-01
— None —

stonebranch-applicationmonitertrigger-02

'stonebranch-applicationmonitertrigger-03

stonebranch-applicationmonitortrigger-04

stonebranch-applicationmonitortrigger-05 ‘T‘
B
| [
[]

stonebranch-compositetrigger-01
stonebranch-compositetrigger-02
stonebranch-compositetrigger-03
stonebranch-compositetrigger-04
stonebranch-compositetrigger-05
stonebranch-crentrigger-01
stonebranch-crontrigger-02
stonebranch-crontrigger-03
'stonebranch-crentrigger-04
stonebranch-crentrigger-05

stonebranch-filemenitortrigger-01

[En|

Save Cancel
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Step 4 Select the Trigger records that you want to add to the Bundle and click the Save button. Those records then display in the Triggers list under the Triggers tab.

Bundle Details: Demo Bundie #1 = [=)E3
Bundle © Triggers Tasks Calendars Custom Days Variables Business Services Credentials Agent Clusters VirualR) « | » | =
5 Triggers Edit @
Name Type Descripion | Added By  Updated
[ stonebranch-taskmonitortrigoer-01 Task Monitor ops.admin  2015-09-29 16:50:51 -0400
[ stonebranch-taskmonitortrigoer-03 Task Monitor ops.admin  2015-09-29 16:50:51 -0400
[E] stonebranch-taskmonkortrigaer-05 Task Wonitor ops.admin  2015-08-29 16:50:51 -0400
[ stonebranch-taskmoniortrigoer-04 Task Monitor ops.admin  2015-09-29 16:50:51 -0400
[=] stonebranch-taskmoniortrigoer-02 Task Monitor ops.admin  2015-09-29 16:50:51 -0400

Step 5 Repeat Steps 2-4 for any other record types you want to add to the Bundle.

Step 6 Click the Bundle tab, the Update button, and the Close button. You now must create a record identifying the target (Controller cluster node) to which the Bundle will be
promoted.

Create a Promotion Target Record for the Bundle
In this procedure, we will create a record identifying the target machine (a Controller cluster node) to which you will promote the Bundle.
Step 1 From the Bundles & Promotion navigation pane, select Promotion Targets. The Promotion Targets list displays.

Step 2 Click the New button to display Promotion Target Details for a new promotion target.
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Step 3 Enter a name and the URI for the promotion target.

Note
1
By default, the URI of the cluster node that you are logged into displays. You must change this to the URI of a target cluster node, using the default URI
format.
Promotion Target Details =|[3][%

[] save [ Save & New [[j] Save &View 3£ Close
Promotion Target

Details

Hame : stonebranch-promotiontarget-01

Description

Member of
Business Services

URI:

QA Department n

hitpi/stonebranch 123Universal

User: ops.admin

Password . sssssssss

[l save I3 Save & New Save & View # Close

Step 4 Click the Save button. You now must map Agents on your source machine to Agents on the target machine.

Map Source Machine Agents to Target Machine Agents

In this procedure, we will map Agents on your source machine to Agents on the selected target machine.
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Step 1 From the Bundles & Promotion navigation pane, select Promotion Targets. The Promotion Targets list displays.
Dashboards [1] | Promotion Targets [
' & Prometion Targets Custom Filter ~| 5% Fiter.. [E GoTo.. | [ MNew | &
Name User URl Description Updated By Updated -
E' stonebranch-promotiontarget-01 http:/Mocalhest:8080/opswise: ops.admin 2014-08-13 15:37:58 -0400
El stonebranch-promotiontarget-02 http:/Mlocalhost:3080/ops wise ops.admin 2014-06-13 15:38:04 -0400
E stonebranch-promotiontarget-03 http:/focalhost:8080/opswise ops.admin 2014-06-13 15:38:07 -0400
El stonebranch-promotiontarget-04 http:/Mocalhest:8080/opswise ops.admin 2014-08-13 15:38:12 -0400
El stonebranch-prometiontarget-05 http:/Mlecalhost. 3080/ops wise ops.admin 2014-08-13 15:38:17 -0400
V' Promotion Target Details [] save ) Save & New [T] New
Promotion Target
Details
Name :
Description ©
Member of
Business Senices : (94 Department e
URI:
User:
Password . » s
] save [ Save & New [ New
Step 2 Right-click the Promotion Target record that you just created to display an Action menu.
Step 3 Click Refresh Target Agents to display a Refresh Target Agents pop-up dialog.
Refresh Target Agents - %
Promotion Target : | stonebranch-promotiontarget-01
Override User/Password :
User:
Password
Step 4 Enter the User and Password credentials for the target machine (if they are not provided) and click Submit.
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Step 5 Open the Promotion Target record and click an Agent Mappings tab for which there are Agents listed.

Promotion Target Details: stonebranch-promotiontarget-01 =[E[x
v
Promotion Target | ® Linwe/Unix Agent Mappings Windows Agent Mappings 2/0S Agent Mappings.
0 Linux/Unix Agent Mappings =
Target Agent Source Agent

[F] stonsbranch-inuxunixagent-03

Step 6 Click the Details icon next to a Target Agent name to display Agent Mapping Details for that Target Agent.

LinuxiUnix Agent Mapping Details =[E][*
[E] Update ff] Delete 1% Refresh 3 Close

Linux/Unix Agent Wapping

Promotion Target: stonebranch-linuxunix-01 D
Target Agent: stonebranch-linuxunixagent-01

Type . Linux/Unix

a

No items to show. —
L_J
Source Agent lj_%

@

v

[E] update ] Delete 5| Refresh 3 Close
Step 7  Click the Add-Remove Multiple icon next to the Source field to display a list of all Agents on the source machine.
LinuxiUnix Agent Mapping Details =[x

[E] Update (i) Delete [[% Refresh 3% Close

Linux/Unix Agent Wapping

Promotion Target: stonebranch-linuxunix-01 D
Target Agent: stonebranch-linuxunixagent-01

Type . Linux/Unix
No items to show.

Source Agent

© FEm

[E] update ] Delete 5| Refresh 3 Close

Step 8 Select the source machine Agent(s) that you want mapped to the selected target machine Agent, and then click Save.

197 / uc-70x-tandt



Universal Controller 7.0.x Troubleshooting and Tutorials

Step 9 Repeat Steps 6 to 8 for every Target Agent under all Agent Mappings tab(s) for which there are Agents listed.

Promote the Bundle
In this procedure, we will promote the Bundle that you created to the selected Promotion Target machine.
Step 1 On the Bundles list, right-click the Bundle to be promoted and click Promote Bundle... on the Action menu to display a Promote Bundle... pop-up dialog.
Promote Bundle...

Promaotion Target : | stonebranch-promotiontarget-01
Override User/Password :

User: ops.admin

Password: essssssss

Allow Universal Template Changes : [7]

Schedule . [

Submit Cancel

Step 2  Click Submit. The source machine Controller logs in to the target machine specified in the URI field of the Promotion Target record and copies the bundled records to the target machine Controller. Based on the
specified Agent mapping, the target Agent replaces the source Agent where required.

e
For additional information, see:

® Bundles and Promotion
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Tutorial - Scheduling the Promotion of a Bundle

In this exercise, we will select a date and time for the automatic promotion of the Bundle that was created in the Creating and Promoting a Bundle tutorial.

Schedule a Bundle Promotion
In this procedure, we will schedule the promotion of a Bundle to a target machine.
Step 1  Fromthe Bundles & Promotion navigation pane, select Bundles. The Bundles list displays.
Step 2 Right-click the Bundle to be scheduled for promotion and click Promote Bundle... on the Action menu to display a Promote Bundle... pop-up dialog.

Promote Bundle...

Promotion Target : | stonebranch-promotiontarget-01
Override User/Password :

User: ops.admin

Password: essssssss

Allow Universal Template Changes : [7]

Schedule . [

Submit Cancel
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Step 3
Promote Bundle...

Promotion Target :

Override User/Password :

User:

Password :

Allow Universal Template Changes :
Schedule :

Date :

Time :

Create Snapshot :

System Notification :

Step 4  Selecta Date and Time for the promotion.

Step 5

stonebranch-promotiontarget-01
ops.admin

]
2017

v [|[May |w |30

Hour Win
T w |00 |w

]

Operation Failure

Submit

Click the Schedule field check box to display additional fields for specifying a promotion schedule.

Click the Submit button. The Bundle is listed on the Promotions Schedules list and will be promoted automatically at the scheduled date and time.

Dashboards [1] ‘ Prometion Schedules [ ‘
¥ 2 Promotion Schedules
Bundle

pundie 01
pundie 02

Promotion Target Status

02 Scheduled

v Promotion Schedule Details

Custom Filter — Mone —

Status Description

01 Cancelled Scheduled promotion cancelled by user "ops.admin”.

~| @ Filter
Scheduled Time Use Snapshot
2015-05-23 00:00:00 -0400 Yes
2015-05-24 00:00:00 -0400 No

&
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S
For additional information, see:

® Bundles and Promotion
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